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• 欠品、破損、紛失等の場合は、ご購入された販売店にお問い合わせください。（ACアダプターは別売品で購入可能）
• 付属品のデザインと内容は、予告なく変更されることがあります。

付属品や別売品は、必ず本機指定のものをご使用ください。指定以外のものを使用すると、火災・感電・けがの原因となることがあ
ります。

付属品一覧

リーフ類

• カシオ電子楽器保証書
• 安全上のご注意
• お客様ご相談窓口
• Appendix
• その他ACアダプター：

AD-E95100L

別売品のご案内

本書の内容について
●本書の一部または全部を無断で複写することは禁止されています。また個人としてご利用になるほかは、著作権法上、当
社に無断では使用できませんのでご注意ください。

●本書および本機の使用により生じた損失、逸失利益または第三者からのいかなる請求についても当社では一切その責任を
負えませんので、あらかじめご了承ください。

●本書の内容に関しては、将来予告なく変更することがあります。
●本書のイラストは、実際の製品とは異なる場合があります。
●本書に記載されている社名および商品名は、それぞれ各社の登録商標および商標です。

• カシオ電子楽器取扱店で購入可能。
• 店頭のカシオ電子楽器カタログでより
詳しい情報がご覧になれます。
http://casio.jp/emi/catalogue

商品名 品番
ヘッドホン CP-16
サステインペダル SP-3

SP-20
ソフトケース SC-550B

スタンド CS-4B
CS-7W

イス CB-5
CB-7
CB-30

商品名 品番

■JIS C 61000-3-2適合品
本装置は、高調波電流規格「JIS C 61000-3-2」に適合しています。
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全体ガイド
• 本書の操作説明では、ボタンやつまみなどを、下記のグループ番号（1、2・・・）と名前の組み合わせで表現します。

1から5では、音を聴きながら、その音を左手で素早く調整します。

1スライダー（5）や、（2）のボタンに割り当てる機能を選びます。☞32ページ

2ソロシンセサイザー音色の編集に使用したり、スライダー（5）に割り当てるパートを変更します。
☞23ページ

3音の鳴り始めや消えかたなど、さまざまなパラメーターを調整します。☞32ページ

4ステップシーケンサーで、各ステップやパートのオンとオフを切り替えます。☞49ページ

5ソロシンセサイザーのパラメーターを調整したり、ステップシーケンサーやミキサーの編集に使用します。
☞32、49、71ページ

左 中央 右 小物台

背面

左下

• 少し傾斜していますので、置い
た物がすべり落ちないように
注意してください。

• コップなど液体の入ったもの
は置かないでください。

1

3

4

52

左

（スライダー）
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6本機の電源を入れて、音量を調節します。☞9ページ

7上の3つのボタンで、本機のモード（状態）を選びます。下の3つのボタンで、音色など各種データの編集と保
存、あるいは本機全体にかかわる設定を行います。☞10、 11、 73ページ

8ステップシーケンサーやフレーズなどの再生テンポを調節します。☞42ページ

9ステップシーケンサーやミキサーで編集するパートを切り替えます。☞48、 71ページ

bkステップシーケンサーの再生や、編集するステップの選択などを行います。☞48ページ

blステップシーケンサーのパターンを選びます。☞10、 48ページ

bmサンプルルーパーの録音や再生を行います。☞59ページ

bnアルペジオやホールド機能のオンオフを切り替えたり、ミキサーやエフェクトの設定を変更します。
☞35、 37、 71ページ

boフレーズシーケンサーの録音や再生を行います。☞41ページ

bp液晶画面に表示されている番号や値などを、すばやく変更します。☞10ページ

6

9 bk bl

7 bn8 bm bo bp

中央

液晶画面

ボタンを押し続けたときの
機能名であることを示す

（ダイヤル）
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bq音色やパフォーマンスなどの番号を選びます。☞19ページ

br右の6つのボタンで表示内容を選び（カーソル）、－、＋ボタンで値を切り替えます。
“MENU”では、そのときの状態に対応した機能のメニューを表示します。☞20ページ

bs音の高さをワンタッチで変更します。☞34ページ

bt音のピッチをなめらかに変化させたり、ビブラートの効果などをかけます。☞32ページ

背面 次のページをご参照ください。

bq

br

bs

右

bt

左下
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演奏の準備

• 接続する機器の取扱説明書も、併せてお読みください。
• 本機はスピーカーを内蔵しておりませんので、何も接続しないと音が出ません。

ck背面左側

cl背面右側

接続について

メモリーカード（77ページ） パソコン（82ページ） 他の電子楽器（73ページ）

(1) (2) (3) (5) (6) (7)(4)

※1 標準プラグ（モノラル）
※2 ステレオ標準プラグ
※3 ステレオミニプラグ

ぺダル マイク ヘッドホン 家庭用
コンセント

CDプレーヤー、
携帯オーディオ
プレーヤーなど

オーディオ機器、
アンプなど

他の電子楽器

※1 ※3 ※1 ※1 ※1 ※2
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目的 接続方法など
（1） ペダルを使う。 別売のサステインペダルを接続してください。ペダルを踏んだときの効果につ

いては68ページをご参照ください。
（2） 他の電子楽器の音を取り込む。 市販の接続コードを使って、他の電子楽器の出力端子（モノラル）と接続してく

ださい。※4

• 入力した音に効果（エフェクト）を加えたり（34ページ）、入力した音を音色作
りの素材にすることができます（21ページ）。

（3） 外部機器の音を取り込む。 市販の接続コードを使って、CDプレーヤーや携帯オーディオプレーヤーの出力
端子（ステレオ）と接続してください。※4

（4） 外部の音を、マイクで取り込む。 市販のダイナミックマイクを接続してください。※4

マイクからの入力音の音量は、cl（MIC VOLUME）で、他の音から独立して調
整できます。
• マイクからの入力音にエフェクトを加える方法は71ページを、入力した音を
音色作りの素材にする方法は21ページをご参照ください。

（5） 本機の音を、オーディオ機器やアンプ
で鳴らす。

市販の接続コードを使って、オーディオ機器やアンプの入力端子（AUX INなど）
に接続してください。※4

• 接続コードを1本だけ使ってモノラル出力する場合は、L/MONOの方にコー
ドを接続してください。

（6） ヘッドホンを使う。 別売または市販のヘッドホンを接続してください。※4

• 大きな音量で長時間使用しないでください。聴覚障害になる恐れがあります。 
（7） 電源を準備する 次節「電源の準備」をお読みください。

※4 接続する前に、本機や接続機器の電源を切って、6（VOLUME）を小さ目に絞っておいてください。
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家庭用100V電源、または乾電池をご使用できます。

• 必ず別紙「安全上のご注意」をお読みのうえ正しくお使いく
ださい。誤った使い方をすると感電や火災の危険がありま
す。

• ACアダプターの抜き差しや乾電池の出し入れを行う前に、
必ず本機の電源をお切りください。

※JEITA規格・極性統一形プラグ付き

1. 本機指定のACアダプターを使って、本機を家庭用
コンセントに接続します。

2.6（POWER）を押して、本機の電源を入れます。
• 電源を切るには、もう一度6（POWER）を押します。

• 6（POWER）を軽く押すと、液晶画面が一瞬点灯し、電源
が入らない場合がありますが故障ではありません。その場
合は6（POWER）をしっかりと押し直してください。

• 長時間ご使用になりますとACアダプターが若干熱をもち
ますが、故障ではありません。

• 断線防止のため、コードになるべく負荷がかからないよう
ご注意ください。

• 本機の電源端子（DC 9.5V）に、金属片や鉛筆などを入れな
いようにご注意ください。これらが端子に入ると、事故の原
因になります。

単1形乾電池、6本をご使用ください。
• アルカリ乾電池またはマンガン乾電池をお使いください。
オキシライド乾電池などのニッケル系一次電池は、絶対に
使用しないでください。

1. 本機の裏側にある電池ブタをはずします。

2. 市販の単1形乾電池、6本を電池ケースに入れます。
イラストに合わせて+-の向きを間違えないように入れ
てください。

3. 電池ケースの穴にツメを差し込み、電池ケースのフ
タを閉じます。

4.6（POWER）を押して、本機の電源を入れます。

■乾電池交換時期のお知らせ表示
乾電池の持続時間は下記のとおりです。

※大き目の音量や極端な低温下、あるいは演奏のしかたに
よっては、これより短くなる場合があります。

乾電池が消耗してくると画面に“Battery Low”と表示し、以
下の表示が点滅しますので、すみやかに新しい乾電池と交換
してください。

本機を何も操作せずに一定時間放置すると、無駄な電力消費を
防ぐため自動的に電源が切れます。電源が切れるまでの時間
は、乾電池使用時で6分、ACアダプター使用時で4時間です。
• オートパワーオフ機能が作動しないようにするには、73
ページ「本機全体にかかわる設定」の“Auto Power Off”を
オフにしてください。

電源の準備

家庭用100V電源を使うには

6

折り曲げない 引っ張らない 巻きつけない

本機指定のACアダプター（AD-E95100L）※を使用してくだ
さい。他のACアダプターを使用すると故障の原因になること
があります。

家庭用コンセント

ACアダプター

電源端子DC 9.5V

乾電池を使うには

約35時間※

（アルカリ乾電池使用時、当社別売品ヘッドホンCP-16使用時）

オートパワーオフ機能

ツメ

乾電池交換サイン（点滅します）
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とにかく弾いてみよう！（入門編）
難しい理屈はヌキにして、実際に楽器を操作して楽しみなが
ら、本機の基本をマスターしてしまいましょう。この章ではシ
ンセサイザーは初めてという方にも分かりやすいように、ご
一緒に楽器を操作しているつもりで説明します。

それではスタート！

6（POWER）を押して、電源を入れてください。最初は「パ
フォーマンスモード」という状態になります。

パフォーマンスモードでは本機の性能をフルに発揮した演奏
ができますが、いきなり理解するには難しいでしょう。そこで
本書では、より基本的な「トーンモード」から説明することに
します。

7（TONE）を押して、本機の状態を「トーンモード」にしてく
ださい。

■本機の3大モード

それでは、実際に音色を選んで聴いてみましょう。

音色は4つの種類（カテゴリー）に分けられていて、bpのダイ
ヤルを回して番号を選ぶことができます。
またbqのボタンで、音色番号を直接入力することもできます
（19ページ）。

• より詳しくは、19ページの表をご参照ください。

まず先頭の「ソロシンセサイザー」から聴いてみましょう。bp
（ダイヤル）を回して番号を選んでください。

鍵盤を弾いて、選んだ音色の音を鳴らしてみてください。音量
は、6（VOLUME）で調整します。
• ソロシンセサイザー音色の音は、モノフォニックです。2つ
以上の鍵盤を同時に鳴らすことはできません。

いろいろな音色（トーン）を鳴らして
みよう

6

7

パフォーマンスモード

パフォーマンスモード

トーンモード

ステップシーケンサーモード

点灯

トーンモード

パフォーマンスモード

演奏（パフォーマンス）のための
モード。4種類の音色やステップ
シーケンサーなどを駆使して高度
な演奏が可能。

トーンモード 音色作りのためのモード。1つの音
色を選んで、じっくり編集できる。

ステップシーケンサー
モード

ステップシーケンサーのデータ
（セット）を作りこむためのモード。

カテゴリー
概要

番号 名前
P000～
P099 ソロシンセサイザー 伝統的なアナログシンセ

サイザーの音色。

P100～
P399

PCMメロディー音色
PCMドラム音色

さまざまな楽器の音から
録音したデータを使って、
元の楽器の音を再現した
音色。

－ ユーザーウェーブ
音色

サンプルルーパーで録音
した音の波形。
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「ソロシンセサイザー」には、あらかじめ内蔵されている音色
（プリセット音色※）が100種類もあり、今鳴らしているのはそ
のうちの1つです。他のプリセット音色も聴いてみましょう。
※これに対して、後からご自分で保存した音色を「ユーザー
音色」と呼びます。「プリセット」「ユーザー」という呼び分
けは、音色以外の各種データ（ステップシーケンサーやパ
フォーマンスなど）にも使います。

br（＋）を押してください。押すごとに次のプリセット音色に
切り替わります。

ソロシンセサイザー以外のカテゴリーの音色も、同じ操作で
選ぶことができますので、聴いてみてください。

いかがですか、お好みの音色は見つかりましたか？

音作りこそシンセサイザーの醍醐味です。プリセット音色を
編集して自分だけの音色（ユーザー音色）を作ってみましょ
う！

本機では、7（EDIT）を押して、本格的な編集作業をすること
ができます（20ページ）。ただし、その作業のうちいくつかは
7（EDIT）を押さなくても、5（スライダー）だけで簡単に行
うことができます。ここでは、ソロシンセサイザー音色の編集
をご紹介します。

7（TONE）を押してから、bp（ダイヤル）を回して番号を選
んでください。

鍵盤で音を鳴らしながら、3（ASSIGNABLE KNOBS）を回
してみましょう。ノブを回していくと、音色の特徴が変化して
いきます。お好みの音を作ってみましょう。

例：音色「P:000」でK1を使う

調整ができたら、ユーザー音色として本機に保存してみま
しょう。

7（WRITE）を押して、保存モードに入ってください。液晶画
面に保存先が表示されます。

bp（ダイヤル）またはbr（－、＋）で、保存先の音色番号を指定
してください。

br 前に戻る 次に進む

音色番号

音色名 P：プリセット
U：ユーザー

自分の音を作ってみよう！

• 右に回すと、音が明るくなります。
• 左に回すと、音が暗くなります。

保存先
U：ユーザー音色
000：音色番号000
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次に、br（w）を押して、音色名を入力する画面に切り替えま
す。

例：音色番号000を保存先に指定した場合

br（U、I）でカーソルを移動させ、bqで文字を入力して、お好
きな音色名をつけてください。
• bqの12個のボタンで下図のように文字を分担し、ボタン
を押すごとに文字が切り替わります。入力可能文字の一覧
は、91ページをご参照ください。

• br（－、＋）またはbp（ダイヤル）で文字を切り替えること
もできます。

音色名が完成したら、br（ENTER）を押してください。液晶画
面に“Replace?”（データを入れ替えますか？）という最終確
認のメッセージ※1が出ます。br（YES）を押して保存を実行し
てください※2。

• 本機に保存したデータは、メモリーカードやパソコンに
バックアップを取っておくことをお勧めします。メモリー
カードへの保存については、77ページ「メモリーカードを
使用する」を参照してください。パソコンへの保存について
は、82ページ「パソコンとの接続について」を参照してくだ
さい。

保存したユーザー音色は、プリセット音色と同様の操作で選
ぶことができます。先ほど保存した音色を選んで、鳴らしてみ
ましょう。
• 番号を指定する前に、bq（PRESET/USER）を押して、ユー
ザー音色選択状態にしておいてください。

これであなたは、もっとも簡単な音色の編集と保存の例をマ
スターしました。これは本機のトーン編集機能のほんの一部
にすぎませんが、あせらず徐々に習得していけば、より高度な
編集ができるようになります。ぜひ18ページからの「音色
（トーン）を選ぶ／音色を作る」にもチャレンジしてください。

※1 新しいデータを保存すると、前のデータは消去されます。
※2 保存しない場合はbr（NO）を押してください。

カーソル：ここの文字を入力できます

記号（前半）
数字

ABC DEF GHI JKL

（大文字・小文字切り替え）
MNO PQRS TUV WXYZ

記号（後半）

bq 点灯（ユーザー音色選択状態）

ユーザー音色
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本機は「音作り」だけの楽器ではありません。意表をつく面白
いリズムやフレーズを鳴らして演奏を華やかにサポートする
機能もいろいろ搭載しています。それらを簡単にご紹介しま
しょう。

bn（ARPEGGIO）を押して、ボタンを点灯させてください。

鍵盤をどれでも1つ押してみてください。同じ音が繰り返し鳴
りはじめましたね、鍵盤を離すと音は鳴り止みます。
押す鍵盤を1つから2つ、3つ・・・と増やしていくと、鳴る音も
変化していきます。3つ以上の鍵盤を押すと、アルペジオ（分散
和音）らしくなります。

アルペジオ機能で鳴らせる音形にはさまざまな種類（タイプ）
があり、音色と同様にプリセットから好きなものを選んで、編
集してユーザータイプとして保存することができます。ここ
ではプリセットタイプを選んでみましょう。
• 本機では、10個のタイプをまとめたグループを「バンク」と
呼びます。アルペジオにはバンク0から9までの合計10バン
クがあり、各バンクの中に0番から9番までの10タイプがあ
りますので、合計100種類となります。

bn（ARPEGGIO）を押したままにして、下記の画面が表示さ
れたら離してください。

後は音色と同様に、bp（ダイヤル）を回して、プリセットタイ
プを色々と切り替えて鳴らしてみてください。
より詳しくは、37ページ「アルペジオを自動的に鳴らす」をご
参照ください。

まずは「フレーズ」のイメージをつかむためにプリセットフ
レーズを聴いてみましょう。

bo（KEY PLAY）を押したままにして、下記の画面が表示さ
れたら離してください。

bo（PLAY/STOP）を押してください。本機にあらかじめ内蔵
されているフレーズ（プリセットフレーズ）が鳴ります。後は
音色と同様に、bp（ダイヤル）を回して、プリセットフレーズ
を切り替えて、聴いてみてください。

さらにフレーズシーケンサーでは、bo（PLAY/STOP）の代わ
りに鍵盤を押して、フレーズを鳴らすこともできます。さっそ
く試してみましょう。

まずbo（KEY PLAY）を押して、ボタンを点灯させてくださ
い。

この状態（キープレイモード）で鍵盤を押すと、フレーズが自
動的に鳴り始めます。別の鍵盤を押すと、フレーズのピッチが
変わります。このようにキープレイモードでは、鍵盤でフレー
ズの高さを次々と変化させて、面白い効果を出すことができ
ます。

しかし、フレーズシーケンサーの本領は、自分でフレーズを録
音して演奏に活用することにあります。詳しくは43ページ
「フレーズを新規に記録する」をお読みください。

ステップシーケンサーやフレーズで
遊んでみよう

アルペジオ機能

bn 点灯

アルペジオタイプ画面 バンク－タイプ番号

プリセット

フレーズシーケンサー

bo

フレーズシーケンサーモード バンク－フレーズ番号

プリセット

フレーズ名

点灯
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これもイメージをつかむために、プリセットのデータ（シーケ
ンス）を聴いてみましょう。

7（STEP SEQ）を押して、ステップシーケンサーモードに
入ってください。

音色と同様に、bp（ダイヤル）を使ってシーケンスを選ぶこと
ができます。ためしにプリセットシーケンス「2-3」を選んで、
bk（START/STOP）を押してみてください。選んだシーケン
スが鳴りはじめます。

1つのシーケンスには、8つのバリエーション（パターン）があ
り、bl（PATTERN 1～8）で選ぶことができます。パターンを
次々と切り替えて、リズムや音数の変化をお楽しみください。

例：パターン3を選ぶ

ステップシーケンサーでは、本機の音源16パートのうち9つ
（パート8～16）を使って、お聴きのような複雑なリズムを鳴
らします。液晶画面を見ると、今どのパートで音を出している
か分かります。

このとき4（1～16）のボタンの光がめまぐるしく動いてい
ます。これは編集対象パート（上記イラストのe）の音の動き
を表示しています。このようにステップシーケンサーでは、
16のステップを繰り返し鳴らします。9（PART －、＋）で編
集対象パートを選び、5（スライダー）を使ってステップを個
別に編集できます。詳しい操作方法は46ページをご参照くだ
さい。

ステップシーケンサーの不思議なリズムには、独特の魅力が
あります。プリセットシーケンスを聴いて興味を持たれた方
は、ぜひ46ページ「ステップシーケンサーを使う」でオリジナ
ル制作にもチャレンジしてください。

サンプルルーパーで簡単な録音をして、ループを作ってみま
しょう。

録音したい他の電子楽器、またはマイクがあれば本機に接続
してください。（7ページ参照）

bm（REC）を押して、サンプルルーパーの録音モード設定画面
を表示してください。
• br（q、w）およびbr（－、＋）を使って、“Rec Mode”を
“NORM-AT”に切り替え、“Length”を“04bt”に設定しま
す。

ステップシーケンサー

7

bk

bl

点灯

ステップシーケンサーモード バンク－シーケンス番号

プリセット

シーケンス名

点灯：選ばれているパターン

サンプルを録音してループさせてみ
よう

パート11と14は休んでいる

編集対象パート（e）

録音モード設定画面

自動録音のモード
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もう一度、bm（REC）を押してください。
bm（REC）が点滅します。この操作で、録音の自動開始を待っ
ている状態になっています。

他の電子楽器やマイク、または本機を演奏して音を出してく
ださい。本機が音を感知して録音が開始されます。
• 録音が始まると、bm（REC）が点灯に変わります。

4拍の長さを録音し終わると、自動的にそれまでに録音した音
のループ再生が始まります。
• bm（REC）が速い点滅に変わり、オーバーダビング（重ね録
音）の一時待ちの状態になります。この状態での演奏はオー
バーダビングされませんので録音した音とのデュエットや
オーバーダビングのリハーサルができます。

bm（REC）を押すと、bm（REC）が点灯に変わり、オーバーダビ
ングが始まります。
• ここで演奏した音は、元の音に次々と重なって録音されま
す。

• bm（REC）を押すごとに、ループ再生→オーバーダビング→
ループ再生→オーバーダビングに状態が切り替わります。

録音を終了したいときは、bm（PLAY/STOP）を押します。

詳しくは59ページ「サンプルルーパーで録音・再生する」をお
読みください。

いよいよパフォーマンス機能をご紹介できるところまできま
した。トーンモードでは1種類の音色しか選べませんでした
が、パフォーマンスモードでは4種類の音色を同時に使っての
演奏が可能です。しかも、音色やステップシーケンサーなどの
本機のさまざまな設定をまとめて一つのデータ（パフォーマ
ンス）として登録し、演奏中に簡単に呼び出すことができま
す。

7（PERFORM）を押して、パフォーマンスモードに入って
ください。

ここで、前後しますが18ページの表をご覧ください。そこに
書かれているように、パフォーマンスモードでは、鍵盤で4つ
のパート（ゾーンパート1～4）の音を鳴らします。
• ソロシンセサイザー音色は、ゾーンパート1にのみ割り当て
ることができます。

bm 点滅

“パフォーマンス”を使ってみよう

7

点灯

パフォーマンスモード バンク－パフォーマンス番号

プリセット

パフォーマンス名
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ゾーンパート1から順に設定しましょう。7（PERFORM）と
7（TONE）を同時に押して、パフォーマンスの簡易編集機能
である「クイックトーンモード」に入ってください。

もし編集対象ゾーンパート（e）が“1”になっていない場合は、
9（PART －、＋）を押して“1”に変更してください。
以上の準備ができたら、blbpbqbrを使って、ゾーンパート
1の音色を選びます。

次に9（PART －、＋）で編集対象ゾーンパートを“2”に変更
してから、ゾーンパート1と同じ要領で音色を選んでくださ
い。同様にゾーンパート3と4の音色も設定します。

4つのパートすべての音色を設定したら、br（EXIT）を押して
パフォーマンスモード画面に戻って、鍵盤を弾いてみてくだ
さい。これまでに選んだ4つの音色の音が、全部まとめて鳴り
ます。

編集中マーク“!”が表示されていますが、まだこれまでの設定
内容は本機に保存されていません。7（WRITE）を押して保
存モードに入り、あとは音色と同じ要領でユーザーパフォー
マンスとして保存してください。

例：ユーザーバンク2のパフォーマンス番号1に保存した
場合

• 編集中マーク“!”と保存済マーク“＊”は、パフォーマンス以
外にも、音色やステップシーケンサーなど各種データの編
集・保存時に登場します。

「Aura Lee」を演奏したいときユーザーパフォーマンス「2-1」
を呼び出せば、保存した4音色を瞬時に呼び戻すことができま
す。ためしに一旦他のパフォーマンス番号を呼び出しておい
て、再度「2-1」に戻してみてください。保存した4音色が再び鍵
盤で鳴らせるようになりますね。

実はこのとき、鍵盤の音色以外にも本機のさまざまな設定が、
保存したときの内容に戻っています。このようにパフォーマ
ンス機能では、本機の主要な設定をまとめて保存して、必要な
ときにすぐに呼び出すことができます。さらに例えば、バンク
2は「Aura Lee」専用、バンク3は別の曲用…という具合に曲ご
とにバンクを分けて整理すると、より使いやすくすることが
できます。詳しくは65ページからの「さらに高度な演奏に
チャレンジする（パフォーマンス）」をご参照ください。

7

クイックトーンモード

編集対象ゾーンパートの音色

編集対象ゾーンパート

編集中マーク

保存済マーク

曲「Aura Lee」の演奏用データで
あることが分かる名前にした
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では最後に、本機の表現力をデモンストレーションするため
の内蔵曲（デモ曲）をお楽しみください。

7（SETTING）と7（WRITE）を同時に押してください。

次にbr（ENTER）を押してください。デモ曲の演奏がスター
トします。
• 曲を切り替えるには、br（－、＋）を、停止するには、bk
（START/STOP）を押してください。その他の詳しい操作
方法は76ページをご参照ください。

本機は、音色番号などの各種設定内容を、電源を入れなおして
も保持します。設定内容を初期化したいときは、75ページ「本
機全体の設定内容やデータを初期化する（イニシャライズ）」
をご参照ください。

以上で入門編は終了です。次のページからは内容がぐっと詳
しくなり、この章でご紹介できなかった機能もたくさん登場
します。あせらずに、着実に理解できるペースで読み進めてく
ださい。用語についてはウェブ検索や市販の専門書で調べて
いただくと、さらに理解が深まるでしょう。

それでは、シンセサイザーならではの音作りの世
界をご堪能ください！

デモ曲を聴いてみよう

7

おわりに
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音色（トーン）を選ぶ／音色を作る

本機の音源は、下記の16パート＋外部入力パートから構成されています。本章では、トーンモード（10ページ）でゾーンパート1※
を使って、音色を選択・編集・保存する方法について詳しく説明します。
また、音色をさらにひきたてる「エフェクト機能」や、演奏中に音にさまざまな変化を与える「コントローラー」についてもご紹介し
ます。

※「ゾーン」と「ゾーンパート」について：
本機の鍵盤やペダル、ボタンなどの操作は、本機内部の音源に対してのみではなく、本機に接続した外部機器（電子楽器やパ
ソコン）に対してもMIDI送信によって働きかけます。
そこで、内部と外部の両方に共通する設定領域のことを「ゾーン」と呼び、これに対応した本機内部の音源パートを「ゾーンパー
ト」と呼びます。たとえば本機の「ゾーン2」で音色を選ぶと、内部音源の「ゾーンパート2」と、外部機器のMIDIチャンネル2に対
応するパートの両方をその音色にすることができます。

概要

パート番号 パート名 特徴
1 ゾーンパート1※ 本機のメインパート。常に鍵盤で演奏可能。音色の割り当てや編集も自由にできる。

2～4 ゾーンパート2～4※ パフォーマンスモードでのみ演奏可能な鍵盤パート。ゾーンパート1に比べて、音色の割
り当てと編集に制約あり（65ページ）。

5～6 マルチファンクション
キー

マルチファンクションキー機能で割り当てるフレーズ1（パート番号5）、
およびフレーズ2（パート番号6）に使用（67ページ）。

7 ガイド、プレカウント フレーズを録音するときガイドやプレカウントで使用（43ページ）。
8～16 ドラム1～コード ステップシーケンサーのノートパート（37ページ）。
－ 外部入力 本機背面のcl（MIC IN、INST IN）からの入力音（71ページ）。

• ゾーンとMIDIチャンネルの対応は、変更可能です（67ページ）。

9 bl

7 bn bo bp

bq

br

bs

3

5

ゾーンパート1 ゾーンパート2 ゾーンパート3 ゾーンパート4

（MIDI
チャンネル1）

（MIDI
チャンネル2）

（MIDI
チャンネル3）

（MIDI
チャンネル4）

ゾーン1の設定 ゾーン2の設定 ゾーン3の設定 ゾーン4の設定

本機内部の音源

外部機器
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1.7（TONE）を押します。
ボタンが点灯して、トーンモードになります。

2. bq（PRESET/USER）を押して、プリセット音色かユーザー音色かを選びます。
• ボタンが消灯しているときはプリセット音色、点灯しているときはユーザー音色です。

3. bq（0～9）を押して、音色番号を選びます。
• bp（ダイヤル）を回すと、素早く音色番号を切り替えることができます。
• br（－、＋）で、音色番号を1ずつ切り替えることもできます。br（－）とbr（＋）を両方一緒に押すとカテゴリーの先頭の音
色になります。

■音色カテゴリーの概要

• 全音色のリストは、別紙「Appendix」をご覧ください。

音色を選ぶ

カテゴリー
特徴

音色数
番号

名前 プリセット ユーザー
プリセット ユーザー

P000-P099 U000-U099 ソロシンセサイザー

伝統的なアナログシンセサイザー音色。元にす
る波形を選び、音の3要素（高さ、音色、音量）ごと
に編集してきめ細かな音作りが可能。モノフォ
ニック。

100 100

P100-P399 U100-U199 PCMメロディー さまざまな楽器の音からサンプリングしたデー
タを使って、元の楽器の音を再現する。

300 100
P400-P419 U300-U309 PCMドラム 20 10

－ U200-U210 ユーザーウェーブ

サンプルルーパー（59ページ）で録音した音の
波形を編集。ユーザーウェーブ音色として、音の
波形を編集することができる。
• ユーザーウェーブ音色の「U210」は、サンプ
ルルーパー録音によって即時に変更される音
色です。

－ 11
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1. 編集の元にする音色を選びます。
• プリセット音色、ユーザー音色のいずれも選ぶことが
できます。

2.7（EDIT）を押します。
音色の編集項目リストのトップ画面が表示されます。

例：ソロシンセサイザー音色の編集項目リストのトップ
画面

3. brを使って編集したい項目を選び、設定値を切り
替えます。
• bp（ダイヤル）を回すと、素早く設定値を切り替えるこ
とができます。

• リスト内容の詳細は、21ページ「ソロシンセサイザー
音色の編集内容」から30ページ「ユーザーウェーブ音
色の編集内容」までの中から、該当する音色カテゴリー
の記載をご参照ください。

例：トップ画面で“Volume”（音量）を選び、設定値を055
に切り替えた場合

4. 編集が終わったら、7（EDIT）を押します。
編集項目リスト画面を抜けます。
• まだ保存していないことを示す“!”（編集中マーク）が
点灯します。ここで他の操作をすると、これまでの編集
内容が消えてしまう場合がありますので、保存したい
ときは次の手順5に進んでください。

5.7（WRITE）を押して、編集した音色をユーザー音
色として保存してください。
• 保存の方法は、11ページをご参照ください。
• 保存したデータを消去する方法は、75ページをご参照
ください。

• 編集項目リストの一部の項目は、編集項目リストに入らず
に5（スライダー）や3（ASSIGNABLE KNOBS）を使っ
て簡単に設定することができます。32ページ「音をコント
ロールする」をご参照ください。

■ユーザー音色を外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

音色を編集して保存する

リストタイトル

リスト

この表示の項目は、複数の項目のグループ。
br（ENTER）押しで、そのグループの中に入る。

ページ

選択マーク 設定値

brbp

設定値を切り替える ページをめくる

項目を選ぶ

グループの中に入る

グループの外に出る

編集中マーク
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ソロシンセサイザー音色は下図のように、（1）～（6）の6つのブロックの音を統合して作られます。編集の前に、この構成と各ブ
ロックの内容をしっかりと把握しておいてください。

■ソロシンセサイザー音色構成図

※エンベロープジェネレーター（Envelope Generator）の略。

ソロシンセサイザー音色の編集内容

MIC IN

INST IN

（1）シンセOSC1ブロック

EG※ EG※ EG※

シンセOSC フィルター アンプ

（2）シンセOSC2ブロック

（3）PCM OSC1ブロック

EG※ EG※ EG※

PCM OSC フィルター アンプ

（4）PCM OSC2ブロック

（5）外部入力音ブロック

EG※ EG※ EG※

ピッチ
シフター フィルター アンプ

（6）ノイズブロック

EG※ EG※

ノイズ発生器 フィルター アンプ

（8）LFO1ブロック

EG※

LFO

（9）LFO2ブロック

（7）トータルブロック

EG※

フィルター ソロシンセ
サイザーDSP

出力

（1）～（9）各ブロックへ

（10）各種コントローラー

• 鍵盤
• ペダル
• bn（HOLD）
• ベンダー
• モジュレーション
• MIDI受信メッセージ

（バーチャルコントローラー）

（1）～（7）各ブロックへ
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内容

（1）シンセOSC1ブロック

“OSC”とはOscillator（発振器）の略で、音を生み出す部分です。この2つのシンセOSCブロックで
は、アナログシンセサイザーと同様に、サイン波やのこぎり波などの基本波形を元にして音を作り
ます。
• シンセOSC：元音を発生してピッチを決定します。
• フィルター：一部周波数をカットして、音質を調整します。
• アンプ：音量を調整します。
• 3つのEG（エンベロープジェネレーター）：
ピッチ、音質、音量などの、時間経過にともなう
変化（エンベロープ）をコントロールします。
右図は音量のエンベロープの例です。

（2）シンセOSC2ブロック

（3）PCM OSC1ブロック PCM音（音色カテゴリーの「PCM音色」と同質の音）を元にします。編集内容のうち（1）（2）と異な
る項目については23ページ「ブロック（1）～（6）の編集項目」をご参照ください。（4）PCM OSC2ブロック

（5）外部入力音ブロック OSCの代わりに、本機背面の2つの端子cl（MIC IN、INST IN）からの外部入力音を元にします。
ピッチの変更範囲に制限があります。

（6）ノイズブロック OSCの代わりに、専用のノイズ発生器によるノイズを元にします。ピッチの編集はできません。
（7）トータルブロック （1）～（6）の信号を統合し、フィルターとDSP（エフェクトの一種）を通して音色を完成します。
（8）LFO1ブロック “LFO”とはLow Frequency Oscillator（低周波発信器）の略で、モジュレーションやトレモロなど

のゆらぎ効果の元になる波形情報を各ブロックに送ります。（9）LFO2ブロック

（10）各種コントローラー

鍵盤やベンダーなどの各種操作子、あるいはMIDIメッセージなど。（1）～（9）の各ブロックにコン
トロールメッセージを送って音色をコントロールします。
またバーチャルコントローラー機能を使えば、例えば「ペダルを踏んで、音量を変える」という具合
に、コントローラーの種類（ソース）とコントロールされるパラメーター（デスティネーション）の
組み合わせを自由に設定することができます。

音量

時間
アタック サステイン リリース2

ディケイ リリース1
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■ブロック（1）～（6）の編集項目
• 特に重要な一部の項目については、5（9本のスライダー）や3（4つのノブ）で簡単に調整することができます（32ページ）。

事前のご準備
20ページ「音色を編集して保存する」の手順2の画面から、次の操作をします。

1.“OSC Block >Ent”を選び、br（ENTER）を押してグループの中に入る。

2.9（PART －、＋）で編集したいブロックを選ぶ。

編集項目リスト
• 網掛けは、複数の項目からなるグループです。br（ENTER）押しで、そのグループ内の項目を表示します。
• 表示の末尾に（V）と記載した項目は、ブロック（10）「バーチャルコントローラー」のデスティネーション（28ページ）として選ぶ
ことができます。

表示 内容 設定範囲

OSC On/Off OSCオンオフ（OSC On/Off）。オフにするとブロック全体が無効になる。 Off, On

Oscillator >Ent
（ブロック（1）～（5）のみ）

オシレーター（Oscillator）。シンセOSC、PCM OSC、またはピッチシフターのピッ
チにかかわる編集項目グループ。
• 20ページ「音色を編集して保存する」の手順1の後に、7（EDIT）をしばらく押
したままにすると、ショートカットでこのグループの中に入ることができます。

Synth Wave
（ブロック（1）（2）のみ）
PCM Wave
（ブロック（3）（4）のみ）

シンセ波形（SYNTH WAVE）、PCM波形（PCM WAVE）。シンセOSCまたはPCM 
OSCでの発生音の、元にする波形を選ぶ。
•“L”または“B”表示つきの波形は、本来のピッチより1オクターブ低く発音しま
す。また“B”表示つきの波形は、C5より上の鍵盤では発音しません。

• 波形の種類は別紙「Appendix」をご覧ください。
• ブロック（5）には、この項目はありません。
• ユーザーウェーブ音色（User Wave）の各スプリットを、PCM Waveとしてアサ
インすることができます。 
ユーザーウェーブ名は、例として“UserWave 1-2”と表示されます。最初の番号
（例では1）は「ユーザーウェーブ番号：1～10、あるいはR（サンプルルーパーで録
音したデータ）」が入ります。“ - ”の後の番号（例では2）は「スプリット番号：1～
5」が入ります。
また、波形が存在するデータの場合、ユーザーウェーブ名の頭に“ * ”が付きます。

別紙「Appendix」参照

Pitch（V） ピッチ（Pitch）。音程を調整する、最大、最小値で±2オクターブ変化する。 －256 - 0 - ＋255

Detune（V） デチューン（Detune）。チューニングの微調整。 －256 - 0 - ＋255

KeyFollow（V）

キーフォロー（Key Follow）。隣り合う鍵盤の間のピッチ変化量。数値が高いほど変
化が大きくなる。
例：キーフォローベース（Key Follow Base）がC4鍵盤のとき

－128 - 0 - ＋127

KeyFolBase（V） キーフォローベース（Key Follow Base）。キーフォローの中心となる鍵盤。
• 鍵盤で設定値を入力することができます。 C- - G9※

Env.Depth（V） エンベロープデプス（Envelope Depth）。下記エンベロープのかかり具合。 －64 - 0 - ＋63

ブロック
Syn1: シンセOSC1
Syn2: シンセOSC2
PCM1: PCM OSC1
PCM2: PCM OSC2
Ext: 外部入力
Noise: ノイズ

D4

C#4

C4

C4

Key Follow = 127

Key Follow = 64

Key Follow = 0

Key Follow = -127
C#4

Bb4 Key Follow

Key Follow Base
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Envelope >Ent

ピッチエンベロープ（Envelope）。シンセOSC、PCM OSC、またはピッチシフター
にかけるエンベロープ（Envelope Generator）の編集項目グループ。
• 下の概要図はフィルターやアンプなど他のエンベロープにも適用します。ピッ
チエンベロープでは、音の高さが縦軸「Level」に該当します。

Init.Level（V） イニシャルレベル（Initial Level）。発音開始時の音の高さ。 －64 - 0 - ＋63

Atk.Time（V） アタックタイム（Attack Time）。イニシャルレベルからアタックレベルに達する
までの時間。 0 - 127

Atk.Level（V） アタックレベル（Attack Level）。発音開始直後の変化で到達目標とするレベル。 －64 - 0 - ＋63

Dcy.Time（V） ディケイタイム（Decay Time）。アタックレベルからサステインレベルに達するま
での時間。 0 - 127

Sus.Level（V） サステインレベル（Sustain Level）。鍵盤やペダルで音を持続させているときのレ
ベル。 －64 - 0 - ＋63

Rel.Time1（V） リリースタイム1（Release Time1）。鍵盤を離してからリリースレベル1に達する
までの時間。 0 - 127

Rel.Level1（V） リリースレベル1（Release Level1）。鍵盤を離した直後の変化で目標とするレベ
ル。 －64 - 0 - ＋63

Rel.Time2（V） リリースタイム2（Release Time2）。リリースレベル1からリリースレベル2に達
するまでの時間。 0 - 127

Rel.Level2（V） リリースレベル2（Release Level2）。鍵盤を離してからの変化で、目標とする二つ
目のレベル。 －64 - 0 - ＋63

Clk.Trig クロックトリガー（Clock Trigger）。エンベロープをリセットする拍数を指定す
る。1/4U～4Uを選択すると、裏拍のタイミングでリセットする。

Off, 1/4, 1/3, 1/2, 
2/3, 1, 3/2, 2, 3, 4, 
1/4U, 1/3U, 1/2U, 
2/3U, 1U, 3/2U, 2U, 
3U, 4U

Ext.Trig
（ブロック（5）のみ）

外部入力トリガー（External Trigger）。オンに設定すると、外部入力によってエン
ベロープをリセットする。 Off, On

LFO1 Depth（V） LFO1デプス（LFO1 Depth）。ブロック（8）からのLFO1のかかり具合。 －64 - 0 - ＋63

LFO2 Depth（V） LFO2デプス（LFO2 Depth）。ブロック（9）からのLFO2のかかり具合。 －64 - 0 - ＋63

PulseWidth
（ブロック（1）（2）のみ）
（V）

パルスワイズ（Pulse Width）。シンセ波形が矩形波のときの、矩形波の幅を調整す
る。 0 - 127

PWM LFO1 Dep
（ブロック（1）（2）のみ）
（V）

PWM LFO1デプス（PWM LFO1 Depth）。LFO1によるパルス幅変調（Pulse 
Width Modulation）の深さを調整する。

－64 - 0 - ＋63

PWM LFO2 Dep
（ブロック（1）（2）のみ）
（V）

PWM LFO2デプス（PWM LFO2 Depth）。LFO2によるパルス幅変調（Pulse 
Width Modulation）の深さを調整する。 －64 - 0 - ＋63

表示 内容 設定範囲

IL

AL

SL RL1

RL2

AT DT RT1 RT2

Level

Time

IL : Init Level RT1 : Release Time1
AT : Attack Time RL1 : Release Level1
AL : Attack Level RT2 : Release Time2
DT : Decay Time RL2 : Release Level2
SL : Sustain Level

PWM



音色（トーン）を選ぶ／音色を作る

25

Sync OSC
（ブロック（2）のみ）

オシレーターシンク（Sync OSC）。オンにすると、ブロック（2）の音の波形を、ブ
ロック（1）の音の波形周期にあわせてリセットして両者を同期させます。 Off, On

OriginalKey
（ブロック（5）のみ）（V）

オリジナルキー（Original Key）。ブロック（5）への外部入力音をそのままのピッチ
で鳴らす鍵盤を選ぶ。
• 鍵盤で設定値を入力することができます。

C- - G9※

MicInstLvl
（ブロック（5）のみ）（V）

マイク／インストレベル（Mic/Inst Level）。ブロック（5）への外部入力音のレベ
ル。 0 - 127

TrigThresh
（ブロック（5）のみ）（V）

トリガースレッシュホールド（Trigger Threshold）。外部入力トリガー（24ペー
ジ）をかける外部入力音レベルのしきい値。 0 - 127

TrigRelease
（ブロック（5）のみ）（V）

トリガーリリースタイム（Trigger Release Time）。外部入力トリガー（24ページ）
動作後、次のトリガー動作がすぐに起きないよう抑制している時間。 0 - 127

P.ShiftMode
（ブロック（5）のみ）

ピッチシフターモード（Pitch Shifter Mode）。この設定の値が大きいほど、発音ま
での時間が長くかかるが、音質は良くなる。オフにすると、鍵盤を変えてもピッチ
が変化しない。

Off, 1, 2, 3

P.ShiftMix
（ブロック（5）のみ）

ピッチシフターミックス（Pitch Shifter Mix）。ピッチを変更した音（シフト音）と、
変更しない音（原音）の音量比。
0 : シフト音のみ鳴る
7 : 両方が同じ音量で鳴る
15: 原音のみ鳴る

0 - 15

Noise Type（ブロック（6）のみ）
ノイズタイプ（Noise Type）。ブロック（6）で発生させるノイズの種類を選ぶ。ホワ
イトノイズ（全周波数帯域で均一の雑音）、ピンクノイズ（周波数に反比例する雑
音）などがある。
• ノイズの種類は別紙「Appendix」をご覧ください。

別紙「Appendix」参照

Filter >Ent フィルター（Filter）。各ブロック内のフィルター（音色）にかかわる編集項目グルー
プ。

Gain ゲイン（Gain）。下記カットオフ周波数（Cut off Frequency）の設定値よりも高い
周波数成分の音量の落とし具合。“Flat”に設定するとカットオフしなくなる。

－18dB, －12dB, 
－6dB, －3dB, Flat

Cutoff（V） カットオフ周波数（Cut off Frequency）。フィルターのカットオフ周波数。 0 - 15

TouchSense（V） タッチセンス（Touch Sense）。鍵盤を弾くタッチに応じて、フィルターを変化させ
る度合い。 －64 - 0 - ＋63

KeyFollow（V） キーフォロー（Key Follow）。隣り合う鍵盤の間のフィルター変化量。数値が高いほ
ど変化が大きくなる。 －128 - 0 - ＋127

KeyFolBase（V） キーフォローベース（Key Follow Base）。キーフォローの中心となる鍵盤。
• 鍵盤で設定値を入力することができます。 C- - G9※

Env.Depth（V） エンベロープデプス（Envelope Depth）。下記エンベロープのかかり具合。 －64 - 0 - ＋63

Envelope >Ent

フィルターエンベロープ（Envelope）。フィルターにかけるエンベロープ
（Envelope Generator）の編集項目グループ。

• グループ内の項目は前述の「ピッチエンベロープ」をご参照ください。ピッチエ
ンベロープの概要図の縦軸「Level」には、フィルターのかかり具合が該当しま
す。

0 - 127（イニシャルレベ
ル～リリースレベル2）
• クロックトリガーと外
部入力トリガーの設定
範囲は「ピッチエンベ
ロープ」と同じ。

LFO1 Depth（V） LFO1デプス（LFO1 Depth）。ブロック（8）からのLFO1のかかり具合。 －64 - 0 - ＋63

LFO2 Depth（V） LFO2デプス（LFO2 Depth）。ブロック（9）からのLFO2のかかり具合。 －64 - 0 - ＋63

Amp >Ent アンプ（Amp）。各ブロック内のアンプ（音量）にかかわる編集項目グループ。

Volume（V） 音量（Volume）。アンプの音量設定。 0 - 127

TouchSense（V） タッチセンス（Touch Sense）。鍵盤を弾くタッチに応じて、音量を変化させる度合
い。 －64 - 0 - ＋63

KeyFollow（V） キーフォロー（Key Follow）。隣り合う鍵盤の間の音量変化。数値が高いほど変化が
大きくなる。 －128 - 0 - ＋127

KeyFolBase（V） キーフォローベース（Key Follow Base）。キーフォローの中心となる鍵盤。
• 鍵盤で設定値を入力することができます。 C- - G9※

Envelope >Ent

アンプエンベロープ（Envelope）。アンプにかけるエンベロープ（Envelope 
Generator）の編集項目グループ。
• グループ内の項目は前述の「ピッチエンベロープ」をご参照ください。ピッチエ
ンベロープの概要図の縦軸「Level」には、音量が該当します。ただし「イニシャル
レベル」から「リリースレベル2」までの9項目の設定範囲は「0 - 127」で、ピッチ
エンベロープとは異なります。

0 - 127（イニシャルレベ
ル～リリースレベル2）
• クロックトリガーと外
部入力トリガーの設定
範囲は「ピッチエンベ
ロープ」と同じ。

LFO1 Depth（V） LFO1デプス（LFO1 Depth）。ブロック（8）からのLFO1のかかり具合。 －64 - 0 - ＋63

LFO2 Depth（V） LFO2デプス（LFO2 Depth）。ブロック（9）からのLFO2のかかり具合。 －64 - 0 - ＋63

Legato レガート（Legato）。オンに設定すると次の音へのつながりがなめらかになる。 Off, On

表示 内容 設定範囲
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※画面表示の“C-”は、C-1（C0の1オクターブ下）を表します。

■ブロック（7）「トータルブロック」のフィルター編集項目
事前のご準備
20ページ「音色を編集して保存する」の手順2の画面で“Total Filter >Ent”を選び、br（ENTER）を押してグループの中に入ってく
ださい。

編集項目リスト
• 網掛けは、複数の項目からなるグループです。br（ENTER）押しで、そのグループ内の項目を表示します。
• 表示の末尾に（V）と記載した項目は、ブロック（10）「バーチャルコントローラー」のデスティネーション（28ページ）として選ぶ
ことができます。

※画面表示の“C-”は、C-1（C0の1オクターブ下）を表します。

Portamento ポルタメント（Portament）。オンに設定するとポルタメント効果がかかる。
• ブロック（6）には、この項目はありません。 Off, On

PortaTime（V）
ポルタメントタイム（Portament Time）。ポルタメントで次の音に到達するまで
の時間。
• ブロック（6）には、この項目はありません。

0 - 127

表示 内容 設定範囲

FilterType
フィルタータイプ（Filter Type）。フィルターの種類を選ぶ。
LPF: ローパスフィルター。カットオフ周波数以上の高域成分をカットする。
BPF: バンドパスフィルター。カットオフ周波数を中心に合わせて低域、高域成分をカットする。
HPF:ハイパスフィルター。カットオフ周波数以下の低域成分をカットする。

左記参照

CutOff（V） カットオフ周波数（Cut off Frequency）。ソロシンセサイザー音色のカットオフ周波数。 0 - 127

Resonance（V） レゾナンス（Resonance）。カットオフ周波数付近につける音色のくせの度合い。 0 - 127

TouchSense（V） タッチセンス（Touch Sense）。鍵盤を弾くタッチに応じて、フィルターを変化させる度合い。 －64 - 0 - ＋63

KeyFollow（V） キーフォロー（Key Follow）。隣り合う鍵盤の間のフィルター変化量。数値が高いほど変化が大きく
なる。 －128 - 0 - ＋127

KeyFolBase（V） キーフォローベース（Key Follow Base）。キーフォローの中心となる鍵盤。
• 鍵盤で設定値を入力することができます。 C- - G9※

Env.Retrig エンベロープリトリガー（Envelope Generator Retrigger）。この設定をオンにすると、押鍵の度
にフィルターをリセットする。 Off, On

Env.Depth（V） エンベロープデプス（Envelope Depth）。下記エンベロープのかかり具合。 －64 - 0 - ＋63

Envelope >Ent
トータルフィルターエンベロープ（Envelope）。トータルブロックのフィルターにかけるエンベ
ロープ（Envelope Generator）の編集項目グループ。
• グループ内の項目は前述の「ピッチエンベロープ」をご参照ください。ピッチエンベロープの概要
図の縦軸「Level」には、フィルターのかかり具合が該当します。

0 - 127（イニシャルレベ
ル～リリースレベル2）
• クロックトリガーと外
部入力トリガーの設定
範囲は「ピッチエンベ
ロープ」と同じ。

LFO1 Depth（V） LFO1デプス（LFO1 Depth）。ブロック（8）からのLFO1のかかり具合。 －64 - 0 - ＋63

LFO2 Depth（V） LFO2デプス（LFO2 Depth）。ブロック（9）からのLFO2のかかり具合。 －64 - 0 - ＋63

表示 内容 設定範囲
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■ブロック（8）（9）「LFO1、LFO2ブロック」の編集項目
事前のご準備
20ページ「音色を編集して保存する」の手順2の画面から、次の操作をします。

1.“LFO >Ent”を選び、br（ENTER）を押してグループの中に入る。

2.9（PART －、＋）で編集したいブロックを選ぶ。
編集項目リスト
• 表示の末尾に（V）と記載した項目は、ブロック（10）「バーチャルコントローラー」のデスティネーション（28ページ）として選ぶ
ことができます。

表示 内容 設定範囲

WaveType

波形タイプ（Wave Type）。LFOに用いる波形の種類を以下から選ぶ。

左記参照

Sync
シンク（Sync）。LFOを何と同期させるか。
Off： 同期をとらない。
Tempo： クロックシンク（下記）で設定された拍に同期する。
LFO1（LFO2でのみ選択可能）： LFO2を、LFO1に同期させる。 

左記参照

Rate（V） レート（Rate）。LFOの速さ（周波数）。シンク設定がオフの場合に有効。 0 - 127

Clk.Sync
クロックシンク（Clock Sync）。LFOの周期を同期させる拍数を指定する。1/4U～4Uを選択する
と、裏拍のタイミングに同期する。
• シンク設定が“Tempo”のときのみ有効。

1/4, 1/3, 1/2, 2/3, 1, 
3/2, 2, 3, 4, 1/4U, 
1/3U, 1/2U, 2/3U, 
1U, 3/2U, 2U, 3U, 4U

Depth（V） デプス（Depth）。LFOのかかり具合。 0 - 127

Delay（V） ディレイ（Delay）。LFOのかかるタイミングを遅らせる度合い。 0 - 127

Rise（V） ライズ（Rise）。LFOがかかり始めてから、効果の深さが上記デプスで設定されたレベルに達するま
での時間。 0 - 127

Mod.Depth（V） モジュレーションデプス（Modulation Depth）。LFOに対するモジュレーションのかかり具合。 0 - 127

Sin
（サイン波）

Puls 1:3
（矩形波1:3）

Tri
（三角波）

Puls 2:2
（矩形波2:2）

Saw up
（鋸波アップ）

Puls 3:1
（矩形波3:1）

Saw down
（鋸波ダウン）

Random
（ランダム）
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■ブロック（10）「各種コントローラー」の、バーチャルコントローラー編集項目
好きな入力手段（ソース）で、好きな編集項目（操作対象：デスティネーション）を調整するための、仮想コントローラーです。

事前のご準備
20ページ「音色を編集して保存する」の手順2の画面から、次の操作をします。

1.“VirtualCtrl >Ent”を選び、br（ENTER）を押してグループの中に入る。
• コントローラーは1～8番まであり、それぞれスライダー 5（1/9～8/16）にも割り当てられます。

2.9（PART －、＋）で編集したいコントローラー番号を選ぶ。
編集項目リスト

■その他の編集項目
これまでご紹介したもの以外の編集項目です。これらは、ソロシンセサイザーのみでなく、他のカテゴリーの音色にも共通の項目
です。

事前のご準備
20ページ「音色を編集して保存する」の手順2の画面を表示させてください。

編集項目リスト
• 網掛けは、複数の項目からなるグループです。br（ENTER）押しで、そのグループ内の項目を表示します。

表示 内容 設定範囲

Source

ソース（Source）。入力手段を選ぶ。
Off: 無効
CC00 - CC97: MIDIのコントロールチェンジ。※
NoteOnKeyNum: MIDIのノートオンメッセージのキーナンバー
NoteOnVel: MIDIのノートオンメッセージのベロシティー値
Ch.Pressure: MIDIのチャンネルアフタータッチ
Bend Up: bt（BENDER）の中央から上への操作
Bend Down: bt（BENDER）の中央から下への操作
Modulation: bt（MODULATION）の操作
LFO1: LFO1（ブロック（8））
LFO2: LFO2（ブロック（9））
※各値の内容は、MIDIインプリメンテーション（http://casio.jp/support/emi/）や、MIDI関係の
資料でご確認ください。

左記参照

Depth デプス（Depth）。バーチャルコントローラのかかり具合。 －128 - 0 - ＋127

Dest デスティネーション（Destination）。バーチャルコントローラの操作対象となるパラメーターを選
ぶ。

• Off
• ブロック（1）～（9）のパ
ラメーター（23～27
ページ）のうち、「表示」
の末尾にV）が記載され
ているもの。

• DSPパラメーター
（89ページ）

表示 内容 設定範囲

DSP On/Off（ソ
ロシンセサイザー
以外の音色のみ）

DSPオンオフ（DSP On/Off）。 音色にDSPをかけるか、かけないかを設定する。
• オンの場合は、br（ENTER）押しでDSP編集画面（36ページ）に入ることができます。
• ソロシンセサイザー音色の編集リストには、この項目は存在しません。

Off, On

DSP Edit >Ent
DSP編集（DSP Edit）。エフェクト機能のDSP（34ページ）の編集項目グループ。br（ENTER）押し
で、DSP編集画面（36ページ）に進む。
• 上記の「DSPオンオフ」がオフの場合は無効になります。

Volume 音量（Volume）。音色全体の音量。 0 - 127

Rev.Send リバーブセンド（Reverb Send）。音色へのリバーブ（34ページ）のかかり具合。 0 - 127

Cho.Send（ソロ
シンセサイザー以
外の音色のみ）

コーラスセンド（Chorus Send）。音色へのコーラス（34ページ）のかかり具合。
• ソロシンセサイザー音色のリストでは、この項目は存在しません。 0 - 127
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PCMメロディー音色に特有の編集項目と、他の音色カテゴリーと共通の編集項目、の2種類があります。
PCMメロディー音色のうち、ドラムセット音色は、項目内容が異なりますので、29ページ「PCMドラム音色の編集内容」をご参照
ください。

■PCMメロディー音色特有の編集項目
事前のご準備
20ページ「音色を編集して保存する」の手順2の画面を表示させてください。

編集項目リスト

■他の音色カテゴリーと共通の編集項目
28ページ「その他の編集項目」をご参照ください。

ドラムセット音色の編集項目です。PCMドラム音色特有の編集項目と、他の音色カテゴリーと共通の編集項目、の2種類があります。

■PCMドラム音色特有の編集項目
事前のご準備
20ページ「音色を編集して保存する」の手順2の画面を表示させてください。
編集項目リスト
• 網掛けは、複数の項目からなるグループです。br（ENTER）押しで、そのグループ内の項目を表示します。

PCMメロディー音色（ドラム以外のPCM音色）の編集内容

表示 内容 設定範囲

Atk.Time アタックタイム（Attack Time）。発音開始から最大音量（アタックレベル）に達するまでの時間。 －64 - 0 - ＋63

Rel.Time リリースタイム（Release Time）。鍵盤を離してから音が消えるまでの時間。 －64 - 0 - ＋63

Cutoff カットオフ周波数（Cut off Frequency）。音色のカットオフ周波数。 －64 - 0 - ＋63

Vib.Type ビブラートタイプ（Vibrato Type）。ビブラートに用いる波形の種類を以下から選ぶ。
Sin（サイン波）、Tri（三角波）、Saw（鋸波）、Sqr（矩形波） Sin, Tri, Saw, Sqr

Vib.Depth ビブラートデプス（Vibrato Depth）。ビブラートのかかり具合を調整する。 －64 - 0 - ＋63

Vib.Rate ビブラートレート（Vibrato Rate）。ビブラートの速さ（周波数）を調整する。 －64 - 0 - ＋63

Vib.Delay ビブラートディレイ（Vibrato Delay）。ビブラートがかかるタイミングを遅らせる度合い。 －64 - 0 - ＋63

Oct.Shift オクターブシフト（Octave Shift）。音の高さをオクターブ単位で変更する。 －2 - 0 - ＋2

TouchSense タッチセンス（Touch Sense）。鍵盤を弾くタッチに応じて、音量を変化させる度合い。 －64 - 0 - ＋63

PCMドラム音色の編集内容

表示 内容 設定範囲

Inst Edit >Ent

インストエディット（Inst Edit）。個々の鍵盤ごとに割り当てる楽器（インスト）の
編集項目グループ。
• 鍵盤を押して、編集する鍵盤を指定します。
• 20ページ「音色を編集して保存する」の手順1の後に、7（EDIT）をしばらく押し
たままにすると、ショートカットでこのグループの中に入ることができます。

（C- - G9）※

Inst Select >Ent

インスト選択（Inst Select）。音色の編集項目グループ。鍵盤を押す強さ（Velocity）
を4段階（ベロシティーレンジ）に分けて、レンジ毎に異なる音色（Inst Number）を
鳴らすことができる。
• 編集するレンジを選ぶには、9（PART －、＋）を押します。

レンジ1 レンジ2 レンジ3 レンジ4

0

Velocity Range Hi

Inst Number

[1]

[1]

[2]

[2]

[3]

[3]

[4]

[4]

127 Velocity

指定不可
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※画面表示の“C-”は、C-1（C0の1オクターブ下）を表します。

■他の音色カテゴリーと共通の編集項目
ソロシンセサイザー音色の28ページ「その他の編集項目」をご参照ください。

音色カテゴリー「ユーザーウェーブ音色」の編集項目と、他の音色カテゴリーと共通の編集項目、の2種類があります。

■ユーザーウェーブ音色特有の編集項目
事前のご準備
20ページ「音色を編集して保存する」の手順2の画面を表示させてください。

編集項目リスト
• 網掛けは、複数の項目からなるグループです。br（ENTER）押しで、そのグループ内の項目を表示します。

Inst Number

インストナンバー（Inst Number）。ベロシティーレンジごとに割り当てるドラム
音色の波形を選ぶ。
• 波形の種類は別紙「Appendix」をご覧ください。
• ユーザーウェーブ音色（User Wave）の各スプリットを、Inst Numberとしてア
サインすることができます。 
ユーザーウェーブ名は、例として“UserWave 1-2”と表示されます。最初の番号
（例では1）は「ユーザーウェーブ番号：1～10、あるいはR（サンプルルーパーで録
音したデータ）」が入ります。“ - ”の後の番号（例では2）は「スプリット番号：1～
5」が入ります。
また、波形が存在するデータの場合、ユーザーウェーブ名の頭に“ * ”が付きます。

別紙「Appendix」参照

VelRangeHi ベロシティーレンジハイ（Velocity Range Hi）。ベロシティーレンジごとの上限を
決める。 0 - 127

Volume 音量（Volume）。ドラム音の音量を調整する。 －128 - 0 - ＋127

Pan パン（Pan）。ドラム音のステレオ定位を調整する。 －64 - 0 - ＋63

Rev.Send リバーブセンド（Reverb Send）。ドラム音色へのリバーブのかかり具合を調整する。 0 - 127

NoteOffMode ノートオフモード（Note Off Mode）。この設定をオンにすると、鍵盤を離すと音
が消える。 Off, On

Assign Grp アサイングループ（Assign Group）。今選んでいる鍵盤を1～15のうちどのグルー
プに入れるか選ぶ。同じグループ内の鍵盤は、同時に一つしか鳴らない（排他発音）。 Off, 1 - 15

Pitch LFO >Ent ピッチLFO（Pitch LFO）。ピッチにかけるLFOの編集項目グループ。

WaveType 波形タイプ（Wave Type）。LFOに用いる波形の種類を選ぶ。選べる波形の内容は、
27ページ「ブロック（8）（9）の編集項目」の「波形タイプ（Wave Type）」と同じ。

Sin, Tri, SawUp, 
SawDown, Puls1:3, 
Puls2:2, Puls3:1

Rate レート（Rate）。LFOの速さ（周波数）。 0 - 127

Depth デプス（Depth）。LFOのかかり具合。 －128 - 0 - ＋127

Delay ディレイ（Delay）。LFOのかかるタイミングを遅らせる度合い。 0 - 127

Rise ライズ（Rise）。LFOがかかり始めてから、効果の深さが上記デプス（Depth）で設定
されたレベルに達するまでの時間。 0 - 127

Mod.Depth モジュレーションデプス（Modulation Depth）。LFOに対するモジュレーション
のかかり具合。 0 - 127

After Depth アフターデプス（After Depth）。MIDIのチャンネルアフタータッチを受信したと
きの、LFO変化の度合い。 0 - 127

Amp LFO >Ent アンプLFO（Amp LFO）。音量にかけるLFOの編集項目グループ。グループ内の項
目内容と設定範囲は、上記ピッチLFO（Pitch LFO）と同じ。 左記参照

ユーザーウェーブ音色の編集内容

表示 内容 設定範囲

Split Edit >Ent
スプリットの編集（Split Edit）。サンプルルーパーで録音されたスプリットの編集項
目グループ。
• スプリットを切り替えるには、9（PART －、＋）を押します。

Volume 音量（Volume）。音量を調整する。 0 - 127

Pan パン（Pan）。音のステレオ定位を調整する。 －64 - 0 - 63

CoarseTune コースチューン（Coarse Tune）。音の高さを半音単位で調整する。 －24 - 0 - 24

Fine Tune ファインチューン（Fine Tune）。音の高さを微調整する。設定値－256で半音下が
り、＋255で半音上がる。 －256 - 0 - 255

表示 内容 設定範囲
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※画面表示の“C-”は、C-1（C0の1オクターブ下）を表します。

■他の音色カテゴリーと共通の編集項目
28ページ「その他の編集項目」をご参照ください。

CutOff カットオフ周波数（Cut off Frequency）。ユーザーウェーブ音色のカットオフ周波数。 0 - 127

TouchSense タッチセンス（Touch Sense）。鍵盤を弾くタッチに応じて、音量を変化させる度合い。 －64 - 0 - 63

KeyFollow キーフォロー（Key Follow）。隣り合う鍵盤の間のピッチ変化量。数値が高いほど変
化が大きくなる。 －128 - 0 - 127

KeyFolBase キーフォローベース（Key Follow Base）。キーフォローの中心となる鍵盤。
• 鍵盤で設定値を入力することができます。 C- - G9※

P.Env.Depth ピッチエンベロープデプス（Pitch envelope depth）。ピッチにかけるエンベロープ
のかかり具合。 －64 - 0 - 63

Pitch Env >Ent ピッチエンベロープ（Envelope）。ピッチにかけるエンベロープ（Envelope 
Generator）の編集項目グループ。

Init.Level イニシャルレベル（Initial Level）。発音開始時の音の高さ。 －64 - 0 - 63

Atk.Time アタックタイム（Attack Time）。イニシャルレベルからレベル0に達するまでの時間。 0 - 127

Rel.Time リリースタイム（Release Time）。鍵盤を離してからリリースレベルに達するまでの
時間。 0 - 127

Rel.Level リリースレベル（Release Level）。鍵盤を離した直後の変化で目標とするレベル。 －64 - 0 - 63

Amp Env >Ent

アンプエンベロープ（Envelope）。アンプにかけるエンベロープ（Envelope 
Generator）の編集項目グループ。
• グループ内の項目は24ページの「ピッチエンベロープ」をご参照ください。ピッチ
エンベロープの概要図の縦軸「Level」には、音量が該当します。ただし「イニシャル
レベル」から「リリースレベル2」までの9項目の設定範囲は「0 - 127」で、ピッチエ
ンベロープとは異なります。また、「クロックトリガー」の1項目は入っていません。

0 - 127（イニシャルレ
ベル～リリースレベル
2）
• 外部入力トリガーの
設定範囲は「ピッチエ
ンベロープ」と同じ。

KeyRangeLow キーレンジロー（Key Range Low） 。スプリット再生の有効な鍵域の下限を設定する。
• 鍵盤で設定値を入力することができます。 C- - G9※

KeyRangeHi キーレンジハイ（Key Range High） 。スプリット再生の有効な鍵域の上限を設定する。
• 鍵盤で設定値を入力することができます。 C- - G9※

OriginalKey オリジナルキー（Original Key）。スプリットをそのままのピッチで鳴らす鍵盤を選ぶ。
• 鍵盤で設定値を入力することができます。 C- - G9※

Points >Ent ポイント（Points）。スプリットの開始、ループ、終了の各位置を変更する。

Start

開始位置（Start point）。下図のようにスプリット全体の長さは数値で記録されており、
スプリットの先頭の数値を変更することで、スプリットの開始タイミングを変更する。
• bq（0～9）でスプリットの開始位置の値を入力することができます。
• br（－、＋）で、上3桁の値を変更することができます。
例：開始位置の数値を100000から125000へ変更することで、開始タイミング

を後ろにする。 0 - 205000
（ステレオ録音時）、
0 - 410000
（モノラル録音時）

Loop
ループ位置（Loop point）。Start Pointと同様に、スプリットのループタイミングを
変更する。
• bq（0～9）でスプリットのループ位置の値を入力することができます。
• br（－、＋）で、上3桁の値を変更することができます。

0 - 205000
（ステレオ録音時）、
0 - 410000
（モノラル録音時）

End
終了位置（End point）。Start Pointと同様に、スプリットの終了タイミングを変更する。
• bq（0～9）でスプリットの終了位置の値を入力することができます。
• br（－、＋）で、上3桁の値を変更することができます。

0 - 205000
（ステレオ録音時）、
0 - 410000
（モノラル録音時）

Pitch LFO >Ent
ピッチLFO（Pitch LFO）。ピッチにかけるLFOの編集項目グループ。グループ内の項
目内容と設定範囲は、29ページ「PCMドラム音色特有の編集項目」のピッチLFO
（Pitch LFO）と同じ。

左記参照

Amp LFO >Ent
アンプLFO（Amp LFO）。音量にかけるLFOの編集項目グループ。グループ内の項目
内容と設定範囲は、29ページ「PCMドラム音色特有の編集項目」のアンプLFO（Amp 
LFO）と同じ。

左記参照

表示 内容 設定範囲

Start Point Loop Point End Point

100000 150000 200000
125000
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ペダルやベンダーなどを使って、音の高さや音量、エンベロー
プなどを、演奏中に素早くコントロールすることができます。

ペダルを踏んで、鳴っている音やアルペジオ（37ページ）、フ
レーズ（41ページ）などを持続させたり、ソフト効果をつけた
りすることができます。
• ペダルの接続は、7ページをご参照ください。
• ペダルの効果は、パフォーマンス編集項目リストの
“Controller >Ent”3“Pedal”で選ぶことができます。詳し
くは68ページをご参照ください。

ホイールbt（BENDER、MODURATION）を動かして、音の
高さ（ピッチ）を滑らかに上下させたり、音にビブラート（モ
ジュレーション効果）をかけることができます。

• 電源を入れるときは、ホイールを動かさないようにしてく
ださい。

• bt（BENDER）で変更できるピッチ幅（ベンドレンジ）は、
パフォーマンス編集項目リストの“BendRngDwn”
“BendRngUp”で、パートごとに設定できます（67ペー
ジ）。

4つのノブ3（ASSIGNABLE KNOBS）を回して、音のエン
ベロープ（アタックタイムなど、21ページ）や音量などをすば
やく調整することができます。

• ゾーンパート1の音色カテゴリーにより、各ノブの機能は次
のようになります。

ソロシンセサイザー音色（23ページ）

PCMメロディー音色（29ページ）

PCMドラム音色（29ページ）

ユーザーウェーブ音色（30ページ）

上の機能は、トーンモード画面に省略名で表示されます。

• パフォーマンスモードでは、各ノブの効果の種類は、
パフォーマンス編集項目リストの“Controller >Ent”3
“K1～K4”で切り替えることができます（68ページ）。

5（9本のスライダー）を使って、ソロシンセサイザー音色の
オシレーター、エンベロープ、トータルフィルター／LFOの各
パラメーターを間単に調整することができます。

1. ソロシンセサイザー音色を選びます。

2.1のオシレーター（OSC BLOCK）、エンベロープ
（ENV GENERATOR）、トータルフィルター／
LFO（TOTAL FILTER/LFO）のうち、スライダーに
よる編集対象をボタンから選び点灯させます。

3.2（3つのボタン）を押して、以下を選びます。

音をコントロールする

ペダルを使う

ホイールを使う（ベンダー、モジュレーション）

bt

アサイナブルノブを使う

3

K1: バーチャルコントローラー1（28ページ）
K2: バーチャルコントローラー2（28ページ）
K3: バーチャルコントローラー3（28ページ）
K4: バーチャルコントローラー4（28ページ）

K1: Cut off Frequency
K2: Attack Time
K3: Release Time
K4: Reverb Send（他の音色カテゴリーと共通）

ピッチの上下
（ホイールを離すと、
元のピッチになる）

モジュレーション効果
（ホイールを上げると、
効果がかかる）

K1: Volume（Drum Inst >）
K2: Pan（Drum Inst >）
K3: Reverb Send（Drum Inst >）
K4: Reverb Send（他の音色カテゴリーと共通）

K1: Cut off Frequency
K2: Attack Time（Amp Envelope >）
K3: Release Time（Amp Envelope >）
K4: Reverb Send（他の音色カテゴリーと共通）

スライダーを使う

Y手順2でオシレーターを選んだ場合
2（SELECT OSC）を押すごとに、OSCブロックの
（1）～（6）およびALL（（1）～（6）すべて）が順に切り替
わります。

Y手順2でエンベロープを選んだ場合
• 2（SELECT OSC）を押すごとに、OSCブロックの
（1）～（6）およびALL（（1）～（6）すべて）が順に切り
替わります。

• 2（SELECT EG）を押すごとに、EGブロックの
OSC／フィルター／アンプ／ALL（OSC、フィル
ター、アンプのすべて）が順に切り替わります。

Y手順2でトータルフィルター／LFOを選んだ場合
2（SELECT LFO）を押すごとに、LFO 1、LFO 2、ALL
が順に切り替わります。
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4.5（スライダー）を動かして、割り当てられているパラメーターを調整します。
• スライダーに割り当てられているパラメーターは以下の表をご参照ください。パラメーターの詳細は、各掲載ページをご参
照ください。

• パフォーマンスモードやステップシーケンサーモードにいながら、1のボタンを押すことにより、モードを変えずにスライ
ダーで音色を編集することができます。

• PCM音色およびユーザーウェーブ音色は、スライダーでは調整できません。
• ステップシーケンサーやミキサーモードでのスライダー機能については、それぞれの機能の説明（48、71ページ）をご参照くだ
さい。

1ボタン 5（スライダー） パネル表示 パラメーター 掲載ページ

OSC BLOCK

1/9 OSC ON/OFF OSC Block > OSC On/Off 23

2/10 WAVE
OSC Block > Oscillator > Wave（Ext OSCでは無効）
• スライダーで選択可能なWAVEの種類は、別紙「Appendix」を
ご覧ください。

23

3/11 PITCH OSC Block > Oscillator > Pitch（Noise OSCでは無効） 23

4/12 DETUNE OSC Block > Oscillator > Detune（Noise OSCでは無効） 23

5/13 PORTA TIME OSC Block > PortaTime 26

6/14 P.ENV DEPTH OSC Block > Oscillator > Env.Depth（Noise OSCでは無効） 23

7/15 CUTOFF OSC Block > Filter > CutOff 25

8/16 F.ENV DEPTH OSC Block > Filter > Env.Depth 25

MASTER VOLUME OSC Block > Amp > Volume 25

ENV GENERATOR

1/9 INIT LEVEL • OSC Block > Oscillator/Filter/Amp > Envelope > Init.Level
• TotalFilter > Envelope > Init.Level 24

2/10 ATK TIME • OSC Block > Oscillator/Filter/Amp > Envelope > Atk.Time
• TotalFilter > Envelope > Atk.Time 24

3/11 ATK LEVEL • OSC Block > Oscillator/Filter/Amp > Envelope > Atk.Level
• TotalFilter > Envelope > Atk.Level 24

4/12 DCY TIME • OSC Block > Oscillator/Filter/Amp > Envelope > Dcy.Time
• TotalFilter > Envelope > Dcy.Time 24

5/13 SUS LEVEL • OSC Block > Oscillator/Filter/Amp > Envelope > Sus.Level
• TotalFilter > Envelope > Sus.Level 24

6/14 REL TIME1 • OSC Block > Oscillator/Filter/Amp > Envelope > Rel.Time1
• TotalFilter > Envelope > Rel.Time1 24

7/15 REL LEVEL1 • OSC Block > Oscillator/Filter/Amp > Envelope > Rel.Level1
• TotalFilter > Envelope > Rel.Level1 24

8/16 REL TIME2 • OSC Block > Oscillator/Filter/Amp > Envelope > Rel.Time2
• TotalFilter > Envelope > Rel.Time2 24

MASTER REL LEVEL2 • OSC Block > Oscillator/Filter/Amp > Envelope > Rel.Level2
• TotalFilter > Envelope > Rel.Level2 24

TOTAL FILTER/LFO

1/9 TOTAL FILTER TYPE TotalFilter > FilterType 26

2/10 TOTAL FILTER CUTOFF TotalFilter > CutOff 26

3/11 TOTAL FILTER RESONANCE TotalFilter > Resonance 26

4/12 TOTAL FILTER ENV.DEPTH TotalFilter > Env.Depth 26

5/13 LFO WAVE LFO > WaveType 27

6/14 LFO RATE LFO > Rate（Sync OFF以外のときは効果なし） 27

7/15 LFO DEPTH LFO > Depth 27

8/16 LFO DELAY LFO > Delay 27

MASTER LFO RISE LFO > Rise 27
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bn（HOLD）を押してボタンを点灯させると、鳴っている音や
アルペジオ（37ページ）などを持続させることができます。

• もう一度bn（HOLD）を押すと、ボタンが消灯してホールド
オフになります。

bs（TRANSPOSE、OCTAVE －、＋）を使って、鍵盤の音の
高さを、半音やオクターブ単位ですばやく変更することがで
きます。
• ヘルツ単位での微調整（チューニング）については、73ペー
ジをご参照ください。

1. 半音単位で変更するには、bs（TRANSPOSE）を押
しながら、bs（OCTAVE －、＋）を押します。
• 設定範囲は、上下1オクターブ（－12から＋12半音ま
で）です。

2. オクターブ単位で変更するには、bs（OCTAVE 
－、＋）を押します。
• 設定範囲は、上下3オクターブ（－3から＋3オクターブ
まで）です。

• 上記の表示のときは、bp（ダイヤル）や、br（－、＋）でも設
定値を変更できます。しばらく何も操作しないと、これらの
表示を終了します。

残響やビブラートなどさまざまな効果を加えて、音のグレー
ドをさらにアップさせます。

■エフェクト構成図

ホールドボタンを使う

bn

ピッチを半音やオクターブ単位で変える
（トランスポーズ、オクターブシフト）

bs

ホールドオンのとき点灯します。
bs

音にさまざまな効果をかける
（エフェクト）

音源 （5）マスター
イコライザー

（1）リバーブ

（2）コーラス

（3）ノーマル
DSP

（4）ソロシンセ
サイザーDSP

（2）（3）（4）のうちい
ずれか1つを通しま
す。
下記「コーラスとDSP
の使用制約について」
をご参照ください。

出力
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※ソロシンセサイザー音色以外の、DSP付き音色（特定のDSP使用を前提とした音色）を選んだ場合。DSP付き音色は、ミキサー
画面（71ページ）またはパフォーマンス編集画面（67ページ）で、音色名の隣に“DSP”と表示されるかどうかで確認すること
ができます。

■コーラスとDSPの使用制約について
システムの制約上、（2）（3）（4）は三者択一になります。

1. bn（EFFECT）を押したままにし、下記のエフェクトリストトップ画面が表示されたら離します。

2. あとは音色と同じ要領で、次のリストを見ながら、brを使ってリストの項目を選び、値を変更してください。

■エフェクト設定項目リスト

（1）リバーブ 室内やホールで演奏しているような残響を加える。

（2）コーラス 同じ音を複数重ねて、より厚みのある音にする。

（3）ノーマルDSP 音色を引き立てるための多彩なエフェクト。たとえばエレキギターの音に歪み効果を加えて、よ
りパワフルな音にする。46種類のDSPタイプがあり、選んだ音色にふさわしいものが自動でセッ
トされる※。編集してユーザーDSPに保存することができる。

（4）ソロシンセサイザーDSP ソロシンセサイザー音色を構成する要素の一つ（21ページ「ソロシンセサイザー音色構成図」の
「（7）トータルブロック」）。
6種類のDSPタイプがある。編集内容はソロシンセサイザーのユーザー音色の一部として保存さ
れ、ユーザーDSPとして保存することはできない。

（5）マスターイコライザー 全体音の周波数特性の調整。低域、中域1、中域2、高域、の4バンド（帯域）それぞれの周波数とゲイ
ン（音量の増幅率）を調整する。

このときは… これが有効になります パートごとの効果のかかり方
コーラスモード
• ゾーンパート1でソロシンセサイザー以外の音色を選び、
かつ「コーラス/DSP選択」（35ページ）でコーラスを選ん
でいる。

（2）コーラス ミキサーコーラスセンド設定値（72ペー
ジ）と、選んでいる音色のコーラスセンド
設定値（28ページ）に依存。

ノーマルDSPモード
• ゾーンパート1でソロシンセサイザー以外の音色を選び、
かつ「コーラス/DSP選択」でDSPを選んでいる。

（3）ノーマルDSP ミキサーDSPライン（72ページ）がオンの
パートにのみ（3）がかかる。

ソロシンセサイザー音色モード
• ゾーンパート1でソロシンセサイザー音色を選んでいる。

（4）ソロシンセサイザー
DSP

ゾーンパート1、およびミキサーDSPライ
ンがオンのパートにのみ（4）がかかる。

エフェクトの設定方法

bn

表示 内容 設定範囲

Rev.Type リバーブタイプ（Reverb Type）。リバーブ効果の種類。 Type1, Type2

Rev.Level リバーブレベル（Reverb Level）。残響音の音量。 0 - 127

Rev.Time リバーブタイム（Reverb Time）。残響の持続時間。 0 - 127

Cho Level コーラスレベル（Chorus Level）。コーラス効果の音量。 0 - 127
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Cho Rate コーラスレイト（Chorus Rate）。コーラス効果のうねりの速さ。 0 - 127

ChoSendRev コーラスセンドレベル・トゥ・リバーブ（Chorus Send Level To Reverb）。コーラス
効果のついた音全体に対してかけるリバーブのかかり具合。 0 - 127

Cho/DSP コーラス／DSP選択（Chorus/DSP）。コーラスとノーマルDSPのどちらを使用する
か（35ページ「コーラスとDSPの使用制約について」）。 Cho, DSP

DSP Select >Ent
ノーマルDSP選択画面への入り口。
• ゾーンパート1でソロシンセサイザー音色を選んでいるときは、これより先に進め
ません。

（ノーマルDSP選
択画面）

ノーマルDSPを、音色と同様の操作でプリセット、ユーザーの中から選ぶことができ
る。
• プリセットノーマルDSPの一覧は、別紙「Appendix」参照。“ton”は音色ごとの初
期プリセットDSP。

• この画面で7（EDIT）を押すと、DSP編集画面（36ページ）になる。

ton
Preset: 0-0 - 9-9
User: 0-0 - 9-9

Master EQ >Ent マスターイコライザー（34ページ、エフェクト構成図の（5））の設定グループ。

EQ Enable オフにすると、マスターイコライザーの設定が無効になる。 Off, On

Low Freq 低域周波数（Low Frequency）。低域の周波数を調整する。 200Hz, 400Hz, 
800Hz

Low Gain 低域ゲイン（Low Gain）。低域の音量増幅率。 －12 - 0 - ＋12

Mid1 Freq 中域1周波数（Mid1 Frequency）。中域1の周波数を調整する。 1.0kHz～5.0kHz

Mid1 Gain 中域1ゲイン（Mid1 Gain）。中域1の音量増幅率。 －12 - 0 - ＋12

Mid2 Freq 中域2周波数（Mid2 Frequency）。中域2の周波数を調整する。 1.0kHz～5.0kHz

Mid2 Gain 中域2ゲイン（Mid2 Gain）。中域2の音量増幅率。 －12 - 0 - ＋12

High Freq 高域周波数（High Frequency）。高域の周波数を調整する。 6.0kHz, 8.0kHz, 
10.0kHz

High Gain 高域ゲイン（High Gain）。高域の音量増幅率。 －12 - 0 - ＋12

表示 内容 設定範囲

DSPは、効果の内容によって53のDSPタイプ（種類）に分類さ
れます。たとえばプリセットノーマルDSPの0-0と0-1はどち
らも「コンプレッサー」というタイプに属しています。DSPタ
イプには、ノーマルDSP専用のタイプと、ソロシンセサイザー
DSP専用のタイプがあります。
DSPを編集して保存するときは、まずタイプを選び、それを元
に編集します。
• DSPタイプの一覧は、「DSPタイプリスト」（88ページ）をご
参照ください。

1. DSPをかけたい音色を選んで、その音色編集画面の
“DSP Edit >Ent”（28ページ）からbr（ENTER）を
押してDSP編集画面（下記）へ進んでください。
• ノーマルDSPの編集の場合は、エフェクト設定項目リ
ストの「ノーマルDSP選択画面」（36ページ）で7
（EDIT）を押してここに来ることもできます。

2. bp（ダイヤル）でDSPタイプ番号を選びます。

3. 音色の編集（20ページ）と同様の操作で、画面の
DSPパラメーターを選んで設定します。
• DSPパラメーターは、DSPタイプごとに内容が異なり
ます。詳しくは「DSPパラメーターリスト」（89ページ）
をご参照ください。

4. 編集が終わったら、以下の要領で保存してくださ
い。
7（WRITE）を押すとユーザー音色の保存画面になりま
す。ユーザー音色として保存してください（11ページ）。
• 上記手順1で「ノーマルDSP選択画面」（36ページ）から
来た場合
7（WRITE）を押すとユーザーDSPの保存画面になり
ます。ユーザー音色の保存と同じ要領で、ユーザーDSP
として保存してください。

■ユーザーDSPを外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

DSPを編集して保存する

DSPタイプ番号：タイプ名

DSPパラメーター
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アルペジオを自動的に鳴らす

アルペジオ機能を使うと、鍵盤を押さえるだけでアルペジオ
（分散和音）が自動的に再生されます。押さえている和音の構
成音を再生するものや、自動的に和音の構成音以外の音も入
れて再生するものなど、数多くのアルペジオタイプから選べ
ます。
• アルペジオ機能には100タイプのプリセットがあります。
プリセットを編集して、ユーザーセットを100タイプまで
作ることができます。

• アルペジオのタイプを選択するとき、下記の機能を付加で
きます。

1. bn（ARPEGGIO）を押したままにし、次のような
タイプ選択画面が表示されたら離します。

2. bq（PRESET/USER）を押して、プリセットアルペ
ジオかユーザーアルペジオかを選びます。
• ボタンが消灯しているときはプリセットアルペジオ、
点灯しているときはユーザーアルペジオです。

3. bq（NUM/BANK）を押して、同ボタンを点滅させ
ます。
• このボタンが点滅しているときは、bq（0～9）でバンク
を選ぶことができます。

4. bq（0～9）を押して、バンクを選びます。
• 選ぶと同時に、bq（NUM/BANK）が消灯します。この
ボタンが消灯しているときは、bq（0～9）でアルペジオ
番号を選ぶことができます。

5. bq（0～9）を押して、アルペジオ番号を選びます。
• bp（ダイヤル）を回すと、素早くアルペジオ番号を切り
替えることができます。

• br（－、＋）で、番号を1ずつ切り替えることもできま
す。br（－）とbr（＋）を両方一緒に押すとカテゴリー
の先頭の番号になります。

7 bn bp

br

5

bk

4

2

bq

ホールド（HOLD）：鍵盤を離した後もアルペジオを再生し
続けます。例えば、スプリット機能を
使っているとき片方にアルペジオを入
れるのに便利です。

シンクロ（SYNC）：鍵盤を押さえてアルペジオ機能をかけ
ると同時に、ステップシーケンサーを
自動的に再生・停止させます。

アルペジオ機能を使う

アルペジオのバンクと番号

ホールドの設定 シンクロの設定

アルペジオ名
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6. アルペジオのホールドおよびシンクロのON/OFF
を選びます。
• ホールド（HOLD）を設定したいときは、bk（STEP ＋）
を押してオンとオフを切り替えます。

• シンクロ（SYNC）を設定したいときは、bk（STEP －）
を押して、以下の中からシンクロのタイプを選びます。

• ホールドとシンクロの設定は、パフォーマンスのパラ
メーターです。

7. 鍵盤を押さえると、アルペジオを自動再生します。
• アルペジオをオフにするには、もう一度bn
（ARPEGGIO）を押します。

• ホールド中のアルペジオの再生を止めたい場合、bn
（ARPEGGIO）を押すか、ホールドの設定をオフに切
り替えます。

■アルペジオのタイプの選択画面で、選択中のアルペ
ジオのタイプに合った推奨音色を、ゾーンパート1の
音色として選ぶことができます。

1. bn（ARPEGGIO）を押したままにし、タイプ選択
画面が表示されたら離します。

2.7（EDIT）を押したままにし、bn（ARPEGGIO）
が点滅し始め点灯に変わったら離します。
• ユーザーアルペジオの場合、ユーザーデータとして保
存する時にゾーンパート1に選ばれていた音色が推奨
音色となります。

アルペジオは、ステップタイプとバリエーションタイプの2種
類があります。
• ステップタイプでは、ステップおよびパラメーターを編集
できます。最大16個のステップから構成されています。各
ステップで以下の値を変更します。

• バリエーションタイプでは、パラメーターだけ編集できま
す。

1. bn（ARPEGGIO）を押したままにし、タイプ選択
画面が表示されたら離します。

2. プリセットまたはユーザーアルペジオの中から、編
集したいアルペジオのタイプを選択します。
• 操作方法は、アルペジオタイプの選択（37ページ「アル
ペジオ機能を使う」の手順2～5）と同じ要領です。

3.7（EDIT）を押します。

4. br（q、w）で●を“Step Edit”へ移動させてか
ら、br（ENTER）を押します。
• バリエーションタイプの場合、“Step Edit”は表示され
ません。

OFF：鍵盤を押さえている間だけアルペジオを再生し
ます。

ON：鍵盤を離した後もアルペジオを再生し続けます。

OFF：シンクロを設定しません。
ON：ステップシーケンサーの再生だけシンクロしま

す。
S/S：ステップシーケンサーの再生と停止の両方とも

シンクロします（スタート／ストップ）。

アルペジオを編集する

TYPE：押した鍵盤のうちどの音を鳴らすかを、一番低い音
（L1）や一番高い音（U1）を基準にしたTYPEの中か
らステップごとに選びます。押した鍵盤を最大5音
まで同時に鳴らす（P2～P5）TYPEもあります。

NOTE：押した鍵盤からノートをシフトさせたいとき、その
シフトさせる値を半音単位で指定できます。

VELO：音量を指定します。

ステップのタイプ

ステップ番号
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5. bp（ダイヤル）またはbr（－、＋）を使って、TYPE、NOTE、VELOの値を変更します。
• 4（1～16）を使って、ステップのオンとオフを切り替えることもできます。
•【TYPE】となっているとき、br（－、＋）を使ってTYPEのオンとオフを切り替えることもできます。
• 5（“MASTER”を除く8つのスライダー）を使って、該当するステップの値を直接変更することもできます。スライダーを
使う場合、2（1-8/9-16）を押して、ステップ1～8（ボタン消灯）とステップ9～16（ボタン点灯）を切り替えます。ただし
TYPEがTIEとOFFの場合、スライダーは使えません。

• タイを設定することができます。設定方法は、49ページ「タイ（長音符）を設定するには」を参照してください。
• アルペジオのステップ編集のメニューは下表のとおりです。

6. TYPE、NOTE、VELOの値を変更し終えたら、br（EXIT）を押して“ARPEGGIO”メニューへ戻ります。

7. br（q、w）で●を“Parameter”へ移動し、br（ENTER）を押します。

8. bp（ダイヤル）またはbr（－、＋）を使って、パラメーターの値を変更します。
• アルペジオのパラメーター編集のメニューは下表のとおりです。

9. 編集が終わったら、以下の要領で保存してください。
• 7（WRITE）を押すと、アルペジオデータの保存画面になります。ユーザー音色の保存と同じ要領で保存してください
（11ページ）。

• 保存したデータを消去する方法は、75ページをご参照ください。

■アルペジオデータを外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

メニューの階層
内容 設定値

1 2

Step Edit >Ent

TYPE

押した鍵盤の最低音（L1）を基準に、何番目の音程を鳴らすか。
• 押した鍵盤の数よりも設定値のほうが大きい場合、1オクターブ上の音が鳴る。（例えば、L4を指
定して鍵盤を3つ押さえた場合、L1の1オクターブ上の音が鳴る。）

• 1オクターブを超えると、元の音域から折り返す。
L1～L8

押した鍵盤の最高音（U1）を基準に、何番目の音程を鳴らすか。
• 押した鍵盤の数よりも指定した設定値のほうが大きい場合、オクターブ下の音が鳴る。（例え
ば、U4を指定して鍵盤を3つ押さえた場合、U1の1オクターブ下の音が鳴る。）

• 1オクターブを超えると、元の音域から折り返す。
U1～U8

押した鍵盤の最高音を基準に、何音鳴らすか。
• 押した鍵数の方が設定値よりも少ない場合は、押した鍵数までしか鳴らない。 P2～P5

NOTE 押した鍵盤からの発音を半音単位で移調させる。 －24～＋24

VELO 押した鍵盤のベロシティー（音量）を変更する。 －64～＋63

メニューの階層
内容 設定値

1 2

Parameter >Ent

Max Step 最大ステップ（Max Step）。ステップタイプでのみ編集可能。 1～16

Step Size ステップサイズ（Step Size）。各ステップ間の音長を指定す
る。 2、6、 、7、 、8

NoteLngth
音長（Note Length）。ステップサイズに対するパーセントで、
発音する音長を設定する。（100％で元と同じ長さ、50％で元
の半分）

1～100％

Groove
グルーブ（Groove）。裏拍ステップの発音タイミングを設定す
る。（50％のときがイーブンで、値が大きくなるほど前半の音
長が長くなる。）

10～90％

Grv.Type グルーブタイプ（Groove Type）。グルーブを50％以外で設定
した場合の音長タイプを設定する。

Norml：ステップの長さを実際のパーセントで再生。
Short：ステップの長さが変わるとき短い方のステッ
プに合わせる。

Velocity
ベロシティー（Velocity）。入力するアルペジオのベロシティー
値を指定する。“KeyOn”を指定すると、キーを押した強さに応
じて、ベロシティー値が入力される。

KeyOn、1～127

Hold Pedal ホールドペダル（Hold Pedal）。ペダルを使ったホールドのオ
ンオフの切り替えを設定する。 On、Off
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プリセットのステップデータや“Step Edit”（38ページ）で編
集したステップデータをクリアし、最初からステップデータ
を作成することができます。
• バリエーションタイプは、クリアすることができません。

1. アルペジオのタイプ選択画面から、7（EDIT）を押
します。

2. br（q、w）で●を“Clear Step”へ移動させてか
ら、br（ENTER）を押します。

3. もう一度br（ENTER）を押します。
“Clear?”と表示されます。

4. br（YES）を押します。
“Complete!”が表示されたらクリアが完了です。

アルペジオのステップデータを
クリアする
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フレーズを再生・記録する

フレーズシーケンサーは、思い浮かんだフレーズを本機に記
録し、好きな時に再生させることができます。
• 100個のプリセットフレーズがあります。
• 新規のフレーズを記録したり、フレーズを重ねて記録（オー
バーダビング）したものを、ユーザーフレーズとして100個
まで保存できます。

• 鍵盤で弾いたフレーズの他に、ペダル、ホイール、ノブの各
操作も記録します。

• 再生方法は、1回だけの再生（ループオフ）か、繰り返しの再
生（ループオン）のいずれかを選べます。

• ループさせながらオーバーダビングもできます。また、一時
的にオーバーダビングを解除し、ループ再生だけに戻すこ
ともできます。

• 鍵盤を押して、フレーズの音程を変えながら再生を開始す
ること（キープレイ）ができます。

1. bo（KEY PLAY）を押したままにし、下のようなプ
リセットフレーズ選択画面が表示されたら離しま
す。

2. 聴いてみたいフレーズ番号を選びます。
• 操作方法は、アルペジオタイプの選択（37ページ「アル
ペジオ機能を使う」の手順2～5）と同じ要領です。

3. bk（STEP ＋）を押して、ループのオンとオフを切
り替えます。

4. bk（STEP －）を押して、ホールドのオンとオフを
切り替えます。

5. bo（PLAY/STOP）を押して、フレーズを再生しま
す。
• ループをONにしている場合、bo（PLAY/STOP）が一
瞬消灯してループの先頭位置であることをお知らせし
ます。

• 上記の手順1～5でユーザーフレーズを再生すること
もできます。

• フレーズのループとホールドの設定は、フレーズ毎に
保存されるパラメーターです。

7 bo

bq

br

bk

プリセットフレーズを聴いてみる

フレーズ番号

ループの設定 ホールドの設定

フレーズ名

OFF：1回だけ再生させる
ON：繰り返し再生させる

OFF：bo（PLAY/STOP）を押している間だけフレーズを
再生し、離すとフレーズが止まる

ON：bo（PLAY/STOP）を押すとフレーズが始まり、も
う一度bo（PLAY/STOP）を押すとフレーズが止ま
る
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テンポ値を増減させながら調節する方法（だんだん速くした
り遅くしたりする）と、4回ボタンを連打し、その速さをテンポ
として設定する方法（タップ入力）の2種類があります。
• フレーズだけでなく他の機能のテンポ調節においても下記
の手順です。

■方法1：テンポ値を増減させながらテンポを調節する

1.8（TEMPO －、＋）を押します。
• テンポ画面が表示されます。

• しばらく何も操作をしないと、元の表示に戻ります。

2.8（TEMPO －、＋）を押すごとに、テンポ値（1分
間あたりの拍数）が1ずつ切り替わります。
• ボタンを押したままにするかダイヤルを回すと、テン
ポ値が連続して素早く切り替わります。

• テンポ値は30～255の間で設定できます。

3. br（EXIT）を押します。
• テンポ画面が閉じます。

■方法2：ボタンを連打した速さでテンポを決める
（タップ入力）

1. 設定したい速さで、ボタン8（TAP）を4回押しま
す。

• 4回押した時点で、押した速さに応じて、テンポが設定
されます。

2. 必要に応じて、「方法1」の操作でテンポを微調整し
ます。

1. bo（KEY PLAY）を押したままにし、フレーズ選択
画面が表示されたら離します。

2.7（EDIT）を押したままにし、bo（KEY PLAY）が
点滅を始めたら離します。
• ユーザーフレーズの場合、ユーザーデータとして保存
する時にゾーンパート1に選ばれていた音色が推奨音
色となります。

1. bo（KEY PLAY）を押して、bo（KEY PLAY）を点
灯させます。

2. 鍵盤を押すと、フレーズの再生を開始します。
• 再生を開始した鍵盤より高いあるいは低い音を押さえ
ると、その音程に合わせてフレーズの再生も高低しま
す。

• ホールド設定をOFFにしている場合、鍵盤を押してい
る間だけフレーズを再生し、離すとフレーズが止まり
ます。ホールド設定をONにしている場合、鍵盤を押す
とフレーズが始まり、bo（PLAY/STOP）を押すとフ
レーズが止まります。

• キープレイが有効な鍵域は、パフォーマンスのパラ
メーター“PhrKeyRgLo”および“PhrKeyRgHi”で指定
することができます（69ページ）。

テンポ（速さ）を変えるには フレーズの選択画面で、選択中のフレーズに合っ
た推奨音色を、ゾーンパート1の音色として選ぶ
ことができます。

鍵盤を押してフレーズを再生する
（キープレイ）
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鍵盤の演奏の他に、ペダル、ノブ、ホイールの操作も記録され
ます。
• フレーズあたり最大約1,600音符まで記録できます。ノブ、
ホイールの操作は多くのデータ量を使います。

1. bo（REC）を押します。
bo（REC）が点滅します。
• 画面の“Rec Mode”がオーバーダビング（OVDB）に
なっている場合、br（－、＋）を使って新規（NEW）に変
更します。新規フレーズの記録開始待ちの状態になり
ます。

• 必要に応じてエンドクォンタイズとノートクォンタイ
ズを設定します。

■エンドクォンタイズ（End Qntz）の設定
新規のフレーズを記録したとき、ボタン操作で記録を停止し
たときにフレーズの終了点が決定されますが、その終了点の
タイミングがずれてしまう場合があります。
その場合、以下のエンドクォンタイズの設定にしたがって、終
了点のタイミングが自動的に補正され、ループが自然な位置
で行われるように調整されます。

■ノートクォンタイズ（Note Qntz）の設定
鍵盤演奏を記録したとき、演奏が正確なタイミングからずれ
てしまう場合があります。その場合、以下のノートクォンタイ
ズの設定にしたがって、鍵盤演奏タイミングが自動的に補正
され、鍵盤演奏が正確なタイミングで発音されるように調整
されます。
（ただし、鍵盤を押したタイミング以外の、「鍵盤を離す」ある
いは「ホイール、ペダル、ノブの操作」のタイミングは補正され
ません。）

• br（MENU）を押すと、以下の設定をすることができ
ます。br（q、w）を使って設定項目を選び、br（－、
＋）を押して各項目の値を変更します。

2. bo（REC）を押す、ペダル操作、ノブ操作、ホイール
操作または鍵盤で演奏を始めると、記録が開始され
ます。
bo（REC）が点灯に変わります。

3. 記録を終了したいタイミングで、bo（PLAY/
STOP）を押します。
bo（REC）が消灯しフレーズ番号に“!TEMP”（テンポラ
リー）と表示されます。
• 手順3でbo（PLAY/STOP）のかわりにbo（REC）を押
すと、記録を終了して一時的にオーバーダビングの待
機状態に変わり、記録したフレーズをループ再生しは
じめます。
オーバーダビングについての詳細は、44ページ「フ
レーズに演奏を重ねて記録する（オーバーダビング）」
を参照してください。

4. 記録が終わったら、以下の要領で保存してくださ
い。
• 7（WRITE）を押すと、フレーズの保存画面になりま
す（45ページ）。

• 保存したデータを消去する方法は、75ページをご参照
ください。

■フレーズを外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

フレーズを新規に記録する

Off：フレーズ終了点のタイミング調整は行われない
1M：フレーズ終了点は1小節単位の位置に調整される
2 ：フレーズ終了点は4分音符単位の位置に調整される
6 ：フレーズ終了点は8分音符単位の位置に調整される

Off ：タイミングは補正されない（演奏された
タイミングで記録される）

6、 、7、 ：指定した音符単位で実際の演奏タイミ
ングに一番近い位置に補正される

メニュー 内容 設定範囲

Guide
ガイド音（Guide）。フレーズの記録中
や記録待機中にカウント音を鳴らすか
どうかを設定する。

Off、On

Precount
プレカウント（Precount）。ボタン操作
でフレーズの記録を開始する前に挿入
するカウントの小節数を設定する。

Off、
1：1小節、
2：2小節

Beat
拍子（Beat）。ガイド、プレカウント、エ
ンドクォンタイズ（1M）で使う拍子を
設定する。

2/4～8/4、
2/8～16/8
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キープレイ中、フレーズデータは、最初に記録された鍵盤（オ
リジナルキー）を押さえると、記録したときの音階で再生され
ます。このオリジナルキーを他の鍵盤に変更することができ
ます。また、オリジナルキーを押さえたとき、またはPLAY/
STOPボタンを押して再生させたときどのくらいキーシフト
させるかを、半音単位で設定することもできます。

1. bo（KEY PLAY）を押したままにし、フレーズ選択
画面が表示されたら離します。

2. 設定したいフレーズ番号を選びます。
• 操作方法は、アルペジオタイプの選択（37ページ「アル
ペジオ機能を使う」の手順2～5）と同じ要領です。

3.7（EDIT）を押します。

4. br（q、w）を使って設定項目を選び、bqまたは
br（－、＋）を押して各項目の値を変更します。

※画面表示の“C-”は、C-1（C0の1オクターブ下）を表しま
す。

5. 設定が終わったら、以下の要領で保存してくださ
い。
• 7（WRITE）を押すと、フレーズの保存画面になりま
す（45ページ）。

• 保存したデータを消去する方法は、75ページをご参照
ください。

■フレーズを外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

1. オーバーダビングするフレーズを選びます。
• フレーズの選び方は、アルペジオの選択（37ページ）の
手順2～5と同じ要領です。

2. bo（REC）を押します。
bo（REC）が点滅します。
•“Rec Mode”が新規（NEW）になっている場合、br
（－、＋）を使って%の中をオーバーダビング
（OVDB）に変更します。オーバーダビングの記録待ち
の状態になります。画面にフレーズ番号と名前が表示
されますが、フレーズの選択はできません。

• 必要に応じてノートクォンタイズ（Note Qntz）を設定
します（43ページ）。

3. bo（REC）を押すか、ペダル操作、ノブ操作、ホイー
ル操作、または鍵盤で演奏を始めると、オーバーダ
ビングによる記録が開始されます。
bo（REC）およびbo（PLAY/STOP）が点灯に変わりま
す。
• 元のフレーズがループ再生されます。ループ再生中に
行われた演奏や操作は元のフレーズに重ねて記録され
ます。

4. 記録を終了したいタイミングで、bo（PLAY/
STOP）を押します。
bo（REC）およびbo（PLAY/STOP）が消灯し、フレーズ
番号に“！”マークが表示されます。

■ループ再生しながら、オーバーダビングを一時的に
中断する

上記手順4のとき、bo（PLAY/STOP）のかわりにbo（REC）
を押します。
• bo（REC）が点滅に変わります。
• その時点まで記録したフレーズをループ再生し続けます
が、オーバーダビングを中断している間の演奏は記録され
ません。

• もう一度bo（REC）を押すとオーバーダビングを再開しま
す。

フレーズデータを設定する

メニュー 内容 設定範囲

OriginalKey

オリジナルキー（Original Key）。
キープレイにおいて、記録時の音
程で再生させる鍵盤を指定する。
（初期値は最初に記録された鍵
盤。）
• 鍵盤で設定値を入力することが
できます。

C- - G9※

Key Shift

キーシフト（Key Shift）。オリジナ
ルキーで指定された鍵盤または
PLAY/STOPで再生するフレーズ
のキーシフト値を半音単位で指定
する。（キーシフトしないときは
000を指定。）

－127 - 000 - 
＋127

フレーズに演奏を重ねて記録する
（オーバーダビング）
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■最後に記録した内容を消去する（アンドゥ）
フレーズの停止中、再生中、オーバーダビング中、あるいは
オーバーダビングの中断中に、アンドゥ画面が表示されるま
でbo（REC）を押し続けます。

• 最後の記録のアンドゥがすでに完了していて、さらにアン
ドゥの操作をしようとしたとき、“Can’t UNDO”と表示さ
れこれ以上アンドゥする記録がないことを示します。

• ユーザーフレーズとして保存したフレーズはアンドゥでき
ません。

フレーズを記録したあとにフレーズ番号の横に付くマーク
は、以下の意味を表しています。

• 先頭に!がついたフレーズは「プリセットフレーズを聴いて
みる」の手順2（41ページ）でフレーズ番号を選び直すと破
棄されます。保存しておきたいフレーズは次の「フレーズを
保存する」の手順にしたがって、ユーザーフレーズとして保
存してください。

7（WRITE）を押すと、フレーズの保存画面になります。ユー
ザー音色の保存と同じ要領で保存してください（11ページ）。

• 保存先のデータ容量が不足している場合、フレーズの保存
画面“Press Enter”の代わりに“not enough space”と表
示されて、本機への保存ができなくなります。より大きい
データサイズを持つ他の保存先を指定し直すか、他のユー
ザーデータを消去して空き容量を作ってください。

• 保存したフレーズデータを消去する方法は、75ページを参
照してください。

• 100個のユーザーフレーズの合計で、最大128キロバイト
まで保存できます。

■フレーズを外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

フレーズ番号にあるマークについて

! ：保存前のフレーズ
* ：保存済のユーザーフレーズ
!TEMP：新規の記録後、まだ保存されていないフレーズ

フレーズを保存する
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ステップシーケンサーを使う

本機のステップシーケンサーは、最大16ステップで構成されています。スライダーを使って、ノートやベロシティーをリアルタイ
ムにコントロールできます。リズムマシンとしてだけではなく、鍵盤での演奏と併せたパフォーマンスが可能です。
プリセットシーケンスから各ステップを編集して、お好きなリズムパターンを作ってユーザーシーケンスとして保存できます。
• プリセットシーケンスは100シーケンスあります。ユーザーシーケンスは最大100シーケンスまで保存できます。
• ステップの編集方法は、編集画面に入らずにできる簡易編集と、編集画面で行う詳細編集の2通りがあります。
• ホイール（ベンダー、モジュレーション）、ノブの各操作も記録できます。
• ステップシーケンサー内の複数のパターンを最大99個つなげてループ再生させること（チェーン）ができます。チェーンのシー
ケンスは最大100個保存できます。

• ステップシーケンサーから、フレーズシーケンサーの再生を開始することができます。

1つのシーケンスの構成は、以下のようになっています。
• パート（PART）は、9つのノート（音程）パート（ドラム1～5、ベース、ソロ1～2、コード）と4つのコントロールパートでできてい
ます。

• コントロールパートには、ピッチベンド／コントロールチェンジやフレーズシーケンサーの再生トリガー（再生を開始・終了さ
せるタイミング）が設定できます。

• 各パートの細かな設定等の詳細については、52ページ「シーケンスを編集する 2. 詳細編集」を参照してください。
• パターン（PATTERN）には、8つの異なるパターンがあります。8つのパターンに別々に拍子（Beat Info）が設定できます。
• トラック（Track）は、16のステップデータとそのトラックのパラメーターで構成されています。
• 本機のミキサー機能を使って、ステップシーケンサーの音色を変えることができます。詳細については71ページ「ミキサー機能
を使う」を参照してください。

ステップシーケンサーの構成について

9 bl

7 bn bp

bq

br

5

bk

4

2

1
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8ch

9ch

10ch

11ch

12ch

13ch

14ch

15ch

16ch

A B
A B
A B
A B
A B
A B
A B
A B
A B

3 4 5 6 7 8 9 10 11 12 13 14 15 161 2

トラック

トラック

トラック

トラック

トラック

トラック

トラック

トラック

トラック

トラック

トラック

トラック

トラック

ドラム1

ドラム2

ドラム3

ドラム4

ドラム5

ベース

ソロ1

ソロ2

コード

コントロール1

コントロール2

コントロール3

コントロール4

拍子
スライダー

（49ページ）
Mスライダー
（50ページ）

ミキサー
（71ページ）

パート
（46ページ）

パターン1～8
（46ページ）

ノートパート

コントロール
パート

ステップデータ

トラックパラメーター
• 最大ステップ
• ステップサイズ等

コントロールタイプ
• コントロールトラックのみ

オフ、オン、タイ

ノート1 ノート2※ ノート3※ ベロシティー

値 キーシフト
• フレーズのみ

※コードトラックのみ

シーケンス

トラック

ノートパート

コントロールパート
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パフォーマンス、トーン、ステップシーケンサーのどのモード
からも、ステップシーケンサーを再生することができます。
パターンを切り替えたり、他のシーケンスバンクと番号を選
んだり、音程をシフト（キーシフト）させることで変化を加え
ることができます。

• 手順1を操作する前にbk（CHAIN）が点灯している場合
（チェーンの状態）、bk（CHAIN）を押してボタンを消灯さ
せます。

1. bk（START/STOP）を押します。
bk（START/STOP）が点滅し、シーケンスの再生が始ま
ります。

• 再生中にbk（START/STOP）を押すと、シーケンスが
停止しボタンが消灯します。

• アルペジオ機能にステップシーケンサーの再生トリ
ガーが指定されている場合、bk（START/STOP）を押
さなくてもステップシーケンサーを自動再生すること
ができます。詳しくは、37ページ「アルペジオ機能を使
う」を参照してください。

• 再生のテンポを変えたいときは、42ページ「テンポ（速
さ）を変えるには」を参照してください。

2. パターンを切り替えたいときは、ステップシーケン
サーのモードでbl（PATTERN 1～8）を押します。
選択したパターンのボタンが消灯します。
• 小節切り替えにしている場合、切り替わるまでの間、選
択したパターンのボタンが点滅します。

• 現在選択しているパターンのボタンを押すと、ボタン
が点滅して再生の停止予約となり、bk（START/
STOP）を押すと小節の終わりで再生が止まります。停
止予約をキャンセルするには、ボタンの点滅中にもう
一度ボタンを押します。

3. シーケンスを切り替えたいときは、ステップシーケ
ンサーのモードでシーケンスバンクや番号を変更
します。
• 操作方法は、アルペジオタイプの選択（37ページ「アル
ペジオ機能を使う」の手順2～5）と同じ要領です。

4. キーシフトしたいときは、1（STEP 
SEQUENCER）を押したあと、2（KEY SHIFT）
を押します。
• C2をオリジナルキーとして、D2～B2の鍵盤を押さえ
ることでキーシフトができます。

• パートごとにキーシフトするかしないかを選択できま
す。詳しくは、52ページ「シーケンスを編集する 2. 詳
細編集」を参照してください。

• キーシフトのオンオフの設定はパフォーマンスのパラ
メーターとして保存されます。

パフォーマンス、トーン、ステップシーケンサーのどのモード
からも、シーケンスを簡易編集することができます。

• 手順1を操作する前にbk（CHAIN）が点灯している場合
（チェーンの状態）、bk（CHAIN）を押してボタンを消灯さ
せます。

1. パフォーマンス、トーンのモードにいる場合、1
（STEP SEQUENCER）を押します。
ステップシーケンサーのモードに入り、1（STEP 
SEQUENCER）が点灯します。

2. 48ページ「ステップシーケンサーを再生する」の手
順1～3のとおり操作して、編集したいシーケンス
とパターンを選びます。

3.9（PART －、＋）を使って、編集したいパートを選
びます。
画面の表示されたパート番号の下に“e”が点灯します。

• パート種類がコントロールの場合、画面に“e”は表示
されません。

4. 以下のように、各パートを編集します。

ステップシーケンサーを再生する

シーケンス名

拍数

シーケンスバンク、番号

小節
テンポ

シーケンスを編集する 1. 簡易編集

選択したパート番号選択したパート名
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■オン（鳴る）
オンに切り替えたいステップ番号の4（1～16）を押します。
4（1～16）が点灯し、画面に“NOTE”が表示されます。

■オフ（鳴らさない）
オフに切り替えたいステップ番号の4（1～16）を押します。
4（1～16）が消灯し、画面に“OFF”が表示されます。

• コントロールパートは、オンとオフの設定はできません。

1.1（STEP SEQUENCER）を押したまま、タイの先
頭にするステップ番号の4（1～16）を押します。

2. 引き続き1（STEP SEQUENCER）を押したまま、
タイの最後尾にするステップ番号の4（1～16）を
押します。

• タイの先頭に指定したステップがオンに切り替わりま
す。また、先頭の次のステップからタイの最後尾に指定
したステップの間の各ステップがタイに切り替わりま
す。

• タイに指定されたステップ番号の4（1～16）が点滅
します。1（STEP SEQUENCER）を離すと消灯しま
す。（消灯してもタイの設定は有効になっています。）

• タイになっているステップを確認したい場合、1
（STEP SEQUENCER）を押したまま4（1～16）のい
ずれかを押すと、タイのステップ番号の4（1～16）が
点滅します。

• コントロールパートには、タイを設定することはでき
ません。

• 下記を操作する前に、1（STEP SEQUENCER）が点灯し
ていなければ、1（STEP SEQUENCER）を押します。

■スライダーを操作する
5（1/9～8/16）を使って、ステップ1～16のノートあるいは
ベロシティー（ノートパートの場合）を変更します。
• コントロールパートの場合、コントロールの効果をスライ
ダーで変更できます。詳しくは、52ページ「シーケンスを編
集する 2. 詳細編集」を参照してください。

• 2（1-8/9-16）を押して、ステップ1～8と9～16の操作を
切り替えます。

• 2（1-8/9-16）が消灯しているとき、ステップ1～8の操作
ができます。2（1-8/9-16）が点灯しているとき、ステップ
9～16の操作ができます。

■2種類あるスライダーの機能を切り替える
2（SLIDER A/B）を押すと、スライダーの機能を切り替える
ことができます。
（プリセットの場合）
2（SLIDER A/B）が消灯のとき：“L”ノート
2（SLIDER A/B）が点灯のとき：“M”ベロシティー

• 5（1/9～8/16）を動かすと、ステップがオフになっている
場合でもオンに切り替わります。

• コントロールパートは、スライダー機能の切り替えができ
ません。

ステップのオンとオフを切り替えるには

タイ（長音符）を設定するには

先頭のステップ番号

最後尾のステップ番号

スライダーを使って、ノートやベロシティーを
変更するには

ステップ1～8、あるいはステップ9～16（切り替え後）

LかMが点灯
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5（MASTER）を使って、パート内にある設定（ノート、ベロ
シティー、スタッカート／テヌート、再生スピード、グルーブ）
を一括で変更することができます。
• マスタースライダーで変更できる設定は、パート毎に異な
ります。

• パートによっては無効になっている設定があります。
• マスタースライダーの機能に他の機能を割り当てることも
できます。詳しくは、50ページ「マスタースライダーの機能
を変更するには」、および55ページ「スライダーの設定を変
更する」を参照してください。

スライダー機能にはノートやベロシティーが割り当てられて
います。この割り当てを変更したり、ノートとベロシティーを
一緒に割り当てることができます。
また、8段階あるスライダーの位置に対して設定されている
ノートやベロシティーの各値を変更することができます。

1.1（STEP SEQUENCER）を押します。

2.“SLIDER”画面に切り替わるまで2（SLIDER 
A/B）を押し続けます。

3.9（PART －、＋）で変更したいパートを選びます。

4.2（SLIDER A/B）を押して、AとBの機能を変更
したいほうを選びます。

5. 画面のカーソルを“TYPE：”に移動し、br（NO、
YES）を使って割り当てる機能を変更します。

6. bp（ダイヤル）、br（q、w）、またはbl
（PATTERN 1～8）を使って、変更したいスライ
ダーの位置（“1：”から“8：”）に画面のカーソルを移
動します。
•“1：”～“8：”は、全8段階あるスライダーの位置を示し
ます。一番下が1で、一番上が8です。

7. br（NO、YES）を使って、ノートやベロシティーの
値を変更します。
• ノートやベロシティーの値を鍵盤を押さえて入力する
こともできます。

• コードパートの場合、3つまで値を指定することができ
ます。

• スライダー機能の編集は、詳細編集からでも行えます。
詳しくは、52ページ「シーケンスを編集する 2. 詳細編
集」を参照してください。

1.1（STEP SEQUENCER）を押します。

2.“SLIDER”画面に切り替わるまで2（SLIDER 
A/B）を押し続けます。

3. br（MENU）を押したあと、br（I）を押して0を
“M.Slider”へ移動します。

4. br（ENTER）を押します。
マスタースライダーの設定画面が表示されます。

5. br（－、＋）あるいは9（PART －、＋）を使って、
“Part”の横にある%内に変更したいパートを表
示します。

マスタースライダーを使って、ノートやベロシ
ティーを一括で変更するには

スライダー機能の割り当てを変更する

NOTE ：ノート
VELO ：ベロシティー
NOTE& VELO：ノートとベロシティーの両方

マスタースライダーの機能を変更するには
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6. br（q、w）を使って“Assign”に移動し、bp（ダイ
ヤル）またはbr（－、＋）でアサイン値を変更しま
す。

• ステップサイズ、ステップゲート長、グルーブの各アサ
インについての詳しい説明は、53ページ「ステップ
シーケンサーのパラメーター」を参照してください。

• スライダーの機能変更については、下記の変更もできます。
変更のしかたは、55ページ「スライダーの設定を変更する」
を参照してください。
– 他のスライダー設定からのコピー
– スケール、ドラム、べロシティーのスライダープリセット
– ノートシフト

鍵盤、ピッチベンド、ノブを使った演奏によって、ステップ
データのノートやベロシティーなどを入力することもできま
す。
• ピッチベンドやノブの操作を入力する場合、先にコント
ロールトラックでピッチベンドやノブを選んでおいてか
ら、演奏で入力します。

1.7（EDIT）を押します。

2. br（w）を押して0を“Step Edit”へ移動し、br
（ENTER）を押します。

3. 以下の要領でデータを入力します。

■シーケンスの再生中は
鍵盤を押したり演奏したタイミングで、再生中のシーケンス
に入力されます。

■シーケンスの停止中は
表示中のステップに入力されます。

ソロ1のチャンネルは、通常14chに設定されています。
しかし、ソロの音色としてソロシンセ等の特殊な音色を使用
する場合、以下の方法で1chに設定を変更してください。

1.1（STEP SEQUENCER）を押します。

2. br（MENU）を押したあと、br（I）を押します。

3. 画面の0が“Setting”にあることを確認して、br
（ENTER）を押します。

4. br（q、w）を使って画面の0を“Solo1 Ch”に移
動します。

5. br（－、＋）を使って、ソロ1のチャンネルを設定し
ます。

• ソロ1のチャンネル設定は、パフォーマンスのパラメー
ターとして保存されます。

1. 51ページ「ソロ1のチャンネルを変更するには」の
手順1～3を操作します。

2. br（q、w）を使って画面の0を“Pattern 
Change Timing”に移動します。

3. br（－、＋）を使って、パターンが切り替わるタイミ
ングを設定します。

• パターンが切り替わるタイミングの設定は、パフォー
マンスのパラメーターとして保存されます。

アサイン名 内容

Nop 機能なし（No operation）。マスタースライ
ダーの機能を無効にする。

S. Data ステップデータ（Step Data）。1から16までの
オンになっているデータをまとめて変更する。

S. Size ステップサイズ（Step Size）。
NoteLn ノート長（Note Length）。
Groove グルーブ（Groove）。

Octave

オクターブ（Octave）。スライダー1～8をノー
トの指定にしている場合、スライダーを動かす
とノートデータのオクターブが変わる（範囲：
－1～0～1）。

鍵盤などの演奏によってステップデータを入力
するには

ソロ1のチャンネルを変更するには

1 ：「1ch」に設定
14：「14ch」に設定

パターンが切り替わるタイミングを
変更するには

Wait：次の小節が始まるタイミングまで待つ
Real：小節の途中でもすぐ切り替わる
Beat：拍の頭のタイミングで切り替わる
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37ページ「アルペジオ機能を使う」を参照してください。

本機のミキサー機能によって音色を変えることができます。
• ミキサーで設定された8ch～16chのデータは、ステップシーケンサーのデータとして保存されます。
• ミキサーのパラメーターは、全パターン共通のパラメーターとして設定されます。
• ミキサーについては、71ページ「ミキサー機能を使う」を参照してください。

1.1（STEP SEQUENCER）を押してから、7（EDIT）を押します。
• すでに7（EDIT）を押して編集中になっている場合、この操作は必要ありません。

2. bn（MIXER）を押します。

3.4（9～16）を押し続けて、ソロ状態で鳴らしたいパートをノートパートの中から指定します。
• ステップシーケンサーモードから抜けるか、あるいは“Track On/Off”画面（53ページ）に入ると、ソロ状態が解除されま
す。

• ミキサーの操作についての詳細は、71ページ「ミキサー機能を使う」を参照してください。

シーケンスのパラメーターを編集して、データを細かく作り込むことができます。

1.7（STEP SEQ）を押します。

2.7（EDIT）を押します。

3. br（U、q、w、I）を使って、編集したいメニューに0を移動します。

アルペジオのときにステップシーケンサーをシンクロ再生させるには

ステップシーケンサーの音色を変えるには

特定のパートのみをオン（ソロ状態）で鳴らすには

シーケンスを編集する 2. 詳細編集

詳細編集するには

ミキサー表示
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■ステップシーケンサーのパラメーター
階層1 階層2 階層3 内容 設定範囲や画面

Trk On/Off >Ent
トラックの編集（Track On/Off）。
• ステップシーケンサーモードのとき、7（EDIT）を押し続
ける操作でも、“Trk On/Off >Ent”を操作したときと同じ
画面に切り替えることができます。

Pattern パターン番号（Pattern）。 1～8

Part パート名（Part）。 Drm1～5、Bass、Sol1～2、Chrd、
Ctl1～4

Track
トラックオンオフ（Track）。4（1～16）で切り替え。
• 4（1～4）は、それぞれコントロールパート1～4に対応し
ます。同様に、4（8～16）はノートパートに対応します
（47ページ参照）。

Off、On

Step Edit >Ent ステップの編集（Step Edit）。ステップごとの編集グループ。

Drm1～5、
Bass、
Sol1～2

NOTE、
VELO

ステップのオフ（OFF）、オン（NOTE）、タイ（TIE）の切り替え。
オンのとき、ノート（NOTE）とベロシティー（VELOCITY）を
設定する。Step1にはタイを設定できない。

Off、（オンのとき）NOTE：C-～G9※、
（オンのとき）VELO：1～127、Tie

Chrd NOTE、
VELO

ステップのオフ（OFF）、オン（NOTE）、タイ（TIE）の切り替
え。オンのとき、3つのノート（NOTE）とベロシティー
（VELOCITY）を設定する。Step1にはタイを設定できない。

Off、（オンのとき）NOTE：Offあるい
はC-～G9※、
（オンのとき）VELO：1～127、Tie

Ctl1～4

コントロールパート（Ctl）の効果。パート毎のデータ。

NOP：効果無し、他の設定範囲は以下
に記載。
＜下図は“PHRASE”の画面例＞

BEND ピッチベンダー（Pitch Bender）。 －128～＋127

CC1～97 MIDIコントロールチェンジ（Control Change）。 0～127、Panのみ－64～＋63

K1～4 パフォーマンスなどで設定したノブ（Knob）の動き。 0～127

TEMPO テンポ（Tempo）。 30～255

PHRASE
フレーズシーケンサー（Phrase Sequencer）の再生を開始／
停止させるトリガーを設定する。コントロール4（Ctl4）での
み表示。

Nop：効果無し、Stop：再生を停止、
Start：再生を開始、
－24～＋24：オリジナルキーからの
シフト値（Startを選んだ場合）

Track Param >Ent トラックのパラメーター（Track Parameter）。

Max Step
最大ステップ（Max Step）。パートを再生するステップ数を
設定。再生中に設定の最大ステップ数を超えると、先頭のス
テップに戻って再生。

1～16

Step Size ステップサイズ（Step Size）。各ステップ間の音長を指定。 2、6、 、7、 、8

NoteLngth
ノート長（Note Length）。発音する音長をステップサイズ
に対するパーセントで設定。100%で元と同じ長さ、50%で
元の半分の音長になる。

1～100％

音程 音量

コードの各音程 音量

メニュー 値
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Groove
グルーブ（Groove）。裏拍ステップの発音タイミングを設定。
ステップ再生でステップの音長を交互に変更。50%の時が
イーブンで、値が大きくなる程前半の音長が長くなる。

10～90％

Grv.Type グルーブの種類（Groove Type）。グルーブを50%以外で設
定した場合の発音する音長タイプを指定。

Norml：ノーマル（Normal）。長さを
実際のパーセントで再生。
Short：ショート（Short）。グルーブで
ステップの長さが変るとき短い方に
長さを合わせる。

Ctrl.Ch
（コントロールパートのみ）

コントロールチャンネル（Control Channel）。コントロール
トラックの効果のかかるチャンネルを指定。 1、8～16ch

Smooth
（コントロールパートのみ）

スムーズ（Smooth）。コントロールトラックの再生を制御。
オンの場合はコントロールデータを補間して再生。 On、Off

Phrase No.
（コントロールパート4のみ）

フレーズシーケンサー番号（Phrase No.）。コントロールし
たいフレーズシーケンサー番号を指定。 P00～99、U00～99

Key Shift >Ent
キーシフト（Key Shift）の編集グループ。コントロール
（Ctrl）1～3は設定不可。コントロール（Ctrl）4は、フレーズ
シーケンサーのキーシフトとしての設定でRealtimeは設定
不可。

Enable キーシフトのオンオフ（Enable）。 Off、On

BreakPoint CからBの間で、そのキーを超えるとキーシフトをオクター
ブ下げて発音させるポイント（Break Point）。 C～B

Realtime リアルタイム（Real Time）。ブレークポイントのタイミング
を設定。

On：すぐに変更
Off：次のノートで変更

Beat Info 拍子の設定（Beat Information）。 2/4～8/4、2/8～16/8

Copy >Ent データのコピー。

Track

他トラック（Track）のデータからコピー。ステップデータと
パートパラメーターをコピー。
•“TMP”（編集中のデータ）もコピー可。
• コピーできるパートは以下のとおり。

Pattern 他パターン（Pattern）のデータからコピー。
•“TMP”（編集中のデータ）もコピー可。

Note Shift >Ent ノートを上下する機能（シフト）の編集グループ。

Shift どのくらいシフトさせるかを半音単位で指定。 －24～＋24

Ptn シフトさせるパターン（Pattern）を指定。 01～08

Part シフトさせるパート（Part）を指定。 Dr1～5、Bas、Sl1～2、Chd

Clear >Ent トラックデータのクリア（Clear）。

Track Pattern、
Part トラック内のパターン（Pattern）やパート（Part）を選択。

Pattern：01～16
Part：Drm1～5、Bass、Sol1～2、
Chrd、Ctl1～4

Pattern パターン（Pattern）すべて。

Set トラック（Set）内データすべて。

階層1 階層2 階層3 内容 設定範囲や画面

<From> <To>
Dr1～S2 3 Dr1～S2
Chord 3 Chord
Ctrl1～3 3 Ctrl1～3
Ctrl4 3 Ctrl4

コピー先のパターン番号
コピー先のパート名

コピー元のパターン番号
コピー元のパート名

コピー元のシーケンス
（バンク、番号）

コピー先のパターン番号

コピー元のパターン番号
コピー元のシーケンス

（バンク、番号）
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※画面表示の“C-”は、C-1（C0の1オクターブ下）を表します。

Slider Edit >Ent

ステップシーケンサーモードでのスライダーの設定。
• 1（STEP SEQUENCER）が点灯しているとき、2
（SLIDER A/B）を押し続ける操作でも、“Slider Edit 
>Ent”を操作したときと同じ画面に切り替えることがで
きます。

TYPE
•“TYPE”画面のとき、br
（MENU）を押すと階層3
に入ります。

スライダー機能の割り当ての変更。
操作方法や設定値についての詳細は、
50ページ「スライダー機能の割り当
てを変更する」の手順3以降を参照し
てください。

Copy >Ent 他のスライダー設定からのコピー。 操作方法や設定値についての詳細は、
55ページ「スライダーの設定を変更
する」の手順4以降を参照してくださ
い。

Preset >Ent スケール、ドラム、ベロシティーのスライダープリセット。

Note Shift 
>Ent ノートシフト。

M.Slider 
>Ent マスタースライダー機能の変更。

操作方法や設定値についての詳細は、
50ページ「マスタースライダーの機
能を変更するには」の手順5以降を参
照してください。

階層1 階層2 階層3 内容 設定範囲や画面

4. br（U、q、w、I）を使って、%やカーソルを編
集したい項目へ移動し、br（－、＋）を使ってパラ
メーターの値を変更します。
• パターン番号は、bl（PATTERN）で切り替えます。
• パート名は、9（PART －、＋）で切り替えます。
• ステップ番号は、bk（STEP －、＋）で切り替えます。
• 前の階層に戻るには、br（EXIT）を使います。
• ミキサー表示は、現在設定している値を表示します。
•“Step Edit”の表示画面では、鍵盤は現在選ばれている
パートの音色が鳴ります。ミキサー表示は各ステップ
のノート、ベロシティー、バリュー値を表示します。
ノートの場合、実際のオクターブの上下にかかわらず、
ミキサー表示ではC～Bの音は決まった位置で表示さ
れます。

スライダーの設定は簡易編集の項目で説明した変更の他に、
以下の変更ができます。
• 他のスライダー設定からのコピー
• スケール、ドラム、ベロシティーのスライダープリセット
• ノートシフト

1.1（STEP SEQUENCER）を押します。

2.2（SLIDER A/B）を下のような画面が出るまで押
し続けます。

3. br（MENU）を押します。

スライダーの設定を変更する

他のシーケンスのスライダー設定からコピー
するには
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4. br（U、q、w、I）を使って画面の0を編集したい
項目に移動し、br（ENTER）を押します。各項目は
以下のように変更します。

■Copy：他のスライダー設定からコピーする
br（U、q、w、I）を使って画面の[　]を項目に移動し、br
（－、＋）を使って値を変更します。

• コードパートの場合、コードパート間のコピーだけ可能で
す。

•“!TEMP”（編集中のデータ）もコピー元に設定することが
できます。

■Preset：スケール、ドラム、ベロシティーのスライ
ダープリセット
br（U、q、w、I）を使って画面の[ ]を編集したい項目に
移動し、br（－、＋）を使って値を変更します。スライダープリ
セット番号を入力すると自動的にスライダープリセット名が
表示されます。

• スライダープリセット番号とそれに対応するスライダープ
リセット名は以下のとおりです。
1 Major（メジャー）、2 Minor（マイナー）、
3 Dorian（ドリアン）、4 Lydian（リディアン）、
5 Mixolydn（ミクソリディアン）、
6 Phrygian（フリジアン）、7 Locrian（ロクリアン）、
8 M.Minor（メロディックマイナー）、
9 H.Minor（ハーモニックマイナー）、
10 H.M. 5th（ハーモニックマイナー5th）、
11 Altered（オルタード）、12 WholeTon（ホールトーン）、
13 Diminish（ディミニッシュト）、
14 Pentaton（ペンタトニック）、
15 M.Penta（マイナーペンタトニック）、
16 Blues（ブルース）、17 Kick（バスドラム）、
18 Snare（スネアドラム）、19 Hi-hat（ハイハット）、
20 Toms（タム）、21 Cymbal（シンバル）、
22 Velocity（ベロシティー）

• 以下はコードパートのみのスライダープリセット番号とそ
れに対応するスライダープリセット名です。
1 Diatonic（ダイアトニック）、2 Minor（マイナー）、
3 H.Minor（ハーモニックマイナー）、
4 Velocity（ベロシティー）

■Note Shift：ノートをシフトする
br（U、q、w、I）を使って画面の[ ]を編集したい項目に
移動し、br（－、＋）を使ってシフトする値を変更します。

SLIDER A/Bボタンの設定

コピー先のパターン名

SLIDER A/Bボタンの設定

パターンコピー元のシーケンスNo.

スライダープリセット名

パターン名 SLIDER A/Bボタンの設定

スライダープリセット番号

シフトする値（－24～＋24）

パターン名 SLIDER A/Bボタンの設定
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編集が終わったら、7（WRITE）を押すと、シーケンスの保存
画面になります。ユーザー音色の保存と同じ要領で保存して
ください（11ページ）。
• 保存したデータを消去する方法は、75ページをご参照くだ
さい。

■シーケンスを外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

1. ステップシーケンサーのモードで、bk（CHAIN）を
押します。

2.7（EDIT）を押します。

3. br（U、q、w、I）を使ってカーソルを移動し値を
入力します。

• 値の変更方法は、項目によってボタンが異なります。

• チェーンの種類は、ループにしたいとき“LOOP”を、そ
のチェーンで終わらせたいとき“END”を指定します。

• 部分的にチェーンを削除したいときは、bk（DELETE）
を押して削除できます。

• 部分的にチェーンを挿入したいときは、bk（INSERT）
を押して挿入できます。

• 現在選択中のパターンを確認したいときは、bk
（CHAIN）を押して点灯させてから、bk（START/
STOP）を押してパターンを再生させます。再生中に編
集をすることができます。

4. 編集が終わったら、7（WRITE）を押すと、チェー
ンの保存画面になります。ユーザー音色の保存と同
じ要領で保存してください（11ページ）。
• 保存したデータを消去する方法は、75ページをご参照
ください。

■チェーンを外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

編集したシーケンスを保存する

チェーン

チェーンを作るには

シーケンス番号：アルペジオの選択（37ページ）の手順
2～5と同じ要領です。

パターン番号 ：br（－、＋）、あるいはbl（PATTERN）
小節数 ：br（－、＋）
キーシフト ：br（－、＋）、あるいは鍵盤

（一番左のC～Bの1オクターブ）
チェーンの種類：br（－、＋）

チェーン番号

チェーンの種類

シーケンス番号

パターン番号

小節数

キーシフト
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1.“CHAIN”が表示されるまで、bk（CHAIN）を押し
続けます。

2. bp（ダイヤル）あるいはbq、br（－、＋）で再生した
いチェーンを表示します。

3. bk（START/STOP）を押します。
• 再生を停止するには、bk（START/STOP）をもう一度
押します。

• チェーンを組み直すことができます。操作方法は、57
ページ「チェーンを作るには」を参照してください。

1.“CHAIN”が表示されるまで、bk（CHAIN）を押し
続けます。

2. br（MENU）を押します。

3. bp（ダイヤル）あるいはbr（U、q、w、I）を使っ
て0を“Initialize”に移動し、br（ENTER）を押し
ます。

4. もう一度br（ENTER）を押します。
“Sure?”と表示されます。

5. br（YES）を押します。
“Complete!”が表示されたら初期化完了です。

• 操作を始める前に、本機にメモリーカードを差し込みます。

1.“CHAIN”が表示されるまで、bk（CHAIN）を押し
続けます。

2. bp（ダイヤル）あるいはbq、br（－、＋）で保存した
いチェーンを表示します。

3. br（MENU）を押します。

4. bp（ダイヤル）あるいはbr（U、q、w、I）を使っ
て0を“SMF Save”に移動し、br（ENTER）を押し
ます。

• この後の操作は、79ページ「本機のデータをタイプ別
にカードに保存するには」の手順4以降と同じです。

• 通常のメモリーカードへの保存については、77ページ「メ
モリーカードを使用する」を参照してください。

チェーンを再生するには

チェーンを初期化するには

チェーンをSMF形式でメモリーカードに保存す
るには
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サンプルルーパーで録音・再生する

サンプルルーパーを使って、本機での演奏や、マイク、ライン
などの外部入力の音を最大19秒間、ループさせながら重ねて
録音すること（オーバーダビング）ができます。
録音したデータ（本書では、以降「サンプル」と呼びます）は、
10個まで保存できます。
• 外部入力は、cl（INST IN）およびcl（MIC IN）に入力され
た音が録音できます。cl（AUDIO IN）に入力された音は
録音できません。

• 外部入力よりも高音質なサンプルを本機に取り込みたい場
合には、専用のアプリケーションソフト（82ページ　データ
エディター）を使用してパソコンから波形データを転送し
てください。

• サンプルは、開始方法と録音タイプを組み合わせた5種類の
録音モード（Rec Mode）から選んで録音します。詳しくは、
59ページ「サンプルルーパーで録音する」を参照してくだ
さい。

• 保存したサンプルは、ユーザーウェーブ音色として、パラ
メーターを編集することができます。詳細は、30ページ
「ユーザーウェーブ音色の編集内容」を参照してください。

• サンプルは、サンプルルーパーとして再生したり、ユーザー
ウェーブ音色として鍵盤で演奏することができます。

• フレーズ（41ページ）と同様に、サンプルごとに再生の方法
としてループやホールドのオンとオフを設定できます。

• 外部入力の音を入力したいときは、7ページを参照して本機
との接続を行ってください。

• 本機のペダルを使ってサンプルの録音や再生を操作するこ
ともできます。ペダルの設定方法は、67ページ「パフォーマ
ンスの編集内容」の“Pedal”を参照してください。

1. bm（REC）を押します。
録音モードの設定画面が表示されます。録音モードについ
ては、手順2に詳しい説明をします。

■録音メニューの設定
録音モードの設定画面のとき、br（MENU）を押して、録
音メニューに入ることができます。

• br（U、q、w、I）を使って設定項目を選び、bp（ダイ
ヤル）またはbr（－、＋）を使って各項目の値を変更し
ます。

bm

br

bp87

bk

サンプルの録音について

サンプルルーパーで録音する
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• リバースモード、サンプリングチャンネル、およびサンプリングレートは、新規の録音時にのみ適用されます。オーバーダビ
ング中は適用されません。

• サンプリングレートが高いほど、原音に近いサンプルになります。サンプリングレートとチャンネルの設定によって、録音
可能時間が異なります。

メニュー 内容 設定範囲

Precount プレカウント（Pre count）。録音の開始方法がマニュアルのモード（ML）において、録音の開始前に入れ
るプレカウント数を指定。 Off、2～8

Threshold
スレッシュホールドレベル（Threshold）。録音の開始方法がオート（AT）のモードにおいて、指定したレ
ベル以上に大きい音が入力されたとき、録音が開始される。
• 大きい値を指定すると、大きな音が入力されたときに録音が開始となります。

0～127

Reverse リバースモード（Reverse）。新規録音時の最初の録音分だけを逆再生する。 Off、On

Channel サンプリングチャンネル（Channel）。新規録音時に、ステレオで録音するか、あるいはモノラルで録音す
るかを選択。

Stereo：ステレオ、
Mono：モノラル

Smpl Rate 新規録音時のサンプリングレート（Sampling rate）。サンプリング周波数。 42kHz、21kHz

Auto OVDB 新規録音時にサンプルの終了点が決定した後に、自動的にループ再生を始める（Off）か、あるいはオー
バーダビングを始める（On）かを指定。 Off、On

チャンネル/レート 最大録音可能時間
テンポ別の最大録音可能拍数

テンポ30 テンポ101 テンポ120 テンポ126 テンポ132 テンポ255

Stereo/42 kHz 約4秒 2 8 9 10 10 20

Stereo/21 kHz
Mono/42 kHz 約9秒 4 16 19 20 21 －

Mono/21 kHz 約19秒 9 32 － － － －

• スレッシュホールドの設定時に、現在のスレッシュ
ホールドレベルと入力音のレベルを画面で確認できま
す。

■テンポの調整
8（TEMPO －、＋）を使って、テンポを調整します。
• テンポの調整方法は、42ページ「テンポ（速さ）を変え
るには」を参照してください。

2. bp（ダイヤル）あるいはbr（－、＋）を使って、録音
モードを以下の（1）から（5）の中から選びます。
• 録音モード名の末尾の２文字は、録音の開始方法を示
しています。

• 各録音モードにある項目（Length、Beats、Splits）は、
br（q、w）を使って項目を選び、bp（ダイヤル）また
はbr（－、＋）を使って値を設定します。

（1）NORM-AT：
新規サンプルを、開始方法オートで録音します。
• Length（録音時間）の設定

（2）NORM-ML：
新規サンプルを、開始方法マニュアルで録音します。
• Length（録音時間）の設定は、上記“NORM-AT”と同じ
内容です。

AT：オート（Auto）。本機を録音の待機状態にしてお
いて、鍵盤の演奏やマイク等で音を出すと録音が
自動的に開始されます。

ML：マニュアル（Manual）。手動で録音を開始します。

スレッシュホールドレベル

入力音レベル

Free ：bm（REC）あるいはbm（PLAY/STOP）
を押して録音を停止したとき、サンプル
の終了点が決定されます。最大録音可能
時間に達したときは、そこが終了点にな
ります。

01～32bt ：録音時間を拍数で指定します。
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（3）BEAT-AT：
1拍分録音して、それを指定回数繰り返すことで１つのサ
ンプルを作ります。オート録音のみ対応しています。
• Beats（拍数）の設定
02-32：録音した１拍分の音を何拍繰り返すかを指定
します。

（4）SPLT-AT：
指定した長さのサンプルを指定した回数だけ順次に録音
していき、各サンプルを連結させて1つのサンプルを作り
ます。オート録音のみ対応しています。
• Length（スプリットごとの長さ）の設定

• Splits（分割）数の設定
2、3、4、5：スプリット数を指定する。

■SPLT-ATで録音したスプリットを、ユーザー
ウェーブ音色として選択したい場合

• ソロシンセサイザー音色として選択：
23ページの“PCM Wave”を参照してください。

• PCMドラム音色として選択：
30ページの“Inst Number”を参照してください。

（5）OVDB-ML：
既存のサンプルを冒頭部分からオーバーダビングできま
す（Overdubbing）。マニュアル録音のみ対応していま
す。この録音モードを選ぶ場合は、手順1の前にオーバー
ダビングしたい既存サンプルを選んでおく必要がありま
す。
サンプルの録音直後でまだ保存をしていない場合、自動的
に“OVDB-ML”が選ばれます。新規に録音し直したいとき
は、その他の録音モードを選んでください。

• 最大録音可能時間を越えた長さが指定されている場
合、“ ! ”が点滅表示されます。その場合、60ページにあ
るチャンネル／レートの表を目安に、長さ、サンプリン
グチャンネル、サンプリングレート、テンポ等を調整し
てください。

•“ ! ”の点滅表示のまま手順３を操作すると、
“LOOPER : Can’t REC”と表示され、録音を開始する
ことはできません。

3. bm（REC）を押すと、bm（REC）は点滅に変わり、録
音の待機状態になります。

Free ：無音になったときに、スプリットの終了点が
決定されます。

1～6bt ：指定した拍数（beat）を経過してから無音に
なると、次のスプリットの録音待機状態に入
ります。指定した拍数に満たないで無音に
なった場合は、指定した拍数が終了するまで
録音が続きます。

既存サンプル番号および名称

サンプリングチャンネルとレート



サンプルルーパーで録音・再生する

62

4. 選択した録音モードによって、以下のように録音を
開始します。

■NORM-AT

鍵盤で演奏を始めるか、マイク等で音を出すか、あ
るいはbm（REC）を押すと、録音が開始されます。
• 録音が始まると、bm（REC）が点灯に変わります。
• 録音中、録音可能時間を基準にしたメモリーの消費量
の目安を画面で確認できます。

•“Length”に拍数を指定した場合、拍数分の録音の完了
と同時にbm（REC）が点滅に変わり、オーバーダビング
の待機状態になります。

•“Length”に“Free”を指定した場合、録音中にサンプル
の終了点にしたいタイミングでbm（REC）を押すと、
bm（REC）が点滅に変わりオーバーダビングの待機状
態になります。

• 録音中に最大録音時間に達すると、自動的にオーバー
ダビングの待機状態に移ります。

• オーバーダビングの待機状態になると、同時にそれま
でに録音したサンプルのループ再生が始まります。次
にオーバーダビングしたい演奏のリハーサルや、サン
プルとデュエットをしたいときなどに便利です。

•“Auto OVDB”がオンに設定されている場合は、オー
バーダビングの待機状態に入らずに、すぐにオーバー
ダビングが開始されます。

■NORM-ML

録音したいタイミングで、bm（REC）を押します。
• 録音開始後は、上記“NORM-AT”と同じ操作です。

■BEAT-AT

鍵盤の演奏やマイク等で音を出すか、あるいはbm
（REC）を押すと、1拍目の録音が開始されます。

• 録音が始まると、bm（REC）が点灯に変わります。
• 1拍目の録音が終わると、2拍目から“Beats”で指定し
た拍数分のサンプルが自動作成されます。その後、オー
バーダビングの待機状態に移ります。

■SPLT-AT

鍵盤の演奏やマイク等で音を出すか、あるいはbm
（REC）を押すと、録音が開始されます。

• 録音が始まると、bm（REC）が点灯に変わります。
•“Length”を“Free”以外に指定した場合、指定した拍数
を経過すると録音が停止されます。入力音が無音にな
ると、次の入力音の待機状態になります。入力音が検知
されると自動的に録音が再開されます。

•“Length”を“Free”に指定した場合、入力音が無音にな
るといったん録音を停止して、次の入力音の待機状態
になります。入力音が検知されると自動的に録音が再
開されます。

• 無音になったことを本機が自動で判別する入力レベル
は、“Threshold”（60ページ）で設定したレベルの半分
以下の値が約0.5秒間続いた場合に適用されます。
例えば、“Threshold”のレベルを「80」に設定している
とき、「40」以下のレベルが約0.5秒間続くと無音と判
別します。

•“Splits”で指定した分の録音を終えると、オーバーダビ
ングの待機状態に移ります。

•“Splits”で指定した数に満たないで録音を止める（bm
（REC）を押す）と、その時点でのスプリット数で録音さ
れます。例えば、“Splits”で5を指定したが3で録音を止
めると、スプリット数は3で録音されます。

■OVDB-ML
録音モード“OVDB-ML”を実行する場合は、手順1の前に
オーバーダビングしたい既存のサンプルを選んでおく必
要があります。

bm（REC）を押します。
• 事前に選択したサンプルへのオーバーダビングが始ま
り、bm（REC）が点灯します。

• オーバーダビング中、現在オーバーダビングしている
位置を画面で確認できます。

• bm（REC）が一瞬消灯してループの先頭位置であるこ
とをお知らせします。

• サンプルルーパーでは、オーバーダビングのアンドゥ
はできません。

メモリーの消費量

現在録音対象となっているスプリット番号

メモリーの消費量

現在オーバーダビングしている位置
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5. オーバーダビング待機状態からオーバーダビング
を再開したいとき、bm（REC）を押します。
オーバーダビングが始まると、bm（REC）が点灯に変わり
ます。
• オーバーダビングを一時的に中断するには、bm（REC）
を押します。

• その時点まで録音したサンプルをループ再生し続けま
すが、オーバーダビングを中断している間の演奏は録
音されません。

• もう一度bm（REC）を押すとオーバーダビングを再開
します。

6. 録音を終了したいとき、bm（PLAY/STOP）を押し
ます。
bm（REC）が消灯して、サンプル番号に“!TEMP”（テンポ
ラリー）と表示されます。
• 無音のまま録音を終了しても、1つのサンプルとして扱
われます。

7. 録音が終わったら、以下の要領で保存してくださ
い。
• 7（WRITE）を押すと、サンプルの保存画面になりま
す（64ページ）。

1. サンプルルーパーに録音したいステップシーケン
サーを選びます。
• ステップシーケンサーの操作方法は、48ページ「ス
テップシーケンサーを再生する」を参照してください。

2. bm（REC）を押します。
録音モード画面になります。
• br（－、＋）を使って、録音モードを“NORM-AT”に変
更します。

• 録音したい長さに合わせて“Length”を設定します。例
えば、4/4を2小節録音する場合は“8”に設定します。

3. bm（REC）をもう一回押します。
録音の待機状態になります。

4. bk（START/STOP）を押します。
ステップシーケンサーの再生が始まると同時に、サンプル
の録音も始まります。
• bm（REC）が点灯に変わります。
• 手順2で設定した“Length”のタイミングで録音が完了
し、同時にオーバーダビング待機状態になります。ス
テップシーケンサーも同時に自動停止します。

• この後の操作は、59ページ「サンプルルーパーで録音
する」の手順4以降と同じです。

1. bm（REC）を押したままにし、下のようなサンプル
の選択画面が表示されたら離します。

2. 再生したいサンプルを選びます。
• サンプルの選び方は、アルペジオの選択（37ページ）の
手順5と同じ要領です。

3. bk（STEP ＋）を押して、ループのオンとオフを切
り替えます。

• サンプルが空の場合、ループの切り替えはできません。

4. bk（STEP －）を押して、ホールドのオンとオフを
切り替えます。

• サンプルが空の場合、ホールドの切り替えはできませ
ん。

ステップシーケンサーを使ってサン
プルを録音する

サンプルを再生する

OFF：1回だけ再生させる
ON：繰り返し再生させる

OFF：bm（PLAY/STOP）を押している間だけ再生し、離
すと止まる

ON：bm（PLAY/STOP）を押すと再生が始まり、もう一
度bm（PLAY/STOP）を押すと止まる

サンプル番号

サンプル名称

ループの設定

ホールドの設定
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5. bm（PLAY/STOP）を押して、サンプルを再生しま
す。
• 再生中は、下記のようなLCD表示で現在のサンプル再
生位置をお知らせします。

• サンプルの選択画面を表示したままサンプルを再生し
ているとき、bm（REC）を押すと、オーバーダビングに
移ります。

• サンプルが空の場合、“LOOPER : EMPTY”と表示され
ます。

• サンプルの再生では、テンポを調節することはできま
せん。

6. bm（PLAY/STOP）を押して、再生を停止します。

サンプルを録音したあとにサンプル番号の横に付くマーク
は、以下の意味を表しています。

• 先頭に!がついたサンプルは「サンプルを再生する」の手順2
（63ページ）でサンプル番号を選び直すと破棄されます。保
存しておきたいサンプルは次の「サンプルを保存する」の手
順にしたがって保存してください。

7（WRITE）を押すと、サンプルの保存画面になります。ユー
ザー音色の保存と同じ要領で保存してください（11ページ）。

• 保存したデータを消去する方法は、75ページを参照してく
ださい。

■サンプルを外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

サンプル番号にあるマークについて

! ：保存前のサンプル
* ：保存済のサンプル
!TEMP：新規の録音後、まだ保存されていないサンプル

サンプルを保存する

現在のサンプル再生位置
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さらに高度な演奏にチャレンジする（パフォーマンス）

パフォーマンスモードでは、鍵盤で4種類の音色まで同時に演
奏することができます。また音色以外にもエフェクトやス
テップシーケンサーなど、本機のさまざまな機能の設定内容
をまとめて一つのデータ（パフォーマンス）として登録し、演
奏中に簡単に呼び出すことができます。
• 100種類のプリセットパフォーマンスがあり、ご自分で内
容を編集してユーザーパフォーマンスとして100種類まで
登録できます。プリセットパフォーマンスの一覧は、別紙
「Appendix」をご覧ください。

• 鍵盤ごとに異なる機能を割り当てて、それぞれの鍵盤を押
すことで実行させることができます（マルチファンクショ
ンキー）。
マルチファンクションキーの詳細や設定方法は、67ページ
「パフォーマンスの編集内容」の“Mltfunc Key”をご参照く
ださい。

1.7（PERFORM）を押します。
ボタンが点灯して、パフォーマンスモードになります。

2. アルペジオと同様の操作で（37ページ）、パフォー
マンスのバンクと番号を選びます。

9

7

br

3
8

2

概要 パフォーマンスの登録・呼び出し
パフォーマンスを登録する

br（U）で下記画面へ

3（K1～K4）の機能（68ページ参照）

マルチファンクションキー
機能のオンオフと鍵域の
設定状態（69ページ参照）

br（q、w）で編集対象
ゾーンを切り替え
（67ページ参照）

アルペジオのオンオフと鍵域の
設定状態（69ページ参照）

フレーズキープレイのオンオフと
鍵域の設定状態（69ページ参照）

Zone Param 
>Arp Enable
（68ページ参照）

Zone Param >Phrase Enable
（68ページ参照）

ゾーン1～4のオンオフと
鍵域の設定状態
（67ページ参照）
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3.7（EDIT）を押します。
パフォーマンス編集項目リストのトップ画面が表示されます。

4. 音色と同様の操作で、画面のリストから編集したい項目を選び、設定値を切り替えます。
• 編集内容の詳細は、67ページ「パフォーマンスの編集内容」をご参照ください。

5. 編集が終わったら、7（EDIT）を押します。
編集項目リスト画面を抜けます。

6.7（WRITE）を押して、編集したパフォーマンスをユーザーパフォーマンスとして保存してください。
• 保存の方法は、ユーザー音色の保存（11ページ）と同様です。

■ユーザーパフォーマンスのデータを外部機器に保存するには
• メモリーカード（77ページ）
• パソコン（82ページ）

1.7（PERFORM）を押します。
ボタンが点灯して、パフォーマンスモードになります。

2. アルペジオと同様の操作で（37ページ）、呼び出したいパフォーマンスのバンクと番号を選びます。
選んだパフォーマンスの登録内容が呼び出されます。
• 呼び出される内容は、次の「パフォーマンスの編集内容」と同じです。
• パフォーマンスを呼び出したときに、シーケンサーやアルペジオなど一部の機能の設定を呼び出さないようにすることがで
きます（パフォーマンスフィルター機能）。br（MENU）を押して下記の画面を表示させ、brを使って“PrfrmFilter >Ent”か
らグループの中に入って、設定を行ってください。

パフォーマンスフィルターの設定項目リスト

パフォーマンスを呼び出す

表示 内容 設定範囲

PrfrmFilter >Ent パフォーマンスフィルター（Performance Filter）

Step Seq
ステップシーケンサー（Step Sequencer）。この設定をオンにすると、パフォーマンスの編集項
目リスト（67ページ）のシーケンサーパラメーター（Sequencers Parameter）グループのうち、
ステップシーケンサー関係の項目内容を呼び出さなくなる。

Off, On

Arpeggio
アルペジオ（Arpeggio）。この設定をオンにすると、パフォーマンスの編集項目リスト（67ペー
ジ）のシーケンサーパラメーター（Sequencers Parameter）グループのうち、アルペジオ機能関
係の項目内容を呼び出さなくなる。

Off, On

Phrase
フレーズ（Phrase）。この設定をオンにすると、パフォーマンスの編集項目リスト（67ページ）の
シーケンサーパラメーター（Sequencers Parameter）グループのうち、フレーズシーケンサー
関係の項目内容を呼び出さなくなる。

Off, On

Tempo
テンポ（Tempo）。この設定をオンにすると、パフォーマンスの編集項目リスト（67ページ）の
シーケンサーパラメーター（Sequencers Parameter）グループのうち“Tempo”の設定内容を
呼び出さなくなる。

Off, On

Sys Rev
システムリバーブ（System Reverb）。この設定をオンにすると、パフォーマンスの編集項目リス
ト（67ページ）のエフェクトパラメーター（Effect Parameter）グループのうち、リバーブ関係の
項目内容を呼び出さなくなる。

Off, On

ゾーン1～4のオンオフと鍵域の設定状態
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編集項目リスト

Sys Cho
システムコーラス（System Chorus）。この設定をオンにすると、パフォーマンスの編集項目リス
ト（67ページ）のエフェクトパラメーター（Effect Parameter）グループのうち、コーラス関係の
項目内容を呼び出さなくなる。

Off, On

Master EQ
マスターイコライザー（Master EQ）。この設定をオンにすると、パフォーマンスの編集項目リス
ト（67ページ）のエフェクトパラメーター（Effect Parameter）グループのうち、マスターイコラ
イザー関係の項目内容を呼び出さなくなる。

Off, On

Looper
サンプルルーパー（Looper）。この設定をオンにすると、パフォーマンスの編集項目リスト（67
ページ）のシーケンサーパラメーター（Sequencers Parameter）グループのうち、サンプルルー
パー関係の項目内容を呼び出さなくなる。

Off, On

Multifunc Key
マルチファンクションキー（Multi-function Key）。この設定をオンにすると、パフォーマンスの
編集項目リスト（67ページ）のマルチファンクションキーパラメーター（Multi-function Key 
Parameter）グループの項目内容を呼び出さなくなる。

Off, On

パフォーマンスの編集内容

表示 内容 設定範囲

Zone Param >Ent
ゾーンパラメーター（Zone Parameter）。ゾーン1～4の、ゾーンごとの編集項目グループ。
• 9（PART －、＋）を押して、編集したいゾーンを選んでください。
• 65ページ「パフォーマンスを登録する」の手順2の後に、7（EDIT）をしばらく押したままに
すると、ショートカットでこのグループの中に入ることができます。

Zone ゾーンのオンオフ（Zone Enable）。ゾーン全体のオンとオフを切り替える。ミキサー機能（72
ページ）のパートオンオフ（Part Enable）とは別のもの。 Off, On

Tone

音色（Tone）。各ゾーンの音色を選ぶ。ミキサー機能のパートトーン（72ページ）と同じ。
• この項目選択中には、トーンモードと同様の操作で音色を選ぶことができる。
• クイックトーンモードでも設定可能（15ページ）。
• ゾーン2～4は、選べる音色のカテゴリーに制約がある（15ページ）。
• DSP付き音色は、音色名の隣に“DSP”と表示します（34ページ）。

ゾーン1: 
Solo Synth  P000 - 
PCM Drum U309
ゾーン2～4: 
PCM Tone  P100 - 
PCM Drum U309

KeyRangeLow

キーレンジロー（Key Range Low）。各ゾーンの鍵域の最低鍵盤。次のキーレンジハイとあわ
せて、各ゾーンの鍵域を設定する。

たとえば、ゾーン1と2を「F3（ロー）～C7（ハイ）」、ゾーン3と4を「C2（ロー）～E3（ハイ）」に設
定すれば、下図のように右側の鍵盤をゾーン1と2の音色、左側の鍵盤をゾーン3と4の音色で
弾くことができる。

• 鍵盤で設定値を入力することができます。

C- - G9※

KeyRangeHi
キーレンジハイ（Key Range High）。各ゾーンの鍵域の最高鍵盤。上記のキーレンジローとあ
わせて、ゾーンごとの鍵域を設定する。
• 鍵盤で設定値を入力することができます。

C- - G9※

Volume 音量（Volume）。ミキサー機能のパートボリューム（72ページ）と同じ。 0 - 127

Pan パンニング（Panning）。音の左右定位の調整。ミキサー機能のパートパン（72ページ）と同じ。 －64 - 0 - ＋63

Oct.Shift オクターブシフト（Octave Shift）。音の高さをオクターブ単位で切り替える。 －2 - 0 - ＋2

Transpose トランスポーズ（Transpose）。音の高さを半音単位で切り替える。ミキサー機能のパートコー
スチューン（72ページ）と同じ。 －12 - 0 - ＋12

Fine Tune ファインチューン（Fine Tune）。ミキサー機能のパートファインチューン（72ページ）と同じ。 －99 - 0 - ＋99

BendRngDwn ベンドレンジダウン（Bend Range Down）。ベンダーの下方向のピッチ変化量。 0～24

BendRngUp ベンドレンジアップ（Bend Range Up）。ベンダーの上方向のピッチ変化量。 0～24

Rev Send リバーブセンド（Reverb Send）。ミキサー機能のリバーブセンド（72ページ）と同じ。 0～127

Cho Send コーラスセンド（Chorus Send）。ミキサー機能のコーラスセンド（72ページ）と同じ。 0～127

DSP Line DSPライン（DSP Line）。ミキサー機能のパートDSPライン（72ページ）と同じ。 Off, On

表示 内容 設定範囲

C2 F3E3 C7

ゾーン3
ゾーン4

ゾーン1
ゾーン2
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Knob1Enable ノブ1のオンオフ（Knob1 Enable）。3（K1）の操作が各ゾーンに有効か無効か。 Off, On

Knob2Enable ノブ2のオンオフ（Knob2 Enable）。3（K2）の操作が各ゾーンに有効か無効か。 Off, On

Knob3Enable ノブ3のオンオフ（Knob3 Enable）。3（K3）の操作が各ゾーンに有効か無効か。 Off, On

Knob4Enable ノブ4のオンオフ（Knob4 Enable）。3（K4）の操作が各ゾーンに有効か無効か。 Off, On

Bend Enable ベンダーのオンオフ（Bender Enable）。bt（BENDER）の操作が各ゾーンに有効か無効か。 Off, On

Wheel Enable モジュレーションホールのオンオフ（Wheel Enable）。bt（MODULATION）の操作が各
ゾーンに有効か無効か。 Off, On

Pedal Enable ペダルのオンオフ（Pedal Enable）。cl（SUSTAIN/ASSIGNABLE JACK）に接続したペダ
ルの操作が各ゾーンに有効か無効か。 Off, On

Arp Enable アルペジオのオンオフ（Arpeggio Enable）。アルペジオ機能（37ページ）が各ゾーンに有効か
無効か。 Off, On

Phrase Enable フレーズのオンオフ（Phrase Enable）。フレーズシーケンサー（41ページ）が各ゾーンに有効
か無効か。 Off, On

Controller >Ent コントローラーパラメーター（Controller Parameter）。コントローラー類の編集項目グルー
プ。

K1

ノブターゲット1（Knob Target1）。3（K1）で操作するパラメーターを選ぶ。たとえばこの設
定を「CC67:Soft」にすると、3（K1）でペダルのソフト効果をかけることができるようにな
る。
CC00 - CC97：MIDIのコントロールチェンジ※1

NRPN, RPN：MIDIのNRPNとRPNパラメーター※1※2

Ch Pressure：MIDIのチャンネルプレッシャー※1

Arpeggio：プリセットアルペジオのタイプ選択（37ページ）
Tempo：テンポ設定（42ページ）
EQ Low Gain - EQ High Gain： Master EQ >Low Gain - High Gain（36ページ） 左記参照

K2 - K4 ノブターゲット2（Knob Target2）～ノブターゲット4（Knob Target4）。
ノブターゲット1と同様に、3（K2 ～ K4）それぞれで操作するパラメーターを選ぶ。 K1と同じ

Pedal

ペダル（Pedal）。cl（SUSTAIN/ASSIGNABLE JACK）に接続したペダルの機能を選ぶ。

ホールド（Hold）：音を持続させる。サステイン効果とも呼ぶ。
ソフト（Soft）：音量を若干小さくする。
ソステヌート（Sostenut）：
鍵盤を押しているときにペダルを踏むと、その鍵盤の音だけにホールドと同じ効果がかかる。
ステップシーケンサー再生・停止（SSEQ P/S）：
ステップシーケンサーのシーケンスの再生と停止を交互に行う。
フレーズシーケンサー再生・停止（Phrase P/S）：
フレーズシーケンサーのフレーズの再生と停止を交互に行う。
フレーズ録音（Phrase REC）：フレーズシーケンサーでのbo（REC）と同じ機能。
サンプルルーパー再生／停止（Lper P/S）：サンプルルーパーのサンプルの再生と停止を交互に行
う。
サンプルルーパー録音（Lper Rec）：サンプルルーパーでのbm（REC）と同じ機能。

左記参照

Touch

タッチ（Touch）。鍵盤を弾いたときの、タッチ感度を切り替える。

オフ（Off）：タッチにかかわらず常に一定の音量で鳴る。
ノーマル（Normal）
ライト（Light）：軽く弾いても大きな音量を出しやすい。

左記参照

TchOffVel タッチオフベロシティー（Touch Off Velocity）。上記タッチカーブの設定値がオフのときの
音量を設定する。 0 - 127

Sequencers >Ent シーケンサーパラメーター（Sequencers Parameter）。ステップシーケンサー（46ページ）、
フレーズシーケンサー（41ページ）、アルペジオ機能（37ページ）の編集項目グループ。

Tempo テンポ（Tempo）。フレーズやステップシーケンサーの再生速度を調整する。8（TEMPO）で
も変更できる。 30 - 255

Step SEQ 
Number

ステップシーケンサー番号（Step Sequencer Number）。ステップシーケンサーのシーケン
スを選ぶ（48ページ）。 Preset00 - User99

Solo1 Ch
ステップシーケンサーソロトラックパート（Step Sequencer Solo Track Part）。
ステップシーケンサーのソロトラック1を、パート14からパート1（ゾーンパート1）に変更可
能（51ページ）。

1, 14

表示 内容 設定範囲

※1 各値の内容は、MIDIインプリメンテーション（http://casio.jp/support/emi/）や、
MIDI関係の資料でご確認ください。

※2 これらを選んだ後は、さらにbr（ENTER）を押して、以下項目を調整してください。
MSB：NRPNでは“63H”、RPNでは“65H”（設定範囲 000 - 127）
LSB：NRPNでは“62H”、RPNでは“64H”（設定範囲 000 - 127）
Send Data：MSBとLSBのどちらの Valueをノブで操作するか（設定範囲 MSB, LSB）
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Change ステップシーケンサー切り替わりタイミング（Step Sequencer Change Timing）。
ステップシーケンサーでパターンを変更したときの切り替わりタイミングを選ぶ（51ページ）。 Wait, Real, Beat

Key Shift ステップシーケンサーキーシフト（Step Sequencer Key Shift）。ステップシーケンサーの
キーシフト機能のオンオフを切り替える（48ページ）。 Off, On

Pattern ステップシーケンサーパターンナンバー（Step SEQ Pattern Number）。ステップシーケン
サーのパターン（46ページ）を選ぶ。 1 - 8

Arp On/Off アルペジオ機能のオンオフ（Arpeggio ON/OFF）。オフにすると、アルペジオ機能が使えなく
なる。 Off, On

Arp Type アルペジオタイプ（Arpeggio Type）。アルペジオのタイプを選ぶ（37ページ）。 Preset00 - User99

ArpKeyRgLo アルペジオキーレンジロー（Arpeggio Key Range Low）。アルペジオ機能が有効な鍵域の最
低鍵盤。次のアルペジオキーレンジハイとあわせて、アルペジオ機能の有効鍵域を設定する。 C- - G9※

ArpKeyRgHi アルペジオキーレンジハイ（Arpeggio Key Range High）。アルペジオ機能が有効な鍵域の最
高鍵盤。上記のアルペジオキーレンジローとあわせて、アルペジオ機能の有効鍵域を設定する。 C- - G9※

Arp Hold アルペジオホールド（Arpeggio Hold）。アルペジオのホールド設定のオンオフを選ぶ（37
ページ）。 Off, On

Arp Synchro アルペジオシンクロ（Arpeggio Synchro）。アルペジオシンクロ設定を切り替える（37ページ）。 Off, On, S/S

Key Play フレーズキープレイ（Phrase Key Play）。フレーズシーケンサーのフレーズキープレイの
オンオフ。 Off, On

Phrase フレーズ番号（Phrase Number）。フレーズシーケンサーのフレーズを選ぶ（41ページ）。 Preset00 - User99

PhrKeyRgLo
フレーズキーレンジロー（Phrase Key Range Low）。フレーズシーケンサーのキープレイ
（42ページ）が有効な鍵域の最低鍵盤。次のフレーズキーレンジハイとあわせて、キープレイの
有効鍵域を設定する。

C- - G9※

PhrKeyRgHi
フレーズキーレンジハイ（Phrase Key Range High）。フレーズシーケンサーのキープレイ
（42ページ）が有効な鍵域の最高鍵盤。上記のフレーズキーレンジローとあわせて、キープレイ
の有効鍵域を設定する。

C- - G9※

Looper Number ルーパー番号（Looper Number）。サンプルルーパーのサンプル番号を選ぶ（59ページ）。 U:0～U:9

Mltfunc Key >Ent

マルチファンクションキー（Multi-function Key）。C5～C7の各鍵盤（最大25鍵）に異なる機
能を割り当てる。

Enable マルチファンクションキー機能のOn/Off。 Off, On

KeyRangeLow
マルチファンクションキー機能のキーレンジロー（Multi-function Key Range Low）。
マルチファンクションキー機能が有効となる鍵域の最低鍵盤を設定する。
• 鍵盤で設定値を入力することができます。

C5～C7

Key Setting >Ent

鍵盤に割り当てる機能を選択（Key Setting）。機能を割り当てる鍵盤を指定する方法は、直接
その鍵盤を押すか、あるいは9（Part －、＋）で指定する。

--------- マルチファンクションキー機能が未設定。
• 未設定でも、“Mltfunc Key >Enable”がOnの場合、鍵盤を押しても音は鳴らない。 －

Phrase 1

再生パートを指定してフレーズを再生する（Phrase）。C5-Bb5の範囲の鍵盤に設定可能。
Phrase 1が設定されている場合、B5の鍵盤でPhrase 1 Stop（Phrase 1の停止）を操作でき
る。再生パートはPart5またはPart1を選択。再生中は、LCD表示のPart15の一番上にある目盛
りが点灯。再生時のキーシフトの値も設定可能。
• bn（MIXER）を押すと、再生パートのミキサー設定画面に入ることができます。
• 再生パートのミキサー設定は、パフォーマンスとして保存されます。

• Play Part：1、5
• Phrase：
P:0-0～P:9-9、
U:0-0～U:9-9

• Key Shift：
－127 - 000 - 
+127

表示 内容 設定範囲

C7C5

機能のパラメーター

鍵盤 機能名

B
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※画面表示の“C-”は、C-1（C0の1オクターブ下）を表します。

Phrase 2

再生パートを指定してフレーズを再生する（Phrase）。C6-Bb6の範囲の鍵盤に設定可能。
Phrase 2が設定されている場合、B6の鍵盤でPhrase 2 Stop（Phrase 2の停止）を操作でき
る。再生パートはPart6またはPart1を選択。再生中は、LCD表示のPart16の一番上にある目盛
りが点灯。再生時のキーシフトの値も設定可能。
• bn（MIXER）を押すと、再生パートのミキサー設定画面に入ることができます。
• 再生パートのミキサー設定は、パフォーマンスとして保存されます。

• Play Part：1、6
• Phrase：
P:0-0～P:9-9、
U:0-0～U:9-9

• Key Shift：
－127 - 000 - 
+127

Tempo テンポを変更する（Tempo）。TAPの場合、TAPボタンと同様の動作を行う。TAP以外の場合、
右記の設定に応じてテンポが変更される。

TAP、＋、－、
30～255

Tone トーンに設定された鍵盤を押すと、指定したZoneの音色をToneの内容にしたがって変更す
る（Tone）。

• Zone：1、2、3、4
• Tone：＋、－、
あるいは“Zone 
Param >Tone”
で選択可能な番号

Step Seq ステップシーケンサー（Step Sequencer）。再生するシーケンス番号を切り替える。
＋、－、
P:0-0～P:9-9、
U:0-0～U:9-9

Chain チェーン番号を切り替えて、チェーンをOnにする（Chain）。 ＋、－、
U:0-0～U:9-9

DSP DSPを切り替える（DSP）。Offでは、コーラス/DSP選択（36ページ）がコーラスになる。ただ
し、ソロシンセサイザー音色が選択されているときは切り替えできない。

Off、＋、－、ton、
P:0-0～P:9-9、
U:0-0～U:9-9

DSP Line 指定したパートのDSP Line SelectのOn/Offを交互に切り替える。 01～16

Note
指定したパート番号（Part）、鍵盤（Key）、およびベロシティー（Velocity）の内容にしたがって
ノートを発生させる（Note）。
• 右記“Key”の設定のとき、鍵盤で設定値を入力することができます。

• Part：01～16
• Key：C- ～ G9※
• Velocity：
KeyOn、
001～127

Ctrl Chng
指定したパート番号（Part）、コントロール番号（Control）、およびバリュー（Value）の内容に
したがってコントロールチェンジを発生（Control Change）。
ValueがKeyOnの場合は鍵盤を押したときのベロシティの数値で発生するが、鍵盤を離して
も000の数値を発生しない。

• Part：01～16
• Control：
000～ 119

• Value：KeyOn、
000～127

Prog Chng 指定したパート番号（Part）、バンクMSB（Bank MSB）、およびバリュー（Value）の内容にした
がってプログラムチェンジを発生（Program Change with Bank MSB）。

• Part：01～16
• Bank MSB：
000～ 127

• Value：
000～127

Ch Press
指定したパート番号（Part）、およびバリュー（Value）の内容にしたがってチャンネル・プレッ
シャーを発生（Channel Pressure）。チャンネルアフタータッチ。鍵盤を離すと000の数値を
発生する。

• Part：01～16
• Value：KeyOn、
001～127

Pitch Bend 指定したパート番号（Part）、およびバリュー（Value）の内容にしたがってピッチベンダーを発
生（Pitch Bender）。鍵盤を離すと000の数値を発生する。

• Part：01～16
• Value：KeyOn、
－256～000～
255

Poly Press
指定したパート番号（Part）、鍵盤（Key）、およびバリュー（Value）の内容にしたがってポリ
フォニック・キー・プレッシャーを発生（Polyphonic Key Pressure）。鍵盤を離すと000の数
値を発生する。
• 右記“Key”の設定のとき、鍵盤で設定値を入力することができます。

• Part：01～16
• Key：C- ～ G9※
• Value：KeyOn、
001～127

Effect >Ent エフェクトパラメーター（Effect Parameter）。エフェクト（34ページ）の設定項目グループ。
グループ内の項目は、35ページ「エフェクト設定項目リスト」をご参照ください。

MIDI >Ent MIDIパラメーター（MIDI Parameter）。MIDI関係（74ページ）の設定項目グループ。9
（PART －、＋）を押して、編集したいパートを本機の音源16パートから選んでください。

Ext Out Ch 外部送信チャンネル（External Out Channel）。各パートの情報を外部へMIDI送信するとき
のMIDIチャンネル（73ページ）。 1 - 16

Ext In Ch 外部受信チャンネル（External In Channel）。各パートで受信するMIDIメッセージのチャン
ネル。 Off, 1 - 16

Gen Out 内部送信オンオフ（Gen Out）。各パートの情報を本機内部の音源に対して送るか否か。 Off, On

MIDI Out MIDI出力オンオフ（MIDI Out）。各パートの情報をck（MIDI OUT/THRU）から外部へMIDI
送信するか否か。 Off, On

USB Out USB出力オンオフ（USB Out）。各パートの情報をck（USB）から外部へMIDI送信するか否
か。 Off, On

表示 内容 設定範囲

B
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本機の音源パート（パート01～16、外部入力パート）（18ペー
ジ）の、音色や音量などさまざまな設定項目※を、パート間のバ
ランスを見ながら調節することができます。
※パートごとの設定項目を「パート設定項目」、全パートに
共通の設定項目を「全体設定項目」と呼びます。

1. bn（MIXER）を押します。
ミキサー画面になります。

2.9（PART －、＋）で、設定対象パートを選びます。

3. br（U、q、w、I）を使って設定項目を選び、bp
（ダイヤル）またはbr（－、＋）で設定値を変更しま
す。
• 設定項目の詳細は、72ページ「ミキサーの設定内容」を
ご参照ください。

4. 設定が終わったら、bn（MIXER）を押して、ミキ
サー画面を終了します。

5（1/9～MASTER）や、4（1～16）を使えば、さらにすばや
くミキサーの設定を調整することができます。

1. bn（MIXER）を押します。
ミキサー画面になります。

2.2（KEY SHIFT、SLIDER A/B、1-8/9-16）を
使って、スライダー（5（1/9 ～ MASTER））に割
り当てる設定対象パートを変更します。
• ボタンを押すごとに、ボタンの点灯と消灯が交互に切
り替わります。

3. スライダーを動かして、そのスライダーに割り当て
た設定対象パートの設定を調整します。
• 設定項目はbr（U、q、w、I）を使って選んでくださ
い。

9

7 bn bp

br

5

bk

4

2

ミキサー機能を使う

この調整をするには… この設定対象パートを選びます

パート01～16の
パート設定項目
（72ページ）

All, 01～16
•“All”を選ぶと、パート01～16を全部
まとめて調整することができる。
“All”を選ぶには、“01”から9
（PART －）を1回押す。

全体設定項目
（72ページ）

Master
•“01”から9（PART －）を2回押す

外部入力パートの
パート設定項目
（72ページ）

Ext
•“01”から9（PART －）を3回押す

設定対象パート 各パートの設定状態

設定項目リスト 設定対象パートマーク

スライダーやステップボタンで、設定をすばやく
調整する

2

消灯
点灯

Master
Ext

消灯
点灯

パート01～08
パート09～16

消灯
点灯

パート01～08（または09～16）
All（左端のスライダーのみ）
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4. パート01～16の各パートのオンオフは、4（1～16）で切り替えることができます。
• ボタンを押すごとに、ボタンの点灯（オン）と消灯（オフ）が交互に切り替わります。
• ボタンをしばらく押したままにすると、そのパートのみをオン（ソロ状態）にすることができます。同じボタンをもう一度押
すと、ソロ状態を解除します。

例：パート08をソロ状態にする場合

■パート01～16のパート設定項目

■外部入力パートのパート設定項目

■全体設定項目

ミキサーの設定内容

表示 内容 設定範囲

Part パートオンオフ（Part Off/On）。各パートのオフとオンを切り替える。4（1～16）で切り替える
パートのオンオフ（72ページ）と同じパラメーター。 Off, On

Tone
パートトーン（Part Tone）。各パートの音色。
この項目の選択中には、トーンモードと同様の操作で音色を選ぶことができる。
• DSP付き音色は、音色名の隣に“DSP”と表示します（35ページ）。

パート01：
Solo Synth  P000 - 
PCM Drum U309
パート02 - 16：
PCM Tone  P100 - 
PCM Drum U309

Volume パートの音量（Part Volume）。各パートの音量。 0 - 127

Pan パートパンニング（Panning）。音の左右定位の調整。 －64 - 0 - ＋63

CoarseTune パートコースチューン（Part Coarse Tune）。音の高さを半音単位で切り替える。 －12 - 0 - ＋12

FineTune パートファインチューン（Fine Tune）。音の高さをセント単位で切り替える。 －99 - 0 - ＋99

BendRange パートベンドレンジ（Part Bend Range）。bt（BENDER）を回し切ったときの、ピッチ変化幅（半
音単位）。 －24 - 0 - ＋24

DSP Line パートDSPライン（Part DSP Line）。各パートの音にDSP（34ページ）をかけるかどうかを選ぶ。 Off, On

Rev Send パートリバーブセンド（Part Reverb Send）。各パートのリバーブ効果（34ページ）のかかり具合。 0 - 127

Cho Send パートコーラスセンド（Part Chorus Send）。各パートのコーラス効果（34ページ）のかかり具合。 0 - 127

表示 内容 設定範囲

Part

「パート01～16のパート設定項目」（72ページ）と同じ

Volume

Pan

DSP Line

Rev Send

Cho Send

N.Thresh ノイズゲートのしきい値（Noise Gate Threshold）。ノイズ軽減のため、この設定値より小さい音量
の入力音はカットする。 0 - 127

N.Release ノイズゲートリリース（Noise Gate Release）。入力音の音量がノイズゲートのしきい値を下回っ
た時点から、入力音をカットするまでの時間。 0 - 127

Auto Level 自動レベル調整（Auto Level Control）。入力音のレベルを自動的に整える効果。大きい設定値ほど
効果が大きくなる。 Off, 1 - 3

表示 内容 設定範囲

Volume 全体の音量（Master Volume）。全パートまとめての音量設定。 0 - 127

Pan 全体のパンニング（Master Panning）。全パートまとめての、音の左右定位調整。 －64 - 0 - ＋63

4

点灯

しばらく押したままにします。
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本機全体にかかわる、以下の設定を変更します。
• チューニング（音の高さを微調整する）
• ローカルコントロール
• マスターコースチューン（音の高さを半音単位で変える）
• 電源を入れた直後のモード
• 液晶画面のコントラスト
• オートパワーオフ機能（9ページ）のオンオフ

1.7（SETTING）を押します。
設定画面になり、“General >Ent”が選ばれています。

2. br（ENTER）を押します。

3. br（U、q、w、I）を使って設定項目を選び、bp
（ダイヤル）またはbr（－、＋）で設定値を変更しま
す。

設定項目

4. 設定が終わったら、7（SETTING）を押して、設定
画面を終了します。

電子楽器同士、あるいは電子楽器とコンピューター機器との 
間で情報をやり取りできるように、デジタル信号の仕様や端 
子の形状について定めた統一規格のことです。
本機のMIDI仕様について、詳しくは以下のホームページに公 
開している「MIDIインプリメンテーション」をご覧ください。
http://casio.jp/support/emi/

• 本機と他の電子楽器とを接続してMIDI演奏を行う場合は、
お互いのMIDI端子同士を、別売または市販のMIDIケーブ
ルで接続してください（7ページ）。

• パソコンとの接続は、82ページをご参照ください。
• 本機の各パート（71ページ）と、MIDI IN、MIDI OUTチャン
ネルの対応については、70ページ「パフォーマンスの編集
内容」をご参照ください。

• 本機はGM（General MIDI Level 1）に準拠しています。

本機全体にかかわる設定
表示 内容 設定範囲

Tuning
チューニング（Tuning）。本機全体の
音の高さを、0.1ヘルツ単位で微調整
する。

415.5 - 
465.9Hz

M.Coarse
マスターコースチューン（Master 
Coarse Tune）。本機全体の音の高
さを、半音単位で調整する。

－24 - 0 - 
＋24

Local Ctrl

ローカルコントロール（Local 
Control）。オフにすると鍵盤を弾い
ても本機の音源が鳴らなくなる。鍵
盤やペダルで外部音源のみを鳴らし
たいときにオフにする。

Off, On

Start Up

起動モード（Start Up Item）。本機
の電源を入れた直後のモードを下記
の3種類から選ぶ。
Perfm： パフォーマンスモード
Tone： トーンモード
S.Seq： ステップシーケンサーモード

左記参照

Contrast
液晶画面のコントラスト（LCD 
Contrast）。液晶画面のコントラス
トを調整する。

1 - 17

Auto Power
オートパワーオフ機能のオンオフ
（Auto Power Off）。オフにすると、
オートパワーオフ機能（9ページ）を
解除する。

Off, On

MIDI 機能を使ってみる
MIDI について
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1.7（SETTING）を押します。

2. br（w）を押して“MIDI >Ent”を選び、br
（ENTER）を押します。

3. br（U、q、w、I）を使って設定項目を選び、bp
（ダイヤル）またはbr（－、＋）で設定値を変更しま
す。

設定項目

※これらの設定変更を有効にするには、本機の電源を入れ
なおしてください。設定画面を抜ける際に、そのことを告
知するメッセージが画面に表示されます。

4. 設定が終わったら、7（SETTING）を押して、設定
画面を終了します。

• MIDIデータ送信のチャンネル切り替えなど、パフォーマン
ス編集で変更できる設定もあります。70ページの
“MIDI >Ent”グループをご参照ください。

MIDI関係の設定

表示 内容 設定範囲

Device ID

デバイスID（Device ID）。MIDIのシ
ステム・エクスクルーシブ・メッセー
ジ送受信での、本機のID番号を選ぶ。
•“All”を選ぶと、システム・エクスク
ルーシブ・メッセージをID番号に
係らず受信する。

• ID番号等の詳細は、MIDIインプリ
メンテーション
（http://casio.jp/support/emi/）
参照。

1 - 16, 
ALL

Basic Ch

ベーシックチャンネル（Basic 
Channel）。後述の“Perform 
NRPN”、“S.Seq NRPN”などのMIDI
メッセージを受信するチャンネルを
選ぶ。

1 - 16

MIDIOutSel

MIDIアウト選択（MIDI Out 
Select）。 MIDIアウトとして何を出
力するかを選ぶ。※
KEY（Keyboard）：鍵盤演奏などの本
機の演奏や操作
MIDI（MIDI IN）：ck（MIDI IN） に
入力されたメッセージ（MIDI THRU）
USB（USB IN）：ck（USB）に入力さ
れたメッセージ

左記参照

USBOutSel

USBアウト選択（USB Out Select）。
USBアウトとして何を出力するかを
選ぶ。※
KEY（Keyboard）：鍵盤など本機の操
作
MIDI（MIDI IN）：ck（MIDI IN）に入
力されたメッセージ

左記参照

MIDI In
MIDIイン オンオフ（MIDI IN 
Enable）。 この設定をオンにすると、
ck（MIDI IN）に入力されたメッ
セージを本機内部音源に反映する。※

Off, On

USB In
USBイン オンオフ（USB IN 
Enable）。この設定をオンにすると、
ck（USB）に入力されたメッセージ
を本機内部音源に反映する。※

Off, On

Sync Mode

シンクモード（Sync Mode）。MIDIに
よる本機と外部機器との同期設定。※
Off： 同期しない。
Mast（Master）：本機からClock、
Start/Stop（ステップシーケンサー）
などを出力して、外部機器をコント
ロールする。
Slav（Slave）：外部機器からのClock、
Start/Stopなどを受信して動作する。
• Clockを受信しないと、ステップ
シーケンサーやフレーズシーケン
サーの再生ができない。また Start/
Stopはステップシーケンサーのス
タート／ストップとみなす。

左記参照

Perform NRPN

パフォーマンスNRPN変更
（Performance NRPN Change）。 こ
の設定をオンにすると、外部機器から
のMIDI NRPNメッセージで本機の
パフォーマンス（66ページ）を選択で
きる。

Off, On

S.Seq NRPN

ステップシーケンサーNRPN変更
（Step Seq NRPN Change）。 この設
定をオンにすると、外部機器からの
MIDI NRPNメッセージで本機のシー
ケンス（48ページ）を選択できる。

Off, On

Phrase NRPN

フレーズNRPN変更（Phrase NRPN 
Change）。 この設定をオンにする
と、外部機器からのMIDI NRPNメッ
セージで本機のフレーズ（41ページ）
を選択できる。

Off, On

Arp NRPN

アルペジオNRPN変更（Arpeggio 
NRPN Change）。 この設定をオンに
すると、外部機器からのMIDI NRPN
メッセージで本機のアルペジオタイ
プ（37ページ）を選択できる。

Off, On

表示 内容 設定範囲
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ご自分で保存したユーザー音色やユーザーシーケンスなどの
データを消去することができます。

1. 79ページ「本機のデータをタイプ別にカードに保
存するには」の手順2の表組みを参照し、消去したい
データの種類に応じた操作を行います。

2. br（q、w）を使って●を“Clear USER”に移動
し、br（ENTER）を押します。
• 次のようなメニュー画面が表示されます（以下はステッ
プシーケンサーモードから表示した場合の例です）。

• フレーズシーケンサーの場合は、フレーズのデータサ
イズも表示します。

3. bp（ダイヤル）またはbr（－、＋）を使って、消去す
る番号を選びます。

4. br（ENTER）を押します。

5.“Sure?”という確認メッセージが表示されるので、
消去を実行する場合はbr（YES）を、操作をキャン
セルする場合はbr（NO）を押します。

本機の設定内容やデータをまとめて初期化することができま
す。

1.7（SETTING）を押します。

2. br（ENTER）を押します。

3. br（U、q、w、I）を使って“Initialize >Ent”を選
び、br（ENTER）を押します。
イニシャライズ画面になります。

4. br（q、w）を使って、初期化対象を選びます。
初期化対象

5. br（ENTER）を押します。
“Sure?”と表示されます。

6. br（YES）を押します。
“Complete!”が表示されたら、初期化完了です。

7.7（SETTING）を押して、設定画面を終了します。
• 以下のホームページ
（http://casio.jp/support/emi/）から、工場出荷直後
の本機の設定内容やデータをダウンロードして、本機
へ保存することができます。
パソコンとの接続についての詳細は、82ページ「パソ
コンとの接続について」を参照してください。

保存したデータを消去する 本機全体の設定内容やデータを初期
化する（イニシャライズ）

表示 内容

Parameter >Ent
パラメーターの初期化（Parameter）。LCDコン
トラスト（73ページ）以外の、本機の全設定内容
を初期化する。

All >Ent
すべての初期化（All）。本機のすべての設定内容
と保存データを初期化する。また、ユーザー
ウェーブを消去する。
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デモンストレーション用の内蔵曲（デモ曲）や、メモリーカー
ドに保存している楽曲ファイル（SMF）を再生して楽しむこと
ができます。

1.7（SETTING）と7（WRITE）を同時に押します。

2. br（q、w）を使って、再生対象を選びます。
再生対象

3. br（ENTER）を押します。
再生画面になり、デモ曲は自動で再生スタートします。
• br（－、＋）でファイルを選び、bk（START/STOP）を
押して再生をスタートさせてください。

• 再生中には、bp（ダイヤル）またはbr（－、＋）で曲や
ファイルを変更することができます。
また、bk（4つのボタン）で曲の早送りなどが可能です
（下記「操作ガイド」参照）。

デモ曲の再生画面

4. bk（START/STOP）を押します。
再生を停止します。
• 7（SETTING、WRITE）の同時押し、あるいはbr
（EXIT）押しでも、停止させることができます。

デモ曲やカード上のファイルを再生
する

表示 内容

Demo >Ent デモ曲（Demo）。本機の性能をデモンストレー
ションするための内蔵曲。

Smf >Ent

SMF曲（Standard MIDI File）。本機に装着した
メモリーカードに保存している楽曲ファイル。
• 再生可能な楽曲ファイルは、SMFフォーマット
0、1のMIDIファイル（MID）です。

• 再生するファイルは必ず、カード内の
“MUSICDAT”フォルダ（80ページ）の中に保
存してください。

曲名

操作ガイド
s（早戻し）：bk（STEP －）
d（早送り）：bk（STEP ＋）
Y（停止） ：bk（START/STOP）
YY（一時停止）：bk（CHAIN）
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メモリーカードを使用する

SDメモリーカードやSDHCメモリーカード（以下「カード」と
表記）を使うと、本機のユーザーエリアとカードの間でデータ
を転送（ユーザーエリアからカードへの保存、カードからユー
ザーエリアへの読み込み）したり、カード上の楽曲ファイル
（MIDIファイル）を本機で再生したりすることができます。

• 以下のカードをご使用ください。
規格：SDHCメモリーカード、または
SDメモリーカード
容量：32GB以下
これ以外のカードはご使用になれませ
ん。

• SDHCロゴはSD-3C, LLCの商標です。

■カードへの保存とカードからの読み込みが可能な
データ

• 個別データの保存／読み込みについては、79ページ「本機
のデータをカードに保存する」および80ページ「カードか
ら本機へデータを読み込む」をご参照ください。

• 全データの保存／読み込みについては、80ページ「本機の
全データを一括してカードに保存するには」、および81
ページ「カードから本機へ全データを一括して読み込むに
は」をご参照ください。

■カードから直接再生できるデータ

• 本機が対応していないメモリーカードに格納された、利用
可能データを本機で使用したい場合は、本機で利用可能な
メモリーカードにそのデータをコピーして本機に読み込む
か、そのデータをパソコンからデータエディターを使って
本機に転送する必要があります。詳しくは、82ページ「パソ
コンとの接続について」をご参照ください。

7 bn bp

br

3

bk

bq

利用可能なデータの種類と内容

データの種類 内容（拡張子）
ユーザーパフォーマンス
（65ページ）

本機で編集したパフォーマンスのデータ
（ZPF）

ユーザー
PCMメロディー音色
（29ページ）

本機で編集したメロディー音色のデータ
（ZTN）

ユーザーソロシンセ
サイザー音色
（21ページ）

本機で編集したソロシンセサイザー音色
のデータ
（ZSY）

ユーザー
PCMドラム音色
（29ページ）

本機で編集したドラム音色のデータ
（ZDR）

ユーザーウェーブ音色
（30ページ）

本機で編集したユーザーウェーブ音色の
データ
（ZWT）

ユーザーDSP
（36ページ） 本機で編集したDSPのデータ（DS7）

ユーザーステップ
シーケンス
（57ページ）

本機で記録したステップシーケンスの
データ
（ZSS）

ステップシーケンス
チェーン
（58ページ）

本機で記録したシーケンスチェーンの
データ
（ZSC、MID（保存のみ））

ユーザーフレーズ
（45ページ）

本機で記録したフレーズのデータ
（ZPH）

ユーザーアルペジオ
（38ページ）

本機で編集したアルペジオのデータ
（ZAR）

全データ 上記すべてのデータ
（ZAL）

設定データ 本機で設定したデータ
（ZST）

データの種類 内容（拡張子）
楽曲ファイル
（81ページ）

SMFフォーマット0、1のMIDIファイル
（MID）

データの種類 内容（拡張子）
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• カードに付属している取扱説明書の注意事項をお守りくだ
さい。

• カードには、書き込み禁止スイッチがあります。誤ってデー
タを消さないようにしたいときに使用してください。

• 以下のような場所での保管や使用は避けてください。カー
ド上のデータが壊れる場合があります。
– 高温多湿、または腐食性のある場所
– 強い静電気や電気的ノイズの発生しやすい場所

• カードを抜き差しするときに、カードの接触面に直接触れ
ないでください。

• データの保存処理中は、液晶画面に“Please Wait”と表示さ
れますので、本機の操作を一切行わないでお待ちください。
この表示中に本機の電源が落ちたりカードが抜かれたりす
ると、データが破損・消失したり、6（POWER）を押しても
電源が入らなくなる恐れがあります。万一本機の電源が入
らなくなったときは、84ページ「困ったときは」をご参照く
ださい。

•“No Card”の表示は、カードスロットにカードが挿入され
ていないときに現れます。カードが挿入されているときの
表示については、81ページ「カード上のファイルを再生す
る」をご参照ください。

• カードスロットには、指定のカード以外は決して入れない
でください。故障の原因となります。

• 手の指やカードから静電気がカードスロット部に伝わる
と、本機が誤作動する場合があります。このような場合は一
度本機の電源を切ってから、電源を入れ直してください。

• 長時間使用すると取り出したカードが温かくなっている場
合がありますが、故障ではありません。

• カードには表裏と前後の方向があります。無理に入れよう
とすると破損する恐れがあります。

1. カードの表面を上にして、カードスロットck（SD 
CARD SLOT）へカチッと音がして止まるまで押
し込みます。

2. 取り出すときは、カードをさらに押し込みます。
ロックが外れて、カードが少し押し出されます。出てきた
部分をつまんで引き抜きます。

• 最初に、必ず本機でカードをフォーマットしてください。
• フォーマットする前に、カードに大切なデータが保存され
ていないことをご確認ください。

• 本機でのフォーマットは、クイックフォーマットを実行し
ます。データを完全に消去するにはパソコンなどで通常の
フォーマットを行ってください。

1. フォーマットするカードを、本機のカードスロット
に装着します。
• カードの書き込み禁止スイッチを解除して、書き込み
ができるようにしておいてください。

2.7（SETTING）を押します。

3. br（q、w）を使って●を“CardUtility”に移動
し、br（ENTER）を押します。
•“CARD UTIL”画面が表示されます。

4. br（q、w）を使って“Format”に0を移動しま
す。

5. br（ENTER）を押します。
•“Sure?”という確認メッセージが表示されます。

6. フォーマットを実行して良い場合はbr（YES）を、
操作をキャンセルする場合はbr（NO）を押しま
す。
• 画面に“Please Wait”（実行中）と表示されます。この
間は、本機の操作を一切行わないでください。フォー
マットが終了すると、画面に“Complete!”（完了）と表
示されます。

• フォーマットには数分かかる場合があります。

カードとカードスロットの取扱い上のご注意

カードを本機に入れる・取り出す

表面

カードをフォーマットする
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1. カードを本機のカードスロットに装着します。

2. カードに保存したい本機のデータの種類に応じて、
次の操作を行います。

3. br（q、w）を使って●を“Card Save”（全データ
の場合“Save”）に移動し、br（ENTER）を押しま
す。
• 次のようなメニュー画面が表示されます（以下はパ
フォーマンスモードから表示した場合の例です）。

4. br（ENTER）を押します。

5. 保存する番号（必要に応じてバンクも）、およびファ
イルの名前を入力します。
初期表示されているファイル名を、次の要領で変更してく
ださい。

• 文字の入力方法は、11ページ「自分の音を作ってみよ
う！」を参照してください。

• ファイル名の文字は下記の中から選べます。

• ファイルの末尾3文字は、ファイルの拡張子です。拡張
子は保存するデータの種類によって異なります。

6. br（ENTER）を押します。

7.“Sure?”という確認メッセージが表示されるので、
保存する場合はbr（YES）を、操作をキャンセルす
る場合はbr（NO）を押します。

本機のデータをカードに保存する

本機のデータをタイプ別にカードに保存するには

このデータを
保存するには： この操作を行う：

ユーザーパフォーマンスの
1つ

1. 7（PERFORM）を押す。
2. br（MENU）を押す。

ユーザー音色の1つ
（ユーザーソロシンセサイザー、
ユーザーPCMメロディー、
ユーザーPCMドラム、
ユーザーウェーブ）

1. 7（TONE）を押す。
2. bpのダイヤルまたはbqのテン

キーを使って、音色を選ぶ。
3. br（MENU）を押す。

ユーザーウェーブのひとつ
1. bm（REC）を押し続けて、
“LOOPER”を表示させる。

2. br（MENU）を押す。

ユーザーDSPの1つ

1. bn（MIXER）を押し続けて、
“EFFECT”を表示させる。

2. br（U、q、w、I）を使って、
“DSP Select”に●を移動し、
br（ENTER）を押す。
• ソロシンセサイザー音色の場
合は、“Ent”が表示されない。

3. br（MENU）を押す。

ユーザーステップシーケンスの
1つ

1. 7（STEP SEQ）を押す。
2. br（MENU）を押す。

ステップシーケンスチェーンの
1つ

1. bk（CHAIN）を押し続けて、
“CHAIN”を表示させる。

2. br（MENU）を押す。

ユーザーフレーズの1つ
1. bo（KEY PLAY）を押し続け

て、“PHRASE”を表示させる。
2. br（MENU）を押す。

ユーザーアルペジオの1つ

1. bn（ARPEGGIO）を押し続け
て、“ARPEGGIO”を表示させ
る。

2. br（MENU）を押す。

全データ

1. 7（SETTING）を押す。
2. br（q、w）を使って、
“CardUtility”に●を移動し、
br（ENTER）を押す。

3. br（q、w）を使って、“All 
Data”に●を移動し、br
（ENTER）を押す。

設定データ

1. 7（SETTING）を押す。
2. br（q、w）を使って、
“CardUtility”に●を移動し、
br（ENTER）を押す。

3. br（q、w）を使って、
“SettingData”に●を移動し、
br（ENTER）を押す。

（1）br（U、I）を使って、変更したい文字にカーソルを移
動します。

（2）bp（ダイヤル）またはbr（－、＋）を使って、文字を切
り替えます。

9
J
T
'

8
I
S
_
`

7
H
R
&
~

6
G
Q
S
@

5
F
P
Z
}

4
E
O
Y
{

3
D
N
X
^

2
C
M
W
-

1
B
L
V
)

0
A
K
U
(
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1.7（SETTING）を押します。

2. br（q、w）を使って●を“CardUtility”に移動
し、br（ENTER）を押します。
•“CARD UTIL”画面が表示されます。

3. br（q、w）を使って“All Data”に0を移動し、
br（ENTER）を押します。

4. br（q、w）を使って●を“Save”に移動します。

• この後の操作は、79ページ「本機のデータをタイプ別
にカードに保存するには」の手順3以降と同じです。

■カード内のデータ（ファイル）の保存場所について
以上の操作により本機のデータが、カード内の“MUSICDAT”
フォルダの中にファイルとして保存されます。
•“MUSICDAT”フォルダは、本機でカードをフォーマットし
たとき（78ページ）に自動的に作られます。

•“MUSICDAT”フォルダ以外の場所に保存されているファ
イルは、本機での読み込みや消去、ファイル名の変更ができ
なくなります。また“MUSICDAT”の中にさらにフォルダを
作って、そこにファイルを入れた場合にも、読み込みや消去
ができなくなりますのでご注意ください。

• 読み込むデータ（ファイル）は、必ずカードの
“MUSICDAT”フォルダの中に保存してください。

1. カードを本機のカードスロットに装着します。

2. 79ページ「本機のデータをタイプ別にカードに保
存するには」の手順2の表組みを参照し、カードから
本機へ読み込みたいデータの種類に応じた操作を
行います。

3. br（q、w）を使って●を“Card Load”（全データ
の場合“Load”）に移動し、br（ENTER）を押しま
す。
• 次のようなメニュー画面が表示されます（以下はス
テップシーケンサーモードから表示した場合の例で
す）。

4. bp（ダイヤル）またはbr（－、＋）を使って、本機へ
読み込みたいファイルを表示します。

5. br（w）を使ってカーソルを下へ移動し、bp（ダイ
ヤル）またはbr（－、＋）を使って読み込み先を表示
します。

6. br（ENTER）を押します。

7.“Sure?”という確認メッセージが表示されるので、
読み込みを実行する場合はbr（YES）を、操作を
キャンセルする場合はbr（NO）を押します。

本機の全データを一括してカードに保存するには カードから本機へデータを読み込む

カードから本機へタイプ別にデータを読み込む
には
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1.7（SETTING）を押します。

2. br（q、w）を使って●を“CardUtility”に移動
し、br（ENTER）を押します。
•“CARD UTIL”画面が表示されます。

3. br（q、w）を使って“All Data”に0を移動し、
br（ENTER）を押します。
• この後の操作は、80ページ「カードから本機へタイプ
別にデータを読み込むには」の手順3以降と同じです。

1. カードを本機のカードスロットに装着します。

2.7（SETTING）を押します。

3. br（q、w）を使って●を“CardUtility”に移動
し、br（ENTER）を押します。
•“CARD UTIL”画面が表示されます。

4. br（q、w）を使って“Delete”に0を移動し、br
（ENTER）を押します。

• 削除するファイルを指定する画面が表示されます。

5. bp（ダイヤル）またはbr（－、＋）を使って、削除す
るファイルを表示します。

6. br（ENTER）を押します。

7.“Sure?”という確認メッセージが表示されるので、
削除して良い場合はbr（YES）を、操作をキャンセ
ルする場合はbr（NO）を押します。
• br（YES）を押すと、“Please Wait”（実行中）と表示さ
れます。この間は、本機の操作を一切行わないでくださ
い。削除が終了すると、“Complete!”（完了）と表示さ
れます。

1. カードを本機のカードスロットに装着します。

2.7（SETTING）を押します。

3. br（q、w）を使って●を“CardUtility”に移動
し、br（ENTER）を押します。
•“CARD UTIL”画面が表示されます。

4. br（U、q、w、I）を使って“Rename”に0を移
動し、br（ENTER）を押します。
• 名前を変更するファイルを指定する画面が表示されま
す。

5. bp（ダイヤル）またはbr（－、＋）を使って、名前を
変更するファイルを表示します。

6. br（U、I）を使って、ファイル名の中から変更した
い文字にカーソルを移動し、bp（ダイヤル）または
br（－、＋）を使って文字を切り替えます。

7. 変更が済んだら、br（ENTER）を押します。

8.“Sure?”という確認メッセージが表示されるので、
ファイル名を変更して良い場合はbr（YES）を、操
作をキャンセルする場合はbr（NO）を押します。
• br（YES）を押すと、“Please Wait”（実行中）と表示さ
れます。この間は、本機の操作を一切行わないでくださ
い。変更が終了すると、“Complete!”（完了）と表示さ
れます。

パソコンを使ってカードに保存した楽曲ファイルを、本機で
再生することができます。
再生方法については、76ページ「デモ曲やカード上のファイ
ルを再生する」を参照してください。

カードから本機へ全データを一括して読み込む
には

ファイルを削除する

ファイル名を変更する

カード上のファイルを再生する
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パソコンとの接続について

この楽器とパソコンを接続して演奏情報（MIDIデータ）の送
受信ができます。楽器演奏をパソコンの音楽ソフト（市販品）
へ送って記録したり、パソコンからこの楽器へデータを送っ
て音を鳴らすことができます。

MIDIデータを送受信するために必要なパソコン環境は下記
のとおりです。お手持ちのパソコン環境を必ず事前にご確認
ください。

• 対応OS

• USBポート

• 上記の対応OS以外のパソコンを接続すると、パソコンが故
障する場合があります。絶対に接続しないでください。

• 正しい手順で接続しないとデータの送受信ができなくなる場
合があります。必ず下記の手順に従って接続してください。

1. 本機の電源を切り、パソコンを起動させておきます。
• パソコンの音楽ソフトは起動させないでください。

2. 市販のUSBケーブルで、パソコンと本機を接続しま
す。

3. 本機の電源を入れます。
• 初めての接続では、データを送受信するために必要な
ドライバが自動でパソコンにインストールされます。

4. パソコンの音楽ソフト（市販品）を起動させます。

5. パソコンの音楽ソフトの設定で、MIDIデバイスと
して下記のいずれかを選びます。

• MIDIデバイスの選択方法については、お使いの音楽ソ
フトのマニュアルをご覧ください。

• パソコンの音楽ソフトを起動させる前に、必ず本機の電源
を入れておいてください。

• 1回接続に成功した後は、USBケーブルをつないだままで
パソコンや本機の電源を入れなおすことができます。

• 本機からのMIDIデータ送信でのチャンネル切り替えなど、
MIDI関係の設定を変えることができます。詳しくは、
74ページ「MIDI関係の設定」をご参照ください。

• 本機のMIDIデータ送受信の詳しい仕様や、接続についての最
新のサポート情報は、下記のホームページをご覧ください。
http://casio.jp/support/emi/

本機で保存したユーザー音色や、フレーズなどのデータをパ
ソコンに転送して保存したり、そのデータをいつでも本機に
転送して戻すことができます。
また、本機の音色やパフォーマンスなどのデータ編集を、より
作業しやすいパソコン画面から行うこともできます。
これらの作業には、専用のアプリケーションソフト（データエ
ディター）が必要です。

1. 以下のホームページから、データエディターと操作
マニュアルをダウンロードして、お手持ちのパソコ
ンに保存します。
http://casio.jp/support/emi/

• 本機の製品紹介のページにデータエディターのページ
へのリンクが貼られています。製品紹介のページが見
つからない場合は、上記ホームページの検索フォーム
に本機の製品名を入力して検索してください。

• ダウンロードする前に、データエディターを使用する
ために必要なパソコン環境などについて、必ずご確認
ください。

• ホームページの内容は、予告なく変更される場合があ
ります。

2. 手順1でダウンロードした操作マニュアルに従っ
て、データエディターをインストールします。

3. 操作マニュアルに従って、データ転送や編集を行っ
てください。
• 転送できるデータの種類や、編集できる内容について
は、操作マニュアルをお読みください。

パソコンと接続する

パソコンの動作環境

Windows® XP（SP2以降）※1

Windows Vista® ※2

Windows® 7 ※3

Mac OS® X（10.3.9、10.4.11、10.5.X、10.6.X、10.7.X）
※1：Windows XP Home Edition

Windows XP Professional（32bit版）
※2：Windows Vista（32bit版）
※3：Windows 7（32bit版、64bit版）

接続方法

パソコンのUSB端子

Aコネクタ

Bコネクタ

本機のUSB端子

USBケーブル
（A-Bタイプ）

CASIO USB-MIDI：（Windows 7、Windows Vista、
Mac OS Xの場合）

USBオーディオデバイス：（Windows XPの場合）

本機のデータをパソコンに保存する／
本機のデータをパソコンで編集する
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資料
エラーメッセージ一覧

表示 原因 解決方法
Format 1. カードのフォーマットが本機に適合していない。 1. 本機でカードをフォーマットする（78ページ）。

2. 容量が32GBより大きいカードを使っている。 2. 32GB以下の容量のカードを使用する。
3. SDXCカードを使用している。 3. 本機はSDXCカードには対応していません。別の

カードを使ってください。
4. カードが壊れている。 4. 別のカードを使う。

Card Full カードの空き領域が足りない。 カードに保存しているファイルを消去して、空き領域
を増やす（81ページ）。または別のカードを使う。

Card R/W カードが壊れている。 別のカードを使う。
No Card 1. 本機のカードスロットに、カードが正しくセットさ

れていない。
1. カードスロットにカードを正しくセットする。

2. 操作の途中でカードが抜き差しされた。 2. 本機の操作中にはカードを動かさない。
No Data データが入っていない本機のユーザーエリア（ユー

ザーリズム番号、ユーザーソング番号など）を選んで、
カードに保存しようとした。

データを記録してあるユーザーエリアを選ぶ。

No File 1. カードの中に、“MUSICDAT”フォルダ（80ページ）
がない。

1. パソコンでカード内に“MUSICDAT”フォルダを作
る。または本機でカードをフォーマットする（78
ページ）。

2.“MUSICDAT”フォルダの中に読み込みや再生がで
きるファイルがない。

2. 読み込みや再生したいファイルを、“MUSICDAT”
フォルダの中へ移動する。

Not SMF0/1 SMFフォーマット2のファイルを再生しようとした。 本機で再生できるSMFのフォーマットは、“0”または
“1”です。

Protect カードが書き込み禁止になっている。 カードのプロテクトスイッチを切り替えて、書き込み
できるようにする。

Read Only カードに入っている読み込み専用ファイルと同じ名前
で、別のデータを保存しようとしている。

• 別の名前に変えて保存する。
• カードのファイルから読み込み専用属性を外して、
上書き保存する。

• 別のカードを使う。
Size Over 1. カードの楽曲ファイルのサイズが大きすぎて、本機

で再生できない。
1. 本機では最大で320キロバイトの楽曲ファイルま

で再生できます。
2. 本機へ読み込もうとしているデータのサイズが大

きすぎて、読み込めない。
2. 本機で読み込みできるデータの最大サイズ
（1データあたり）は下記のとおりです。
ユーザーフレーズ： 約8キロバイト
なお、読み込みが可能なユーザーフレーズの総容量
（100データ全体の容量）は、約128キロバイトです。

3. チェーンのSMFデータのサイズが大きすぎて、デー
タを変換しカードに保存することができない。

3. 本機では最大で320キロバイトのチェーンのSMF
データまで、データを変換しカードに保存すること
ができます。

Wrong Data 1. カードのデータが壊れている。 別のカードを使う。
2. カードのデータが本機で操作できない内容になっ

ている。
Memory Full フレーズシーケンサーの操作に必要なメモリー容量が

不足している。
別のフレーズで容量に収まるように録音する。

File Name カード上のファイルの名前の変更時に、既存ファイル
の名前を指定した。

既存ファイルで使われていない名前に変更する。

Invalid Tone PART1（ZONE1）以外で、シンセサイザー音色を選択
した。

ZONE1で、シンセサイザー音色を選択する。

Battery Low 電池残量が少ない。 新しい電池に交換する。またはACアダプターを使用す
る（9ページ）。

Write Error! 本機に内蔵されている保存メモリーへの書き込みが失
敗した。

保存の操作をやり直す。
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困ったときは

症状 対策
付属品
梱包箱のなかに付属品が見つからない。 緩衝材の中も探してみる。

電源
電源が入らない。 • ACアダプターの接続状態や、電池の装着方向が正しいか確認する（9ページ）。

新しい電池に交換する。またはACアダプターを使用する（9ページ）。
電源ボタン6（POWER）を押すと、液晶画
面が一瞬点灯し、電源が入らない。

6（POWER）をしっかりと押し直してください。

大きな音を出すと、突然電源が切れる。 新しい電池に交換する。またはACアダプターを使用する（9ページ）。
数分ほど弾かないでいると、突然電源が切
れる。

オートパワーオフ機能を解除する（73ページ）。

表示
液晶画面の表示が暗くなったり、ちらつくよ
うになった。

新しい電池に交換する。またはACアダプターを使用する（9ページ）。

液晶画面の表示が一定の方向からしか見え
ない。

本機の製造上の制約等によるもので、故障ではありません。

音
鍵盤を弾いても音が出ない。 • 音量の設定（10ページ）を変えてみる。

• 本機はスピーカーを内蔵しておりませんので、何も接続しないと音が出ませ
ん（7ページ）。

ステップシーケンサーをスタートしても音
が出ない

アルペジオ機能をステップシーケンサーのスタートのトリガーにしていると、
鍵盤を押さえるまでシーケンスがスタートになりません。

音が鳴りっぱなしで止まらなくなった。 新しい電池に交換する。またはACアダプターを使用する（9ページ）。
鳴らしている音が途切れてしまう。 同時に鳴っている音の数が64（音色によっては1～32）を超えると発生します。

故障ではありません。
音量や音質が変わってしまった。 • 音量の設定（10ページ）を変えてみる。

• 新しい電池に交換する。またはACアダプターを使用する（9ページ）。
鍵盤を弾くタッチを変えても、出る音の音量
が変わらない。

タッチの設定（68ページ）を変えてみる。

特定の鍵盤の音量や音質が、他の鍵域の鍵盤
と若干違って聴こえる。

本機のシステムの制約等によるもので、故障ではありません。

端の方の鍵盤を弾いていると、同じオクター
ブの音が繰り返されるように聴こえる音色
がある。

本機のシステムの制約等によるもので、故障ではありません。

音の高さが他の楽器とあわない（あるいは不
自然に聴こえる）。

トランスポーズやオクターブシフトの設定を確認する（34ページ）。

ソロシンセサイザー音色で高い音を弾くと、
ノイズが混じる。

本機のシステムの制約等によるもので、故障ではありません。

音の響きが急に変わったように感じる。 リバーブの設定（34ページ）を確認して調整する。
パソコンとの接続
MIDIデータの送受信ができない。 • 本機とパソコンがUSBケーブルで正しく接続されているか、あるいはパソコ

ンの音楽ソフトの設定でデバイスが正しく選ばれているか確認する（82ペー
ジ）。

• 本機の電源を切ってパソコンの音楽ソフトを終了させてから、本機の電源を
入れてパソコンの音楽ソフトを再起動させてみる。
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製品仕様
型式 XW-G1
鍵盤 61鍵盤
タッチレスポンス機能 2種類、オフ

同時発音数 最大64音（一部音色では1～32音）
音色機能 プリセット420／ユーザー220
ソロシンセサイザー音色 プリセット100／ユーザー100
PCMメロディー音色 プリセット300／ユーザー100
PCMドラム音色 プリセット20／ユーザー10
ユーザーウェーブ音色 ユーザー10

エフェクト機能
リバーブ システムリバーブ
コーラス システムコーラス
DSP プリセット100／ユーザー100

53タイプ（ノーマル 46、ソロシンセサイザー 7）
マスターイコライザー 4バンド

デモ 3曲
パフォーマンス機能 プリセット100／ユーザー100
フレーズ機能
プリセットフレーズ 100種類
ユーザーフレーズ 100種類
再生モード 1回、ループ
メモリー容量 128KB
その他 オーバーダビング

ステップシーケンサー機能
プリセットシーケンス 100種類
ユーザーシーケンス 100種類
トラック数 モノ：8、ポリ：1、コントロール：4
パターン 1シーケンスごとに8種類
チェーン 100種類
最大ステップ数 16ステップ
その他 フレーズ機能のコントロール

サンプルルーパー機能
ユーザーサンプル 10種類
サンプリング周波数 42 kHz／21 kHz
サンプリングチャンネル ステレオ／モノラル
サンプリングビット数 16ビット

ミキサー機能 内部16パート＋外部入力パート
その他の機能
トランスポーズ ±1オクターブ（－12 ～ 0 ～ ＋12半音）
オクターブシフト ±3オクターブ
チューニング A4＝415.5 ～ 440.0 ～ 465.9Hz
アルペジオ プリセット：100種類

ユーザー：100種類
MIDI機能 16chマルチティンバー受信、GMレベル1準拠
ホイール ベンダー 、モジュレーション
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• 改良のため、仕様およびデザインの一部を予告なく変更することがあります。

メモリーカード
使用できるメモリーカード 32GB以下のSDメモリーカード、またはSDHCメモリーカード
機能 SMF再生、ファイルの保存／読み込み／消去、カードフォーマット

端子
USB端子 タイプB
MIDIイン／アウト端子 IN、OUT
サステイン／アサイナブル端子 標準ジャック（サステイン、ソステヌート、ソフト、スタート／ストップ）
ヘッドホン端子 ステレオ標準ジャック
ライン出力端子（R, L/MONO） 標準ジャック×2

出力インピーダンス：2.3kΩ、出力電圧：1.7V（RMS）MAX
オーディオ入力端子 ステレオミニジャック

入力インピーダンス：9kΩ、入力感度：200mV
INST入力端子 標準ジャック

入力インピーダンス：9kΩ、入力感度：200mV
マイク入力端子 標準ジャック（ダイナミックマイクを接続）

入力インピーダンス：3kΩ、入力感度：10mV
INST入力・マイク入力A/D変換 : 42kHz、10ビット

電源端子 DC9.5V
電源 2電源方式
電池 単1形マンガン乾電池または単1形アルカリ乾電池6本使用
電池持続時間 約35時間（アルカリ乾電池、および当社別売品ヘッドホンCP-16使用時）
ACアダプター AD-E95100LJ
オートパワーオフ機能 約6分後（乾電池使用時）、約4時間（ACアダプター使用時）、キャンセル可能

消費電力 9.5V=4W
サイズ幅 幅94.8×奥行き38.4×高さ12.4cm
質量 約5.4kg（乾電池含まず）
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別紙「安全上のご注意」と併せてお読みください。

■設置上のご注意
本機を次のような場所に設置しないでください。
• 直射日光のあたる場所、温度の高い場所。
• 極端に温度の低い場所。
• ラジオや、テレビ、ビデオ、チューナーに近い場所（これらを
近くに置いた場合、本機には特に障害はありませんが、近く
に置いたラジオやテレビの側に雑音や映像の乱れが起こる
ことがあります）。

■本機のお手入れについて
• お手入れにベンジン、アルコール、シンナーなどの化学薬品
は使わないでください。

• 鍵盤などのお手入れは柔らかな布を薄い中性洗剤液に浸
し、固く絞ってお拭きください。

■付属品・別売品
付属品や別売品は、本機指定のものをご使用ください。指定以
外のものを使用すると、火災・感電・けがの原因となることが
あります。

■付属のACアダプターについて
• 本ACアダプターは、使用機器の近くのコンセントに差込ん
で使用するようにし、不具合時にはコンセントからすぐに
取り外せるようにしてご使用ください。

• 本ACアダプターは屋内使用専用です。水滴のかかる場所に
置かないでください。また、水の入った花瓶などを本ACア
ダプターの上にのせないでください。

• 本ACアダプターは、湿気のないところで保管してくださ
い。

• 本ACアダプターを新聞紙やテーブルクロス、カーテンなど
で覆わないようにしてください。

• 本ACアダプターを長い間お使いにならないときには、コン
セントから取り外しておくようにしてください。

• 本ACアダプターは、修理することができません。
• 本ACアダプターの使用環境：温度0～40℃

湿度10%～90%RH
• 出力形式：&

■ウエルドライン
外観にスジのように見える箇所がありますが、これは、樹脂成
形上の“ウエルドライン”と呼ばれるものであり、ヒビやキズ
ではありません。ご使用にはまったく支障ありません。

■音のエチケット
楽しい音楽も時と場合によっては気になるものです。特に静
かな夜間には小さな音でも通りやすいものです。周囲に迷惑
のかからない音量でお楽しみください。窓を閉めたり、ヘッド
ホンを使用するのもひとつの方法です。お互いに心を配り、快
い生活環境を守りましょう。

保証書はよくお読みください
保証書は必ず「お買い上げ日・販売店名」などの記入をお確
かめのうえ、販売店から受け取っていただき、内容をよく
お読みの後、大切に保管してください。

保証期間は保証書に記載されています

修理を依頼されるときは
まず、もう一度、取扱説明書に従って正しく操作していた
だき、直らないときには次の処置をしてください。

●保証期間中は
保証書の規定に従ってお買い上げの販売店または取扱説
明書等に記載の「修理サービス窓口」が修理をさせていた
だきます。
• 保証書に「持込修理」と記載されているものは、製品に保
証書を添えてご持参またはご送付ください。

• 保証書に「出張修理」と記載されているものは、お買い上
げの販売店または取扱説明書等に記載の「修理に関す
るお問い合わせ窓口」までご連絡ください。

●保証期間が過ぎているときは
お買い上げの販売店または取扱説明書等に記載の「修理に
関するお問い合わせ窓口」までご連絡ください。修理すれ
ば使用できる製品については、ご希望により有料で修理い
たします。

あらかじめご了承いただきたいこと
●「修理のとき一部代替部品を使わせていただくこと」や
「修理が困難な場合には、修理せず同等品と交換させて
いただくこと」があります。
また、特別注文された製品の修理では、ケースなどをカ
シオ純正部品と交換させていただくことがあります。

● 修理のとき、交換した部品を再生、再利用する場合があ
ります。修理受付時に特段のお申し出がない限り、交換
した部品は弊社にて引き取らせていただきます。

● 録音機能などのデータ記憶機能付きのモデルでは、修
理のとき、故障原因の解析のため、データを確認させて
いただくことがあります。

● 日本国内向けの製品は海外での修理受付ができませ
ん。修理品は日本まで移動の上、日本国内の「修理サー
ビス窓口」にご依頼ください。

アフターサービスなどについておわかりになら
ないときは
お買い上げの販売店または取扱説明書等に記載の「修理に関
するお問い合わせ窓口」にお問い合わせください。

ご使用上の注意 保証・アフターサービスについて
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■ノーマルDSPタイプ
• タイプ番号01～14は「シングルタイプ」、15～46は「デュアルタイプ」のDSPです。シングルタイプは単一構成のDSP、デュアル
タイプはシングルタイプ2つを組み合わせたものです。

• デュアルタイプのDSPは、「DSPタイプ名」そのものが、構成元のシングルDSPを表します。
例えばタイプ番号15の“Wah-Compressor”は、シングルDSPの“Wah”と“Compressor”を、この順番で直列に接続したDSP
です。

• 各DSPタイプで設定可能なパラメーターについては、下記をご参照ください。

■ソロシンセサイザーDSPタイプ

• 各タイプで設定可能なパラメーターについては、91ページ「ソロシンセサイザーDSPのパラメーター」をご参照ください。

DSPエフェクト

DSPタイプリスト

このDSPタイプについては： ここを参照：
シングルタイプ（タイプ番号01～14） 89ページ「ノーマルDSPのシングルタイプDSPのパラメーター」
デュアルタイプ（タイプ番号15～46） 90ページ「ノーマルDSPのデュアルタイプDSPのパラメーター」

タイプ番号 DSPタイプ名 表示名
01 Wah Wah
02 Compressor Comp
03 Distortion Dist
04 Enhancer Enhance
05 AutoPan AutoPan
06 Tremolo Tremolo
07 Phaser Phaser
08 Flanger Flanger
09 Chorus Chorus
10 Delay Delay
11 Reflection Reflect
12 Rotary Rotary
13 RingModulator RingMod
14 Lo-Fi Lo-Fi
15 Wah-Compressor WahCmp
16 Wah-Distortion WahDst
17 Wah-Chorus WahCho
18 Wah-Flanger WahFln
19 Wah-Reflection WahRef
20 Wah-Tremolo WahTrm
21 Wah-AutoPan WahPan
22 Compressor-Wah CmpWah
23 Compressor-Distortion CmpDst

24 Compressor-Chorus CmpCho
25 Compressor-Flanger CmpFln
26 Compressor-Reflection CmpRef
27 Compressor-Tremolo CmpTrm
28 Compressor-AutoPan CmpPan
29 Distortion-Wah DstWah
30 Distortion-Compressor DstCmp
31 Distortion-Chorus DstCho
32 Distortion-Flanger DstFln
33 Distortion-Reflection DstRef
34 Distortion-Tremolo DstTrm
35 Distortion-AutoPan DstPan
36 Chorus-Reflection ChoRef
37 Chorus-AutoPan ChoPan
38 Flanger-Reflection FlnRef
39 Flanger-AutoPan FlnPan
40 Reflection-Distortion RefDst
41 Reflection-Chorus RefCho
42 Reflection-AutoPan RefPan
43 Tremolo-Distortion TrmDst
44 Tremolo-Chorus TrmCho
45 Tremolo-Flanger TrmFln
46 Tremolo-Reflection TrmRef

タイプ番号 DSPタイプ名 表示名

タイプ番号 DSPタイプ名 表示名
Bypass Bypass

01 Auto Pan AutoPan
02 Distortion Dist
03 Flanger Flanger
04 Chorus Chorus
05 Delay Delay
06 Ring Modulator RingMod
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■ノーマルDSPのシングルタイプDSPのパラメーター

01: Wah
LFOによって自動的に周波数を動かすことができるワウです。
パラメーターと値域
1 :Resonance（値域：0～127）

音の癖の強さを調整します。
2 :Manual（値域：0～127）

ワウフィルターの基準となる周波数を設定します。
3 :LFO Rate（値域：0～127）

LFOの速度を調整します。
4 :LFO Depth（値域：0～127）

LFOの深さを調整します。
5 :LFO Waveform（値域：off, sin, tri, random）

LFO波形を選択します。

02: Compressor
入力された信号を圧縮し、レベルのばらつきを抑えたり、減衰音のサス
テインを長くします。
パラメーターと値域
1 :Attack（値域：0～127）

入力信号のアタック量を調整します。値が小さくなるほど、コンプ
レッサーの動作が機敏になり、入力信号のアタックを抑えること
ができます。値が大きくなるほど、コンプレッサーの動作が遅れて
入力信号のアタックをそのまま出力するように動作します。

2 :Release（値域：0～127）
入力信号が所定のレベル以下になってから圧縮動作を中止するま
での時間を調整します。
アタック感を出したい（音の立ち上がりで圧縮動作をさせたくな
い）ときはなるべく小さい値に設定してください。また、常に圧縮
動作させておきたいときは大きな値に設定してください。

3 :Level（値域：0～127）
出力レベルを調整します。

4 :Threshold（値域：0～127）
圧縮動作を始める音量レベルを調整します。

03: Distortion
入力信号を歪ませて倍音を加えたデジタルディストーションです。
パラメーターと値域
1 :Gain（値域：0～127）

入力信号のゲインを調整します。
2 :Level（値域：0～127）

出力レベルを調整します。

04: Enhancer
入力された信号の低域音と高域音を位相シフトし、信号の輪郭を際立
たせます。
パラメーターと値域
1 :Low Frequency（値域：0～127）

低域音エンハンサーの周波数を調整します。
2 :Low Phase（値域：0～127）

低域音エンハンサーの位相シフト量を調整します。
3 :High Frequency（値域：0～127）

高域音エンハンサーの周波数を調整します。
4 :High Phase（値域：0～127）

高域音エンハンサーの位相シフト量を調整します。

05: Auto Pan
入力信号の定位をLFOによって動かします。
パラメーターと値域
1 :LFO Rate（値域：0～127）

パンニングの速度を調整します。
2 :LFO Depth（値域：0～127）

パンニングの深さを調整します。
3 :LFO Waveform（値域：sin, tri）

LFO波形を選択します。
4 :Manual（値域：－64 ～ 0 ～ 63）

定位の中心位置を調整します。－64で左、0で中央、63で右となり
ます。

06: Tremolo
入力信号の音量をLFOによって動かします。
パラメーターと値域
1 :LFO Rate（値域：0～127）

トレモロの速度を調整します。
2 :LFO Depth（値域：0～127）

トレモロの深さを調整します。
3 :LFO Waveform（値域：sin, tri）

LFO波形を選択します。

07: Phaser
入力信号の位相をLFOによって動かし、入力信号に加えることにより、
音に独特なうねりや広がりを与えます。
パラメーターと値域
1 :Resonance（値域：0～127）

音の癖の強さを調整します。
2 :LFO Rate（値域：0～127）

LFOの速度を調整します。
3 :LFO Depth（値域：0～127）

LFOの深さを調整します。
4 :LFO Waveform（値域：sin, tri, random）

LFO波形を選択します。

08: Flanger
音に激しいうなりや金属的な響きを与えます。
LFO波形を選択できます。
パラメーターと値域
1 :LFO Rate（値域：0～127）

LFOの速度を調整します。
2 :LFO Depth（値域：0～127）

LFOの深さを調整します。
3 :LFO Waveform（値域：sin, tri, random）

LFO波形を選択します。
4 :Feedback（値域：0～127）

音の癖の強さを調整します。

09: Chorus
音に厚みと広がりを与えます。コーラスのタイプを選択できます。
パラメーターと値域
1 :LFO Rate（値域：0～127）

LFOの速度を調整します。
2 :LFO Depth（値域：0～127）

LFOの深さを調整します。
3 :LFO Waveform（値域：sin, tri）

LFO波形を選択します。
4 :Feedback（値域：0～127）

音の癖の強さを調整します。
5 :Type（値域：mono, stereo, tri）

コーラスのタイプを選択します。

DSPパラメーターリスト
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10: Delay
入力信号を遅延しフィードバックさせることにより繰り返し効果や音
に広がりを与えます。
パラメーターと値域
1 :Delay Time（値域：0～127）

ディレイタイムを調整します。
2 :Feedback（値域：0～127）

ディレイの繰り返しを調整します。
3 :Ratio Lch（値域：0～127）

左チャンネルのディレイタイムを調整します。Delay Timeで設定
した値に対する比率です。

4 :Ratio Rch（値域：0～127）
右チャンネルのディレイタイムを調整します。Delay Timeで設定
した値に対する比率です。

5 :Wet Level（値域：0, 1, 2, 3, 4, 5）
ディレイ音のレベルを調整します。

6 :Type（値域：1, 2）
ディレイの種類を選択します。

7 :Tempo Sync（値域：Off, 1/4, 1/3, 3/8, 1/2, 2/3, 3/4, 1, 4/3, 
3/2, 2）シーケンサー等のテンポとディレイタイムとの関係を調
整します。
0ffを選択している場合は、ディレイタイムはDelay Timeパラ
メーターで設定された値になります。それ以外の値を選択してい
る場合は、シーケンサー等の拍と同期します。例えば1を選択する
とディレイタイムが1拍の長さと、ほぼ等しくなります。
（ディレイタイムと拍を完全に同期させることはできません）

ご注意：ディレイタイム、タップを調整する際に設定によっては切り替
え音がディレイに残る場合があります。

11: Reflection
残響音から初期反射音を取り出したエフェクターです。
音に臨場感や存在感を与えます。
パラメーターと値域
1 :Type（値域：1, 2, 3, 4, 5, 6, 7, 8）

反射のパターンを8種類の中から選択します。
2 :Feedback（値域：0～127）

反射音の繰り返しを調整します。

12: Rotary
Rotary Speaker Simulatorです。
パラメーターと値域
1 :Overdrive Gain（値域：0, 1, 2, 3）

オーバードライブのゲインを調整します。
2 :Overdrive Level（値域：0～127）

オーバードライブの出力レベルを調整します。
3 :Speed（値域：Slow, Fast）

Fast/Slowの速度モードを選択します。
4 :Brake（値域：Rotate, Stop）

スピーカーの回転を止める働きがあります。
5 :Fall Acceleration（値域：0～127）

速度モードをFastからSlowに切り替えたときの加速度を調整し
ます。

6 :Rise Acceleration（値域：0～127）
速度モードをSlowからFastに切り替えたときの加速度を調整し
ます。

7 :Slow Rate（値域：0～127）
SpeedがSlowモードのときのスピーカーの回転速度を調整しま
す。

8 :Fast Rate（値域：0～127）
SpeedがFastモードのときのスピーカーの回転速度を調整します。

13: Ring Modulator
入力信号と内蔵オシレータを乗算して、金属的な音色をつくります。
パラメーターと値域
1 :OSC Frequency（値域：0～127）

内蔵オシレータの基準周波数を設定します。
2 :LFO Rate（値域：0～127）

LFOの速度を調整します。
3 :LFO Depth（値域：0～127）

LFOの深さを調整します。
4 :Type（値域：1, 2, 3）

14: Lo-Fi
入力信号に色々なノイズを加え、レトロなLo-Fiサウンドを再現しま
す。
テープやレコードなどの回転ムラであるワウフラッター（WF）やFM
ラジオなどのような連続的なノイズを発生するノイズジェネレータ1
とレコードプレーヤーのようなスクラッチノイズを発生するノイズ
ジェネレータ2を備えています。
パラメーターと値域
1 :Wow and Flutter Rate（値域：0～127）

ワウフラッターの速度を調整します。
2 :Wow and Flutter Depth（値域：0～127）

ワウフラッターの深さを調整します。
3 :Noise1 Level（値域：0, 1, 2, 3, 4, 5）

ノイズジェネレータ1のレベルを調整します。
4 :Noise2 Level（値域：0, 1, 2, 3, 4, 5）

ノイズジェネレータ2のレベルを調整します。
5 :Noise2 Density（値域：0, 1, 2, 3, 4, 5）

ノイズジェネレータ2の発生頻度を調整します。
6 :Bit（値域：0, 1, 2, 3）

音質を粗くします。値が大きいほど音質が粗くなります。

ご注意：発音していない場合においてノイズのレベルを上げると入力
信号が無い場合でもノイズ音が鳴ります。

■ノーマルDSPのデュアルタイプDSPのパラメーター
デュアルタイプDSPは、2つの異なるシングルDSPの組み合わ
せで構成されます。各デュアルタイプDSPで変更できるパラ
メーターと、その働きや値域は、次の要領で確認できます。

例：タイプ番号29の“Distortion-Wah”の場合
1. DSPタイプ名を前半と後半に分けます
“Distortion-Wah”→“Distortion”と“Wah”

2. 名前の前半部分と同じ「タイプ名」を下表から探し、「変更で
きるパラメーター」を確認します。

1：ディレイの繰り返しはDelay Timeによって決まります。
2：ディレイの繰り返しはDelay TimeとRatio L/Rによって決

まります。

1：リングモジュレーションされた信号だけを出力します。
2：リングモジュレーションされた信号と入力信号を出力します。
3：2にコーラス効果がかかった信号を出力します。

タイプ名 変更できるパラメーター
Wah LFO Waveform

LFO Rate
LFO Depth

Distortion Gain
Level

Chorus LFO Waveform
LFO Rate
LFO Depth

Flanger LFO Waveform
LFO Rate
LFO Depth

Reflection Feedback
Compressor Threshold

Level
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3. 89ページ～90ページの「ノーマルDSPのシングルタイプ
DSPのパラメーター」で同じタイプ名を探し、上記の「変更
できるパラメーター」と同じ項目の働きと値域を確認しま
す。
•“Distortion-Wah”では前半部分は“Distortion”なの
で、上の表から“Gain”と“Level”という2つのパラメー
ターが変更可能です。89ページ「03: Distortion」を参照
すると、“Gain”と“Level”の働きと値域が確認できます。

4. 名前の後半部分についても、手順2～3と同様に確認します。
• パラメーター設定画面に表示されるパラメーター番号
は、前半部分と後半部分の通し番号となります。
例えば“Distortion-Wah”の場合は、次のようになりま
す。

■ソロシンセサイザーDSPのパラメーター
•（Param A）、（Param B）は、ソロシンセサイザー音色選択
時にスライダー5（8/16、MASTER）に割り当てられるパ
ラメーターです。

Bypass
これを選ぶとDSPがかからなくなります。
パラメーターなし

01: Auto Pan
パラメーターと値域
1 :LFO Waveform（値域：sin, tri）
2 :LFO Rate（値域：0～127）（Param A）
3 :LFO Depth（値域：0～127）（Param B）
4 :Manual（値域：－64～0～63）

02: Distortion
パラメーターと値域
1 :Gain（値域：0～127）（Param A）
2 :Level（値域：0～127）（Param B）

03: Flanger
パラメーターと値域
1 :LFO Waveform（値域：sin, tri, random）
2 :LFO Rate（値域：0～127）（Param A）
3 :LFO Depth（値域：0～127）（Param B）

04: Chorus
パラメーターと値域
1 :LFO Waveform（値域：sin, tri）
2 :LFO Rate（値域：0～127）（Param A）
3 :LFO Depth（値域：0～127）（Param B）

05: Delay
パラメーターと値域
1 :Delay Time（値域：0～127）（Param A）
2 :Feedback（値域：0～127）
3 :Damp（値域：0～3）

高音域の減衰を調整します。3がもっとも減衰します。
4 :Wet Level（値域：0, 1, 2, 3, 4, 5）（Param B）
5 :Tempo Sync（値域：Off, 1/4, 1/3, 3/8, 1/2, 2/3, 3/4, 1, 4/3, 

3/2, 2）

06: Ring Modulator
パラメーターと値域
1 :Frequency（値域：0～127）（Param A）

リングモジュレーターの発振周波数を調整します。
2 :Dry Level（値域：0～127）

原音のレベルを調整します。
3 :Wet Level（値域：0～127）（Param B）

リングモジュレーター音のレベルを調整します。

• 上記記載中に説明のないパラメーターについては、89ペー
ジの「ノーマルDSPのシングルタイプDSPのパラメーター」
で、同じ名前のパラメーターの説明をご参照ください。

Auto Pan LFO Waveform
LFO Rate
LFO Depth
Manual

Tremolo LFO Waveform
LFO Rate
LFO Depth

1：Gain
2：Level
3：LFO Waveform
4：LFO Rate
5：LFO Depth

タイプ名 変更できるパラメーター

入力可能文字一覧
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